Technology

PicoScope 6
PC Oscilloscope Software

User's Guide

psw.en r39
Copyright © 2007-2015 Pico Technology Ltd. All rights reserved.




Technology



PicoScope 6 User's Guide |

Table of Contents

T WEICOME oottt s b e bbb ab e saa s an s 1
2 PICOSCOPE 6 OVEIVIEW ..eoruuiiuiiiiiiiiniiiitiniinitintcsie st esaesatessasssasessssssssesssesasesssesnsesssesssesnsessnsens 2
3 INTrOdUCLION couiiiiiiiiiiiii e 3
L =TT Y 2 T PR 3
2 UPGIAAES - nvenviatiiitietiett et et ettt ettt a et h ettt h ke h e h e et a et b e bttt a e bt et ettt naeebe e 3
BT rad e mMarks «ooeueeuiiniiiiiiii et e e e e e e e e e e e e e a e aaeates 4
4 SYStEM FEQUIFEMENTS «.evtuniitieitieeii ettt e et et e et e et e ettt e e st e e et e etteeataaeataaastaasttnesttasastaaastanassens 4
4 Using PicoScope for the first tiMe ....ccciviiiieiiiiiiiiiiiiiceentcrcctee et 5
5 PicoScope and osCilloSCOPE PrIMEN ...cocuiiviiiiuiiiiiiiiiiiiiiiinicntre sttt essaesaeeanes 6
1 OSClIOSCOPEBASICS vvvevertenteniatintenteutatentestett et et ettt et et et et et es e eb et et be b et est bt et et ese e b et eneebeneeneas 6
2 PC OSClOSCOPE BASICS 1veveuverinreriniteiitetinietestrt ettt ettt ettt ettt es et bt eb et a bttt ettt et 7
3 PICOSCOPE DASICS +eververrritinteniatiatent et ettt est et et et ettt et e st e bt b et es e eh et et h ettt n et bt n bt n et et 7
1 Capture modes
2 How do capture modes work with VIews? - s 9
4 PICOSCOPE WINAOW -+ vvtetemtenietitestettate et es st et ese b et et es e et et e st ettt et e st e b e e es e e bt st et eseebe et et eseebe e 10
D S O P VIBW 1en ettt e et et e e e e e e e eaaes 11
6 Overvoltag e indiCator ....o.uuuuiiiiiiiiiiiiiii e 12
78 10 1N 13
T DGRl VIBW weevereeerers ettt e 14
2 Digital CONEEXE MEMIU rererreeresssssssse s 15
L0, (7 =) N 16
9 THIG G EF MAPKEE - v eeveeetitenteitete ettt ettt ettt ettt ettt a ettt ekt b e ettt sttt ettt 17
TO POSt-Erig G F AITOW . oeeiiiuneiiiii ettt ettt e et et e e ettt e e ettt e e s et e e sett e esata e esettaeeesattaaesetaaaeseses 17
B Y X o T T 18
12 PersiStENCE MO cuouvniininiiit i e 19
13 Measurements table .......o.oooiiiiiiiiiiiiiii 20
T4 POINter tOO] tiP vvvenereiiitiiiii e e e e e e eaaes 21
15 SHGNAL FULEES «-veevtvtentent ettt ettt ettt ettt ettt bbbt bt h e st et e st et et e bt e bt bt bt eates et ettt ebe i 22
B I = T 1 =Y s 23
17 Phase (rotation) FULErs .........oiiiniiiiiiii e e e 24
T8 RUIEF SEEEINGS +ovvvvuneiiiii ittt e et e e e et e e ettt e e e et e e s et e e sabaaeeaaes 26
B Y - Y T 27
20 FreqUENCY 1€Z @Nd - vvtvertemietitinieneeteetenteteeteteseet et esees e et et es e et e e be e estebeebeneesees et enees e et et eneeneeens 27
271 Properties Sheet .......uueiiiiiiiiiiii e e e e 28
22 CUSEOM PrODES uniiiiiiitiiii ettt et e e e et e e et e et e et b e e e e e e saaaaes 29
23 Math channels «..oouoniiiii ittt e ae s 30
24 Reference WavefOrmMS . .oconinininiiii ittt ettt et e e et e e e e e eea e eeaeneas 31
25 SEFial dECOAING 1+evvevveverenteuretirtentetteteetettett et et ettt e st et eteea et es e ettt ettt sa et bt et sttt ea ettt be e 32
26 Mask [ImMit teSTING «ovvvveneeiiiii i e e s 33
3y A - VY 5 T O OoN 34

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved. psw.en r39



Il Table of Contents

28 BUFfEr O VEIVIEW ueuvininitiniiitintteteneeeetteteteeeneaeesenetenenesessnsntenenssesssstenensssensssnssnenssssnensnsenenenes 35
6 MENUS e s b s s b e ab e br s 36
T Rl MMIBNIU +entnttinit ettt ettt et ettt ta e teteneeseseneeaenenesenenennesenensesensosenensssesensosenensnsesensnsenenensesensnnns 37
T SaVE A dialog «orereererseesrerserssteent ettt e 38
2 Startup Settings FYYEIILL ¢+vveeeerserssessesseestsonuunessossssstssssesstsossusessssssssssssstsstssssusssssssssssssssssstssssusesssssssssssssssstssssanasses
3 Waveform Library Browser -
20 e o 7= 11
I L 13 = T P PP PP
2 Channel Labels (PicoScope Automotive only)
3 Details dialog (PicoScope Automotive only) ..........................................................................................
3 VHEWS INMEIIU - eettnnnttiitttttitt ettt tttattetaeteetnatesenaaeseasesssassssssnssesesssesesssessssssssssnssesesssesssnsessssnanes
1 Custom grid 1ayout dialog <+« e eesers e 50
4 MEaSUIEMENTS NMIEIU t1 et tnnttnnttttt ettt ettt et etatettetatetasetateaasetaseansesasesnsesntesnsesnsesnsesnsesnsesnnenns 51
1 Add [ Edit Measurement dialog - rrrrwsssssrrssssssssessssess s 52
2 Advanced measurement settings ................................................................................................................. 53
LI e o X T 11T 1 55
T CuUStOM Probes dialog «wwwerseesermeiei e 56
2 Math Channels dialog <+ttt 70
3 Reference Waveforms di@log et e 81
4 Serial Decoding dialog «« et 83
5 ALQIMS dialog «+eveeeeeseesseessees et 90
6 MASKS MNERIU -+evereererererrereertemeretst ittt ettt be et s st s bbb bbbt s e bbbt e bbbt sa et b bt a b e s e

7 Macro Recorder
8 Preferences dialog

6 HEIP MENU «.niiiiii et et et e et et e et e e e e

7 Automotive menu (PicoScope Automotive only) ...ocuveniiniiiiiiiiiii 110

8 Connect Device dialog .. ocvuiiiiiiiiiiiiiii e 111

9 Converting files in WIindows EXplorer........coouiiiiiiiiiiiiiii e 112
A KeTo) | oF:1 o= a o l o1 Ht o KU 114

1 Advanced Options toolbar....cooiiiniiiii

O 1T N 1 0= IR o Yo 1 = 7 1 o

1 Channel Options menu

2 CONNECED @LECTL e vvrereeeerrerttttiitiiiiiiiiiiiitiititittisies sttt ssssss s s s ettt et a s sssse st s e s et et b bbb et ssssssees
3 Digita| Inputs D ULEO I oeseeseeeersrnttttimmmuuiiniiiiiiiiiniiiiiiemuueeissiissiossitttissmanseisssssssiosssttttesrsssesssssssssssssssetssssssasssssns
3 PicoLog 1000 Series Channels toolbar ..........coouuuiiiiiiiiiiiiiii e 125
1 PicoLog 1000 Series Digital QULpULs CONLFOI «wesesssssmmmmmmmmmnrrrrrneeeeesssssssssssinnnnnnssssssessssss 126
4 USB DrDAQ Channels toolbar ...cocvuvuiiiiiiiiiiiiiiiiiiiiiiiiiiiiii e 127
1 USB DrDAQ RGB LED CONLIOI ++erereeereuesstseetettet 128
2 USB DI‘DAQ Digita| Outputs CONLFOI oo reeeeeeti s 129
5 Capture Setup toOIDar cooovieniiiiii e e 130
1 SPectrum OPtions dialog <+ twtesersstrsstrististi st 132
2 Persistence Options dialog <« 135
6 Buffer Navigation toolbar ......oviiuniiiiiiiiii 137
7 MeEasUrEmMENtS £0OID K ouveiniiiitiiiiiiiiit ittt ettt ettt eeeeteneieesesensesenensesesensesensnsesesensesensnsnsesensnsns 138
8 Signal Generator button . ..ovvuniiiiiiii e 139
1 sig nal Generator dialog (Picoscope devices) ....................................................................................... 139
2 Signal Generator dialog (USB DrDAQ) s wrseesseesseesseesssessessetistis sttt 142
3 Arbitrary wavefo rm fil@s - et 143
4 Arbitrary Waveform Generator Window i 144

psw.en r39 Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.



PicoScope 6 User's Guide 1]

5 D @MO SiNMAlS @MU w-rrveeeseesseessems st 148

6 Demo Signals di@log -« ws e rrssersieessees s 149

9 Start [ StOP toOIbar ovie i 150
10 Triggering toOIbar..ccoeeiiiiiiiiiiiiiei e 151
1 Advanced Triggering dialog - ettt 153

2 AdVANCE LG G @F LY P@S r+rr+rrreesrrrseeseers ettt 154

11 Zooming and SCrolling L00IDAF «...v.vrvrvrieirieisieisieisieisisistatststseseseseses e essessessens 160
1 ZO O O VEIVIEW r+++++erreerterteatentaeiei et et et et e et e et e et e et e e e e e bt et s et s e s b e et e e be e st e e s b e e ssaesbeasaesssease e ba e be e teanseansans 161

B HOW 0. ettt s a s b e s ae s 162
1 HoWw t0 chang e to a different deVICe «. . c.ueueuertirieuirtintenietiateeeneetesteseett ettt ettt eee et sneseene e 162
2 How to use rulers to measure a signal -....oooeveniiiiiiiiiiiiiiiniii e 163
3 Howto measurea time difference.......oovuviiiiiiiiiiiiiiiiii e 164
4 HOW 0 MOVE @ VIBW +tntttntinnitnnetieii ettt et ettt et enaetueetneaneeaaeaataaetaeetnsetnsetnernsennseneeanaennnens 165
5How to scaleand offset a signal .......ooeiiiiiiiiiiiiiiiii 166
6 How to set Up the SPeCctrUm VIEW .....oiiiiiiiiiiiiiii i e e e 168
7 How to find a glitch using persistence Mmode .......coouvniiiiiiiiiiiiiiiiiii 169
8 HOW £0 Set UP @ Mask LImit TSt .. veuerveuerereirieriteteniatettetetetetesteteteneesesteseseseeteeesesesseseeerenenne 173
G HOW t0 SAVE ON LG g er 1o ervuniiiiniiii ittt et e et e et e st e et e e ae e e et e e et e eaeaaeees 176
10 How to create a link file .o.oovinninniniiiii e 180
D RETEIENCE .ttt ettt s b e s s sb e s s sa e s e sa e s ra e s b e e s saaesane 182
T MEASUrEMENT LY PES «vunreiriinniiiiiiieietiiie ettt e ettt e ettt e e e et e e e ettt e e e e et e e e etti e e eettaaeesetaaaaseeaanns 182
1 S0P € MBS UFEIMIEIIES -+--r+:cr-2r1er e 182

2 S CCLIUIM MEASUFEIMEIIES -1 183

2 Signal generator WavefOormM tyPes . ovivuueiiiriiiitiiiitii ettt e e e e 185
3 Spectrum Wind oW FUNCLIONS o..evvvveiiiiiiiiiiiiiic e 186
4 Trigger timing (Part 1) «oeeeeiiiii i e e et e e e e e et 187
S Trigger timing (Part 2) ooeeuuiiiuiiiiiiiieii ittt st e b et e e et e et e a e eees 188
6 SEEIAl PrOtOCOIS - veueeuetirtentetiateteuteteatestete et e tes e et e eteseeseebe s eseeseebeneesees et eneebeebenseneebeabeneeneanennas 189
T RS232/UART Proto ol < reseesseesseesseessees st e 190

2 SPl protocol
3 12C protocol

4 1S protocol

B CAN PrOto O - eeeeseessessees ettt 194

6 LIN Proto o]« ereseesseesseeseesseet et 196

T FIEXRAY ProtoCol e e ettt 198

7 Devicefeature table ....ccoovuiniiiiiiiiiiiiiiii e 200

8 ComMMANd-liNE SYNTAX «vuneeruniiiiiiiiiiiiie ettt e e e et e e et e et e et e e et e e et e et e e e eaes 201

9 Application Error dialog ..oeevveeeeiiiiiiiiiii e 204

TO FlexXiDle POWEK .oeiiniiiiii et ettt e b et sttt e et e e n e ees 205

B T T N 207
Y = R 211

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved. psw.en r39



Technology



PicoScope 6 User's Guide 1

1 Welcome

Welcome to PicoScope 6, the PC Oscilloscope software from Pico
Technology.

With a scope device from Pico Technology, PicoScope turns your PC
into a powerful PC Oscilloscope with all the features and performance of
a benchtop oscilloscope at a fraction of the cost.

» What's new in this version?
» Using PicoScope for the first time

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved. psw.en r39



2 PicoScope 6 overview

2 PicoScope 6 overview

PicoScope 6 is Pico Technology's software for PC Oscilloscopes.
High performance

Fast capture rates, making it easier to see fast-moving signals
Fast data processing

Support for the latest PicoScope USB oscilloscopes

Frequent free-of-charge updates

Advanced usability and display
Clear graphics and text
Tool tips and help messages to explain all features
Easy point-and-click tools for panning and zooming
Quick save, print, and file sharing capability

Key features

Mﬁ"j’é“.t The latest Windows .NET O Multiple views of the same

i technology enabling us to data, with individual zoom
deliver updates more quickly and pan settings for each

view

™N Custom probes manager to i Advanced triggering
make it easy for you to use conditions including pulse,
your own probes and sensors window and logic
with PicoScope

Properies ~ Properties sheet displaying all i, Spectrum mode with a fully
settings at a glance optimized spectrum analyzer

1 kHz Per-channel lowpass filtering ¥ Math channels for creating

mathematical functions of
input channels

@ Reference waveforms for | Arbitrary... | Arbitrary waveform designer
storing copies of input — for oscilloscopes with a built-
channels in arbitrary waveform

generator

- Rapid trigger mode to capture il Windows Explorer integration

to show files as pictures and
convert to other formats

a sequence of waveforms

with the minimum possible Hi-H

dead time e v

o Command-line options for Zoom overview for rapidly
converting files am ot adjusting the zoom to show

any part of the waveform

o Serial decoding for RS232, I°C f1 Mask limit testing to show
and other formats, in real when a signal goes out of
time bounds

&) Buffer overview for searching 9 Alarms to alert you when a
the waveform buffer specified event occurs

psw.en r39 Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.
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3

3.1

3.2

Introduction

PicoScope 6 is a comprehensive software application for Pico Technology
oscilloscopes. Used with a PicoScope hardware device, it creates an oscilloscope and
spectrum analyzer on your PC.

PicoScope 6 supports the devices listed in the Device feature table. It runs on any
computer with Windows XP SP3 through to Windows 8. (See System requirements for
further recommendations).

How to use PicoScope 6

Getting started: see using PicoScope for the first time, and PicoScope's Features.
For further information: see descriptions of Menus and Toolbars, and the Reference
section.

For step-by-step tutorials, see the How to section.

Legal statement

Grant of license. The material contained in this release is licensed, not sold. Pico
Technology Limited ('Pico') grants a license to the person who installs this software,
subject to the conditions listed below.

Access. The licensee agrees to allow access to this software only to persons who
have been informed of and agree to abide by these conditions.

Usage. The software in this release is for use only with Pico products or with data
collected using Pico products.

Copyright. Pico claims the copyright of, and retains the rights to, all material
(software, documents etc.) contained in this release.

Liability. Pico and its agents shall not be liable for any loss or damage, howsoever
caused, related to the use of Pico Technology equipment or software, unless excluded
by statute.

Fitness for purpose. No two applications are the same, so Pico cannot guarantee that
its equipment or software is suitable for a given application. It is therefore the user's
responsibility to ensure that the product is suitable for the user's application.

Mission-critical applications. Because the software runs on a computer that may be
running other software products, and may be subject to interference from these other
products, this license specifically excludes usage in 'mission-critical' applications, for
example life-support systems.

Viruses. This software was continuously monitored for viruses during production.
However, the user is responsible for virus checking the software once it is installed.

Support. No software is ever error-free, but if you are dissatisfied with the
performance of this software, please contact our technical support staff.

Upgrades

We provide upgrades, free of charge, from our web site at www.picotech.com. We
reserve the right to charge for updates or replacements sent out on physical media.

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved. psw.en r39
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3.3 Trade marks
Windows is a registered trade mark of Microsoft Corporation. Pico Technology,
PicoScope and PicolLog are internationally registered trade marks.
3.4  System requirements
To ensure that PicoScope operates correctly, you must have a computer with at least
the minimum system requirements to run your Windows operating system, which must
be one of the versions listed in the following table. The performance of the oscilloscope
will be better with a more powerful PC, and will benefit from a multi-core processor.
Item Minimum specification Recommended
specification
Operating system Windows XP SP3, Windows Vista, Windows 7 or Windows 8
32-bit or 64-bit edition
Not Windows RT
Processor 300 MHz 1 GHz
Memory 256 MB 512 MB
Free disk space* 1 GB 2 GB
USB 2.0 port (USB 2.0
oscilloscopes)
Ports USB 2.0 port USB 3.0 port (USB 3.0
oscilloscopes)
* The PicoScope software does not use all the disk space specified in the table. The
free space is required to make Windows run efficiently.
psw.en r39 Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.
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4 Using PicoScope for the first time

We have designed PicoScope to be as easy as possible to use, even for newcomers to
oscilloscopes. Once you have followed the introductory steps listed below, you will
soon be on your way to becoming a PicoScope expert.

“piseh Install the software. Load the CD-ROM that is included with your
1 scope device, then click the Install Software link and follow the
' on-screen instructions.
Plug in your scope device. Windows will recognise it and prepare
2 - your computer to work with it. Wait until Windows tells you that
' the device is ready to use.
3 ‘3‘] Click the new PicoScope icon on your Windows desktop.

PicoScope will detect your scope device and prepare to display a
@. Q waveform. The green Start button will be highlighted to show that
+ _|, PicoScope is ready.

Connect a signal to one of the scope device's input channels and
see your first waveform! To learn more about using PicoScope,
please read the PicoScope Primer.

Problems?

Help is at hand! Our technical support staff are always ready to answer your telephone
call during office hours (see our Contact Details). At other times, you can leave a
message on our support forum or send us an email.

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved. psw.en r39
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PicoScope and oscilloscope primer

5.1

PicoScope and oscilloscope primer

This chapter explains the fundamental concepts that you will need to know before
working with the PicoScope software. If you have used an oscilloscope before, then
most of these ideas will be familiar to you. You can skip the Oscilloscope basics section
and go straight to the PicoScope-specific information. If you are new to oscilloscopes,
please take a few minutes to read at least the Oscilloscope basics and PicoScope
basics topics.

Oscilloscope basics

An oscilloscope is a measuring instrument that displays a graph of voltage against
time. For example, the picture below shows a typical display on an oscilloscope screen
when a varying voltage is connected to one of its input channels.

Y
0.6
0.4
0.2
0.0
0z
04
06
03
.05 c

00 02 040603101214 16 18 20

M=

A

Oscilloscope displays are always read from left to right. The voltage-time characteristic
of the signal is drawn as a line called the trace. In this example, the trace is blue and
begins at point A. If you look to the left of this point, you will see the number 0.0 on
the voltage axis, which tells you that the voltage is 0.0 V (volts). If you look below
point A, you will see another number 0.0, this time on the time axis, which tells you
that the time is 0.0 ms (milliseconds) at this point.

At point B, 0.25 milliseconds later, the voltage has risen to a positive peak of 0.8 volts.
At point C, 0.75 milliseconds after the start, the voltage has dropped to a negative
peak of -0.8 volts. After 1 millisecond, the voltage has risen back to 0.0 volts and a
new cycle is about to begin. This type of signal is called a sine wave, and is one of a
limitless range of signal types that you will encounter.

Most oscilloscopes allow you to adjust the vertical and horizontal scales of the display.
The vertical scale is called the voltage range (in this example at least, although
scales in other units, such as milliamperes, are possible). The horizontal scale is called
the timebase and is measured in units of time - in this example, thousandths of a
second.

psw.en r39
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52 PC Oscilloscope basics

A PC Oscilloscope is a measuring instrument that consists of a hardware scope device
and an oscilloscope program running on a PC. Oscilloscopes were originally stand-alone
instruments with no signal processing or measuring abilities, and with storage only
available as an expensive extra. Later oscilloscopes began to use new digital
technology to introduce more functions, but they remained highly specialised and
expensive instruments. PC Oscilloscopes are the latest step in the evolution of
oscilloscopes, combining the measuring power of Pico Technology's scope devices with
the convenience of the PC that's already on your desk.

PC scope device PC Oscilloscope

5.3 PicoScope basics

PicoScope can produce a simple display such as the example in the Oscilloscope basics
topic, but it also has many advanced features. The screen shot below shows the
PicoScope window. Click on any of the underlined labels to learn more. See PicoScope
window for an explanation of these important concepts.

Capture Setup

Buffer Mavigation

Zooming and

toolbar toolbar Scrolling toolbar
gy PicoSqope 6 = B
Menu bar — File Edit Views Measurements Tools Hel
channel P Tl | e | 2 424 | | 200 psfelv []]] [ 1 | s.064ks @qu 32 of 32 g;"k@&kk’:‘q @
Setup —f A, At [v] DC [+]]] ] |
toolbar ]
-
W
12
08
04
0.0
-0.4
Scope
view -0.8
-12
Time 15
Ruler )
handle 25
-1.0 -0.8 -06 -0.4 -0.2 op 02 0.4 06 0.8 1.0
Scale — m: — — —
button @@ [[rrigger [ate ] 0 A ENFAESIED SIEEEEE l[ﬁ ]
Stop/Start Triggering Trigger Measurements
toolbar toolbar marker toolbar

Note: Other buttons may appear in the PicoScope main window depending on the

capabilities of the oscilloscope that is connected, and on the settings applied to the
PicoScope program.

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved. psw.en r39
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5.3.1

Capture modes

PicoScope can operate in three capture modes: scope mode, spectrum mode and
persistence mode. The mode is selected by buttons in the Capture Setup Toolbar.

Capture mode buttons

——

B Mo | 2 4 | zoousidy V] | =1 FHEIE) | [itms B

' In scope mode, PicoScope displays a main scope view, optimizes its settings for
use as a PC Oscilloscope, and allows you to directly set the capture time. You can
still display one or more secondary spectrum views.

 In spectrum mode, PicoScope displays a main spectrum view, optimizes its settings
for spectrum analysis, and allows you to directly set the frequency range in a similar
way to a dedicated spectrum analyzer. You can still display one or more secondary
scope views.

» In persistence mode, PicoScope displays a single, modified scope view in which old
waveforms remain on the screen in faded colors while new waveforms are drawn in
brighter colors. See also: How to find a glitch using persistence mode and the
Persistence Options dialog.

When you save waveforms and settings, PicoScope only saves data for the mode that
is currently in use. If you wish to save settings for both capture modes, then you need
to switch to the other mode and save your settings again.

See also: How do capture modes work with views?

psw.en r39
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5.3.2

How do capture modes work with views?

The capture mode tells PicoScope whether you are mainly interested in viewing
waveforms (scope mode) or frequency plots (spectrum mode). When you select a
capture mode, PicoScope sets up the hardware appropriately and then shows you a
view that matches the capture mode (a scope view if you selected scope mode or
persistence mode, or a spectrum view if you selected spectrum mode). The rest of this
section does not apply in persistence mode, which allows only a single view.

Once PicoScope has shown you the first view, you can, if you wish, add more scope or
spectrum views, regardless of the capture mode you are in. You can add and remove

as many extra views as you wish, as long as one view remains that matches the
capture mode.

Persistence

mode
L
Add second Add
scope view spectrum view,
Start Select M
PicoScope »| capture —a
mode Eum..,_m..]
u Spectrum Add second Add
mode spectrum view scope view
| L-r-»—-—-v—u---v---—-m‘

Examples showing how you might select the capture mode and open additional
views in PicoScope. Top: persistence mode (one view only). Middle: scope mode.
Bottom: spectrum mode.

When using a secondary view type (a spectrum view in scope mode, or a scope view in
spectrum mode), you may see the data compressed horizontally rather than displayed
neatly as in a primary view. You can usually overcome this by using the zoom tools.

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved. psw.en r39
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PicoScope and oscilloscope primer

54

PicoScope window

The PicoScope window shows a block of data captured from the scope device. When
you first open PicoScope it contains one scope view, but you can add more views by
clicking Add view in the Views menu. The screen shot below shows all the main
features of the PicoScope window. Click on the underlined labels for more information.

PicaScope Views
window menu
|
gy ! PicoScope 6 = =
File Edit Views Measurements Tools Help |
Al MLl | il | 2 3 | | 500 psfdiv [+ [ x 1 E|lims B[4l 32fof32 ,g;||\{"pqe\q [T}
Ay Aute  [v]|DC O tulof & M
Scope 1 |
m 20
. W .
Scope view 1 Add View i’ Scope
- Rename Yiew Spectrum
-205 Close View Xy
-25 -20 15 1.0 -0.5 25
T s Channels 3
Scope view 3 Ny X-Axis >
{hidden) Scope 2 | Scope 3 |
20 Grid Layout 3
Scope view 2 Arrange Grid Layout v
BReset View Sizes
Move View To 3 L 1.0V EEA 20V
Measurements
table Auto-arrange axes
= Reset View Layout
@O|Trigger Auto |V|ﬂf| A |V||X\$\| . . |G
= View Properties
@ BReference Waveforms 3
Ruler
EJ  Add Measurement legend

To arrange the views within the PicoScope window

If the PicoScope window contains more than one view, PicoScope arranges them in a
grid. This is arranged automatically, but you can customize it if you wish. Each
rectangular space in the grid is called a viewport. You can move a view to a different
viewport by dragging its name tab (show me), but you cannot move it outside the
PicoScope window. You can also put more than one view in a viewport, by dragging a

view and dropping it on top of another.

For further options, right-click on a view to obtain the View menu, or select View from
the Menu bar, then select one of the menu options to arrange the views.

psw.en r39
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1

5.5 Scope view

A scope view shows the data captured from the scope as a graph of signal amplitude
against time. (See Oscilloscope basics for more on these concepts). PicoScope opens

with a single view, but you can add more views by using the views menu. Similar to the
screen of a conventional oscilloscope, a scope view shows you one or more waveforms
with a common horizontal time axis, with signal level shown on one or more vertical
axes. Each view can have as many waveforms as the scope device has channels. Click
on one of the labels below to learn more about a feature.

Overvoliage indicator

Channel A

Yertical axis
for channel &

Time ruler

Ruler handle
Scaling button

Trigger Signal Ruler

Graticule diamond ruler legend
Scope 1| Scope2 | | |
W | 4 | R
T v'n | W
0.6 / 0.6 Yertical axis
04 | | 0.4 for channel B
w2t/ | N L N 02
oo | | oo
02 /-0.2
04 -04
| | Channel B
TE 1 | ‘: ;_' -0E
-05 -08
R -1.0
-1.084 -0.854 -0634 -0.454 -0.234 -0.034 011640316 0316 0716 0916
—_— me T 0 14984k H=

Measurements table —
B Feak ToPeak

B Cuty Cycle

Between rulers 1.602
wihale trace AOO3 %

Time Frequency
axis legend

Scope views are available regardless of which mode - scope mode or spectrum mode -

is active.

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.
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5.6

Overvoltage indicator

If an overvoltage (a signal outside the measuring range) is detected, the red warning
icon (M) will appear in the upper corner of the PicoScope screen next to the relevant
channel’s vertical axis.

Scopes with floating inputs only: If the BNC shell to chassis voltage exceeds the
measurement limit, the Channel LED will turn solid red, and the yellow warning icon ([)
will appear in the upper corner of the PicoScope screen next to the relevant channel’s
vertical axis. Parts of the waveform will also be missing when the measurement limit is
exceeded.

psw.en r39
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5.7 MSO view
Applicability: mixed-signal oscilloscopes (MSOs) only
The MSO view shows mixed analog and digital data on the same timebase.
Digital Inputs
button
g PicoScope 6 = :'
Archivo  Editar  Vistas Mediciones Herramientas  Aynda |
Ayl | | 2 4| 200 ussaivlv ]| x1 SIED E|Qﬂ 32 0f 32 @Hk{"?(k(:‘(:\ ‘(“‘“ I)iL-(_')
Ay |Auto ¢ [v] | By [Apagado =l
| =
v
_ Analog
20 - view
10
00
10
20
a0
‘& 02 04 06 08 10 12 14 15 18 20
| > Splitter
D15,
D14
b2
12
o1 o Digital
o1 - view
D8
D8
07| I 1 [ ] I 1
D§ [
o5 LML Uy UL
D4
D3
D2
o LrLrerrrrrrerrrrJrrrrrererrriroriri
L S (- N A———
Running @@ | Disparo Ninguna | | | | | Mediciones £ | Ruters (3 Motas (3

Digital Inputs button: Switches digital view on and off, and opens the Digital Setup

dialog.
Analog view: S_hows the analog channels. The same as a standard scope
view.
Digital view: Shows the digital channels and groups. See digital view.
Splitter: Drag up and down to move the partition between analog and

digital sections.

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.
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5.7.1  Digital view
Location: MSO view

Digital
channel

Digital
group

Note 1: You can right-click on the digital view to obtain the Digital Context Menu.

Note 2: If the digital view is not visible when required, check that (a) the Digital
Inputs button is activated and (b) at least one digital channel is selected for display in
the Digital Setup dialog.

Digital channel: Displayed in the order in which they appear in the Digital Setup
dialog, where they can be renamed.

Digital group: Groups are created and named in the Digital Setup dialog. You
can expand and collapse them in the digital view using the =
and |/ buttons.

psw.en r39 Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.
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5.7.2

Digital context menu
Location: right-click on the digital view

Sub View r

Format 3

Draw Groups k
Sub View:

Analog
Digital

Format: Hex
Binary
Decimal
Signed
Draw Groups: By Values
By Time
By Level

Analog: View or hide the analog
scope view.

Digital: View or hide the digital
scope view.

Also available from the Views menu.
The numerical format in which group
values are displayed in the digital

scope view.

By Values: Draw groups with
transitions only where the value

changes:
I_;| G1 i3] oz o4 (i3]

By Time: Draw groups with transitions
spaced equally in time, once per
sampling period. You will usually need
to zoom in to see the individual
transitions:

By Level: Draw groups as analog levels
derived from the digital data:
EI G1W

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.
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5.8

XY view

An XY view, in its simplest form, shows a graph of one channel plotted against
another. XY mode is useful for showing relationships between periodic signals (using
Lissajous figures) and for plotting I-V (current-voltage) characteristics of electronic
components.

Graticule Yiews menu
Scope 1 l
m 10
W Add Wiew »
Channel A
Rename View
Close Yiew
Y axis Channels 3
{Channel &)
oo H-fixis 3 Time
- arid Layout 3 A
04 Reset View Sizes E %
06 Mowe View Ta 3
0& Reset View Layout
105

. A0 08 -0F 04 02 00 02 04 06 05 10
Scaling button —-§ Y I

® axis
{Channel B}

In the example above, two different periodic signals have been fed into the two input
channels. The smooth curvature of the trace tells us that the inputs are roughly or
exactly sine waves. The three loops in the trace show that Channel B has about three
times the frequency of Channel A. We can tell that the ratio is not exactly three
because the trace is slowly rotating, although you cannot see that in this static
picture. Since an XY view has no time axis, it tells us nothing about the absolute
frequencies of the signals. To measure frequency, we need to open a Scope view.

How to create an XY view
There are two ways to create an XY view.

Use the Add View > XY command on the Views menu. This adds a new XY view to
the PicoScope window without altering the original scope or spectrum view or views.
It automatically chooses the two most suitable channels to place on the X and Y
axes. Optionally, you can change the X axis channel assignment using the X-Axis
command (see below).

Use the X-Axis command on the Views menu. This converts the current scope view
into an XY view. It maintains the existing Y axes and allows you to choose any
available channel for the X axis. With this method, you can even assign a math
channel or a reference waveform to the X axis.

psw.en r39
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5.9

5.10

Trigger marker
The trigger marker shows the level and timing of the trigger point.

Trigger

Trigger marker
marker et— 199

(off-screen indicator)

The height of the marker on the vertical axis shows the level at which the trigger is
set, and its position on the time axis shows the time at which it occurs.

You can move the trigger marker by dragging it with the mouse or, for more accurate
control, by using the buttons on the Triggering toolbar.

Other forms of trigger marker

If the scope view is zoomed and panned so that the trigger point is off the screen, the
off-screen trigger marker (shown above) appears at the side of the graticule to
indicate the trigger level.

In post-trigger delay mode, the trigger marker is temporarily replaced by the post-
trigger arrow while you adjust the post-trigger delay.

When some advanced trigger types are in use, the trigger marker changes to a window
marker, which shows the upper and lower trigger thresholds.

For more information, see the section on Trigger timing.

Post-trigger arrow

The post-trigger arrow is a modified form of the trigger marker that appears
temporarily on a scope view while you are setting up a post-trigger delay, or dragging
the trigger marker after setting up a post-trigger delay. (What is a post-trigger delay?)

N

The left-hand end of the arrow indicates the trigger point, 0.2
and is aligned with zero on the time axis. If zero on the
time axis is outside the scope view, then the left-hand 00
end of the post-trigger arrow appears like this: '

0z

The right-hand end of the arrow (temporarily replacing the trigger marker) indicates the
trigger reference point.

Use the buttons on the Triggering toolbar to set up a post-trigger delay.

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved. psw.en r39
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5.11  Spectrum view
A spectrum view is one view of the data from a scope device. A spectrumis a
diagram of signal level on a vertical axis plotted against frequency on the horizontal
axis. PicoScope opens with a scope view, but you can add a spectrum view by using
the views menu. Similar to the screen of a conventional spectrum analyzer, a spectrum
view shows you one or more spectra with a common frequency axis. Each view can
have as many spectra as the scope device has channels. Click on one of the labels
below to learn more about a feature.
Ruler Signal
Graticule legend ruler
Spectrum 2 l
mi00 .
cBu | B 160 dBu - —_
2110 O 7.0 MHz — —
Channel & = _ o T —
320
Signal axis 425
for Channel A 53.0
B35
Frequency 740
ruler 845
-a5.07)
00 100 20, 300 40.0 500 600
mHZ
Measurements z
table
B Frequency at Peak A At Peak. 9995 kHz
B Amplitude at Peak, L) Af Peak 1.117 dBu
Frequency
axis
Unlike in the scope view, in the spectrum view the data is not clipped at the limits of
the range displayed on the vertical axis, so you can apply axis scaling or offset to see
more data. Vertical axis labels are not provided for data outside what is considered to
be the 'useful' range, but rulers will still work outside this range.
Spectrum views are available regardless of which mode - Scope Mode or Spectrum
Mode - is active.
For more information, see: How to set up the spectrum view and Spectrum Options
dialog.
psw.en r39 Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.
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5.12 Persistence mode

Persistence mode superimposes multiple waveforms on the same view, with more
frequent data or newer waveforms drawn in brighter colors than older ones. This is
useful for spotting glitches, when you need to see a rare fault event hidden in a series
of repeated normal events.

Enable persistence mode by clicking the Persistence Mode button L on the Capture
Setup toolbar. With the persistence options set at their default values, the screen will
look something like this:

dg PicoScope 6 - B
Eile Edit Views Tools Help |
Al | | 2 G| [owsian[o]] 1 B[R A QS D[4

e

...............................................

Running @)@ | Trigger |Repeat [v] | & (]| % | = | Rulers [ Notes

The colors indicate the frequency of the data. Red is used for the highest-frequency
data, with yellow for intermediate frequencies and blue for the least frequent data. In
the example above, the waveform spends most of its time in the red region, but noise
causes it to wander occasionally into the blue and yellow regions. These are the
default colors, but you can change them using the Persistence Options dialog.

This example shows persistence mode in its most basic form. See the Persistence
Options dialog for ways to modify the display to suit your application, and How to find a
glitch using persistence mode for a worked example.

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved. psw.en r39
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5.13 Measurements table
A measurements table displays the results of automatic measurements. Each view
can have its own table, and you can add, delete or edit measurements from this table.
|
H A Frequency Wheole trace |4.567 kHz (3,333 kHz |7.336 kHz |5.296 kHz 9975 Hz |20
A Rise Time [B0/20%)] |Whole trace [187.6 ps (2436 ps (4725 ps (1405 ps 123.7ps |20
Measurements table columns
Name The name of the measurement that you selected in the Add
Measurement or Edit Measurement dialog. An F after the name indicates
that the statistics for this measurement are filtered.
Span The section of the waveform or spectrum that you want to measure.
This is 'Whole trace' by default.
Value The live value of the measurement, from the latest capture
Min The minimum value of the measurement since measuring began
Max The maximum value of the measurement since measuring began
Average The arithmetic mean of the measurements from the last n captures,
where n is set in the General page of the Preferences dialog
o The standard deviation of the measurements from the last n captures,
where n is set in the General page of the Preferences dialog
Capture The number of captures used to create the statistics above. This starts
Count at 0 when triggering is enabled, and counts up to the number of captures
specified in the General page of the Preferences dialog.
To add, edit or delete measurements
See: Measurements toolbar.
To change the width of a measurement column
First ensure that the Column Auto-width option is not enabled Pl
in the Measurements menu. If necessary, click the option to 5.8 mV | 705.5 mV
switch it off. Then drag the vertical separator between column 1 1 ms
headings to resize the columns, as shown opposite. —
To change the update rate of the statistics
The statistics (Min, Max, Average, Standard Deviation) are based on the number of
captures shown in the Capture Count column. You can change the maximum capture
count using the Capture Size control in the General page of the Preferences dialog.
psw.en r39 Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.



PicoScope 6 User's Guide

21

5.14  Pointer tool tip
The pointer tool tip is a box that displays the horizontal and vertical axis values at the

mouse pointer location. It appears temporarily when you click the background of a

view.

Pointer

tool tip

2E6.7617ps
X 70,851 m
E: 370,851 m

Py

Pointer tool tip
in a scope view

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.
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5.15  Signal rulers

The signal rulers (sometimes called cursors) help you measure absolute and relative
signal levels on a scope, XY or spectrum view.

Ruler Close
legend button
| !
Ruler Yo m seamv B12.0 my 2040 m

drag-handle
(IR S]

Signal 0.4
—_—

axis 02
0.0 Signal
rulers
-0z
04
-0E
20811 .0mY
Boa— a L
g
05 04 03 -02 -01 00O |01 02 03 04 0
M=
Fuler
tool tip

In the scope view above, the two colored squares to the left of the vertical axis are
the ruler drag-handles for channel A. Drag one of these downwards from its resting
position in the top left corner, and a signal ruler (a horizontal dashed line) will extend
from it.

Whenever one or more signal rulers is in use, the ruler legend appears. This is a table
showing all of the signal ruler values. If you close the ruler legend using the Close
button, all the rulers are deleted.

Signal rulers also work in spectrum and XY views.

Ruler tool tip

If you move the mouse pointer over one of the rulers, PicoScope displays a tool tip with

the ruler number and the signal level of the ruler. You can see an example of this in the
picture above.
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5.16 Time rulers
The time rulers measure time on a scope view or frequency on a spectrum view.

Ruler
legend
KT | |
W O 145.0ps 3480 p= 2010 ps |
06
0.4
05 Puler
: tool tip
0.0
-0.2 _
Time
04 ruler
-0.6
-0.5
A0 Fuler
-05 04 -03|-02 -01 00 handle
................. [ N

Titne Frequency
axis legend

In the scope view above, the two white squares on the time axis are the time ruler
handles. When you drag these to the right from the bottom left corner, vertical
dashed lines called time rulers appear. The rulers work in the same way on a spectrum
view, but the ruler legend shows their horizontal positions in units of frequency rather
than time.

Ruler tool tip

If you hold the mouse pointer over one of the rulers, as we did in the example above,
PicoScope displays a tool tip with the ruler number and the time value of the ruler.

Ruler legend

The table at the top of the view is the ruler legend. In this example, the table shows
that time ruler 1 is at 148.0 microseconds, ruler 2 is at 349.0 microseconds and the
difference between them is 201.0 microseconds. Clicking the Close button on the ruler
legend also deletes all the rulers.

Frequency legend

The frequency legend in the bottom right-hand corner of a scope view shows 1/A,
where A is the difference between the two time rulers. The accuracy of this calculation
depends on the accuracy with which you have positioned the rulers. For greater
accuracy with periodic signals, use the frequency measurement function built in to
PicoScope.
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5.17  Phase (rotation) rulers
Location: Scope view

The phase rulers (called rotation rulers in PicoScope Automotive) help to measure
the timing of a cyclic waveform on a scope view. Instead of measuring relative to the
trigger point, as time rulers do, phase rulers measure relative to the start and end of a
time interval that you specify. Measurements may be shown in degrees, percent or a
custom unit as selected by the Ruler settings box.

To use the phase rulers, drag the two phase ruler handles onto the waveform from their
inactive position as shown below:

N
i

1.2

SN N
woF N \

0.4 \ Ir_.r

SN

L2

L&

20 e Drag to position
04 -2 00 02 04 06 05 LD L2 14 16 phase rulers

ms

When you have dragged both phase rulers into position, the scope view will look like
this (we also added two time rulers, for a reason that will be explained later):

Ruler
legend
N 4 Ruler positions
W O z57ps  |7504ps 4248 s T In time units
O 1174 0> 15250 T
1 | | |

Ruler positions

0.8 | i | in phase units
| -/
- \ o1

|

|

rulers

7
\__:/’ b Phase
i
0

| %
|
|
| |
: —
: |
< 7

Start and end phase
(double-click to edit)
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In the scope view above, the two phase rulers have been dragged into place to mark
the start and end of a cycle.

The default start and end phase values of 0° and 360° are shown below the rulers and
can be edited to any custom value. For example, when measuring timings on a four-
stroke engine, it is customary to show the end phase as 720° as one cycle comprises
two rotations of the crankshaft.

Ruler legend

The phase rulers become more powerful when used in conjunction with time rulers.
When both types of rulers are used together, as shown above, the ruler legend displays
the positions of the time rulers in phase units as well as time units. If two time rulers
are positioned, the legend also shows the phase difference between them. Closing the
ruler legend dismisses all rulers including the phase rulers.

Ruler options

Options for the phase (rotation) rulers are configured by the Ruler Settings dialog,
which is called up by the Rulers button on the Advanced Options toolbar.
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5.18 Ruler settings
Location: Advanced Options toolbar > Rulers

The Ruler Settings box allows you to control the behavior of the time rulers and phase
rulers (called rotation rulers in PicoScope Automotive).

Ruler Settings x Ruler Settings x

Phase Ruler

Phase Wrap ]
Phase Partition 1 [£

Units

Degrees (7
Percent (3%

() (W

Custom (

Ruler Settings in
PicoScope

Rotation Ruler

Rotation Wrap ||
Rotation Partition | 1 [~

Units
Degrees [7) (®)
Percent %)

Custom O

Ruler Settings in
PicoScope Automotive

Phase (Rotation) Wrap If this box is checked, time ruler values outside the
range set by the phase (rotation) rulers are wrapped
back into that range. For example, if the phase
(rotation) rulers are set to 0° and 360°, the value of a
time ruler just to the right of the 360° phase (rotation)
ruler will be 0°, and the value of a time ruler just to the
left of the 0° phase (rotation) ruler will be 359°. If this

box is unchecked, ruler values are unconstrained.

Phase (Rotation) Partition Increasing this value above 1 causes the space between
the two phase (rotation) rulers to be partitioned equally
into the specified number of intervals. The intervals are
marked by broken lines between the phase (rotation)
rulers. The lines help you to interpret complex waveforms
such as the vacuum pressure of a four-stroke engine
with its intake, compression, ignition and exhaust
phases, or a commutated AC waveformin a switch mode
power supply.

m Z0

| \ /|
o \\4'/ | \\_//
1.2
16

|
2.0y ‘
_D':,_Is 0.2 El 02 04 06 08 12 14 1e

Phase (rotation) rulers with 4 partitions
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5.19

5.20

Units You can choose between Degrees, Percent or Custom.
Custom allows you to enter your own unit symbol or
name.

Ruler legend

The ruler legend is a box that displays the positions of all the rulers you have placed
on the view. It appears automatically whenever you position a ruler on the view:

Ruler 2
Ruler 1 Vvalues  Ruyler
wvalues difference o
l l Mimimise
#——and Close
Time or frequency muler —s 01655 1078|521 buttons

. — W20 MV [4230mV  [E45.0 mV
Signal rulers - - - Lock
—* @ 720 mY AE0mV (4750 MV ——
button

Editing

You can adjust the position of a ruler by editing any value in the first two columns. To
insert a Greek W (the micro symbol, meaning one millionth or x 107°), type the letter u.

Tracking rulers

When two rulers have been positioned on one channel, the Lock button & appears
next to that ruler in the ruler legend. Clicking this button causes the two rulers to track
each other: dragging one causes the other one to follow it, maintaining a fixed

separation. The button changes to # when the rulers are locked.

TIP: To set up a pair of tracking rulers with a known distance between them, first
click the Lock button, then edit the two values in the ruler legend so that the rulers
are the desired distance apart.

Phase (rotation) rulers

When phase rulers (called rotation rulers in PicoScope Automotive) are in use, the
ruler legend displays additional information.

See also: frequency legend.

Frequency legend
| 33,37 Hz, 2002.0 RPhd

The frequency legend appears when you have placed two time rulers on a scope
view. It shows 1/A in hertz (the SI unit of frequency, equal to cycles per second),
where A is the time difference between the two rulers. You can use this to estimate
the frequency of a periodic waveform, but you will get more accurate results by
creating a frequency measurement using the Add Measurements button on the
Measurements toolbar.

For frequencies up to 1.666 kHz, the frequency legend can also show the frequency in
RPM (revolutions per minute). The RPM display can be enabled or disabled in the
Preferences > Options dialog.
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521 Properties sheet
Views > View Properties

Location:

Purpose:

shows a summary of the settings that PicoScope 6 is using

The Properties sheet appears on the right-hand side of the PicoScope window.

Sampling
settings

settings

Channel
settings

Signal
generator
settings

Time stamp

Capture rate

Properties x

No. samples. The number of
samples captured. This may be
lower than the number requested
in the Maximum Samples control. A
number in brackets is the number

of interpolated samples if
interpolation is enabled.

Window. The window function
applied to the data before

computing the spectrum. This is

Sample interval &4 s
Sample rate 15.63 M5/
Mo, samples 781250
HM Resolution 12 bits
Window Blackman
Ma. bins 16384
Bin width 4768 Hz
Time gate 20587 ms
Channel A
Range =10 my
Coupling (.

selected in the Spectrum options
dialog.

Time gate. The number of samples
that PicoScope uses to compute a
spectrum is equal to twice the
number of bins. This nhumber of

samples is expressed as a time

interval called the time gate. It is
measured from the start of the

Res-Enhancement (resolution

enhancement). The number of
bits, including resolution

enhancement, selected in the

Res-Enhancement 13.0 Bits
Effective Res 11 Bits
Signal type Square
Frequency 1 kHz
Amplitude 1v capture.
Offset ov
Capture Date 35713
Capture Time 121637
Capture Rate 14

| Channel Options dialog.

Effective Res (effective
resolution; applies to Flexible
Resolution oscilloscopes only).
PicoScope tries to use the value
specified by the Hardware
Resolution control in the Capture
Setup toolbar, but on some voltage
ranges the hardware delivers a
lower effective resolution. The
available resolutions are specified in
the data sheet for the scope
device.

Capture rate. The number of
waveforms being captured per
second. Shown only in Persistence
Mode.

psw.en r39
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5.22  Custom probes

A probe is any transducer, measuring device or other accessory that you connect to
an input channel of your scope device. PicoScope has a built-in library of common
probe types, such as the x1 and x10 voltage probes used with most oscilloscopes, but
if your probe is not included in this list you can use the Custom Probes dialog to define
a new one. Custom probes can have any voltage range within the capabilities of the
oscilloscope, display in any units, and have either linear or nonlinear characteristics.

Custom probe definitions are particularly useful when you wish to display the probe's
output in units other than volts, or to apply linear or nonlinear corrections to the data.
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5.23

Math channels

A math channel is a mathematical function of one or more input signals. It can be
displayed in a scope, XY or spectrum view in the same way as an input signal, and like
an input signal it has its own measurement axis, scaling and offset button and color.
PicoScope 6 has a set of built-in math functions for the most important functions, such
as Invert A, A+B and A-B. You can also define your own functions using the equation
editor, or load predefined math channels from files.

Here is a three-step guide to using math channels:

1.

3.

1. Select Tools > 2. Tick the check box to enable the
Math Channels Math channel in the channel list
“hy PicoScope 6 e
Maths Channels “

File Edit Views Measurements Iolnls Help
Ayl Ll | | Z £ || s00psfdiv [v] | [ %1 B woks [ || SelectaMaths Channel [ ok |

Ay | Auto v] [oc |||B, £1V v] [oc |||

.V
04
-02
| Duplicate |

(AR A Cer

Explain what Built-in, Library and L oaded

Maths Channels are. |ﬂ|
20
3. The Math Channel
ﬂ/ﬂ—n\n r],m\L[\’_ appears in the
P “W Ny \”W AT eapevion
-2.0 -1.5 -10 -05 00 05 1.0 15 20 25

[ x03 | ms

@) Tigger [aute  [v] 12 |a |z~ | [ov SR |3

Tools > Math Channels command. Click this to open the Math Channels dialog,
shown at top right in the picture above.

. Math Channels dialog. This lists all the available math channels. In the example

above, only the built-in functions are listed.

Math channel. Once enabled, a math channel appears in the selected scope or
spectrum view. You can change its scale and offset as with any other channel. In
the example above, the new math channel (bottom) is defined as A-B, the
difference between input channels A (top) and B (middle).

You may occasionally see a flashing warning symbol - ! - at the bottom of the

math channel axis. This means that the channel cannot be displayed because an
input source is missing. For example, this occurs if you enable the A+B function

while channel B is set to Off.

psw.en r39
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5.24 Reference waveforms

A reference waveform is a stored version of an input signal. You can create one by
right-clicking on the view, selecting the Reference Waveforms command and
selecting which channel to copy. It can be displayed in a scope or spectrum view in the
same way as an input signal, and like an input signal it has its own measurement axis,
scaling and offset button and color. The reference waveform may have fewer samples

than the original.

For more control over Reference Waveforms, use the Reference Waveforms dialog as

shown below.

1. Select Tools >
Reference Waveforms

2. Select the input channel you
wish to use as the reference

by PicoScope 6 = B x|
. X
File Edit Views Measurements Tools Help Reference Waveforms
M| ML 1]]_1‘ | Z ﬁ| 500 us:di\r\z| ‘ %1 |§| | 100 kS |§| Select a Referenge Channel | oK |
Ay [pute [¥] o€ []] By [ate [ [ [¥)] Cq A"a"-a"'en | )
— — — — e
| R ®m g e
v Library
] B A
Loaded
0.2
S NS ) . 3. Create a reference
-1.0 Duplicate | from the selected
input channel
p . 4, Tick the check
— et box to display the
reference waveform
Explain what Available. Library and Loaded
Reference Channels are.
5. The new reference
waveform appears in the
Scope View
—
{shown here after
scale, offset and
g color adjustment)
-25 -20 -1.5 -1.0 05 00 05 10 15 20 25
ms
QO] moger (a0 M af[[2 Bl sflov  B[wx  ER T

6. Each reference waveform
has its own scale, offset and
delay adjustment dialog

Reference Waveforms button. Click this to open the Reference Waveforms dialog,

shown on the right in the picture above.

Reference Waveforms dialog. This lists all the available input channels and

reference waveforms. In the example above, input channels A and B are switched
on, so they appear in the Available section. The Library section is empty to begin

with.

w

Duplicate button. When you select an input channel or reference waveform and

click this button, the selected item is copied to the Library section.

Library section. This shows all your reference waveforms. Each one has a check

box that controls whether or not the waveform appears on the display.

Reference waveform. Once enabled, a reference waveform appears in the

selected scope or spectrum view. You can change its scale and offset as with any
other channel. In the example above, the new reference waveform (bottom) is a

copy of channel A.
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5.25

6. Axis control button. Opens an axis scaling dialog allowing you to adjust scale,
offset and delay for this waveform.

Serial decoding

You can use PicoScope to decode data from a serial bus such as I?C or CAN Bus. Unlike
a conventional bus analyzer, PicoScope lets you see the high-resolution electrical
waveform at the same time as the data. The data is integrated into the scope view, so
there's no need to learn a new screen layout.

Serial Decoding command "In Graph" serial data
iy PicoScope 6 - [12C_Sample.psdatal = B
Eile Edit Views Measurements Tools Help
Al | il | 7 42| |1 msyaiv M\ Custom Probes... § 23032 H}@” R R G S |Q‘ l.")iC(_')
Ay Auto DC [v] | By 2ute I Maths Channels e
B @ Reference Waveforms
v %5 Serial Decoding
50 @ Alarms |
304 1 Masks 3
i Macro Record Packet # 33: Data
acro hecorder Data hytesm
11 |ACK O
Prefi
— B Preferences | Start Time: 6533 ms
0839 End Time: 6639 ms
|=—— Data: Data bytes=0.. i Addressi7: Agdress=4.. Data: Data buies=18.. H iddress(7): Address=4. Data: Data byi. | 50
277912C-A 3.88
1.94
-3.88
5.0
o ®
982.2 10445 11067 11689 12311 12934 13556 1417.8 14800 15423 1604.5
b -50ms
< [T
D =
Search | Refresh  Clear
™ [ Packet [ Address [ Readrwrite | D=t bytes [ Acknowiedge [ Start Time [ End Time
33 Data = = 01 0 £533ms |6639ms
34 Step - - - - 666ms  666ms
EH Stan - - - - £666ms 6666 ms =
L Adress(7) 70 - - 0 E87Ems  E77ims
7 Dtz - - 03 0 TEims TE06ms
W A-12C
Stopged @@H Trigger Mone | ‘ ‘ Measurements ‘ Rulers Motes
Decoding tab "In Table" serial data

How to use Serial Decoding
1. Select the Tools > Serial Decoding menu command.

2. Complete the Serial Decoding dialog.

3. Choose to display the data In Graph, In Table, or both.

4. You can decode multiple channels in different formats simultaneously. Use the
Decoding tab below the In Table data table (shown in the picture above) to select
which channel of data to display in the table.
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5.26

Mask limit testing

Mask limit testing is a feature that tells you when a waveform or spectrum goes
outside a specified area, called a mask, drawn on the scope view or spectrum view.
PicoScope can draw the mask automatically by tracing a captured waveform, or you
can draw it manually. Mask limit testing is useful for spotting intermittent errors during
debugging, and for finding faulty units during production testing.

To begin, go to the main PicoScope menu and select Tools > Masks > Add Masks.
This opens the Mask Library dialog. When you have selected, loaded or created a mask,

the scope view will appear as follows:

iy

PicoScope 6 = =

| File Edit Views Measurements Tools Help

Bl == ) oROQSS |

r|_dn|...|9ﬁ;}50usfdiux1 5| st

Ay | Auto DC | 2y [off

| ng|

(A) Mask

(B) Failed waveforms

(C) Measurements table

Shows the allowed area (in white) and the disallowed
area (in blue). Right-clicking the mask area and selecting
the Edit Mask command takes you to the Edit Mask
dialog. You can change the mask colors with the Tools
> Preferences > Colors dialog; add, remove and save
masks using the Masks menu; and hide and display
masks using the Views > Masks menu.

If the waveform enters the disallowed area, it is counted
as a failure. The part of the waveform that caused the
failure is highlighted, and persists on the display until the
capture is restarted.

The number of failures since the start of the current
scope run is shown in the Measurements table. You can
clear the failure count by stopping and restarting the
capture using the Start/Stop button. The measurements
table can display other measurements at the same time
as the mask failure count.
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5.27 Alarms

Alarms are actions that PicoScope can be programmed to execute when certain
events occur. Use the Tools > Alarms command to open the Alarms dialog, which
configures this function.

The events that can trigger an alarm are:

Capture - when the oscilloscope has captured a complete waveform or block of
waveforms.

Buffers Full - when the waveform buffer becomes full.

Mask(s) Fail - when a waveform fails a mask limit test.

The actions that PicoScope can execute are:

Beep

Play Sound

Stop Capture
Restart Capture
Run Executable
Save Current Buffer
Save All Buffers

See Alarms dialog for more details.
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5.28 Buffer Overview

The PicoScope waveform buffer can hold up to 10,000 waveforms, subject to the
amount of available memory in the oscilloscope. The Buffer Overview helps you to
scroll through the buffer quickly to find the waveform you want.

To begin, click the Buffer Overview £} putton in the Buffer Navigation toolbar. This
opens the Buffer Overview window:

Avavava
I

r‘“at_ﬂﬁ"qw#“i,, Y

\/\/V\/\/\ IVAVAVAY
T EPEE R TR
N

Buffers to show

(M) (#) ERemmee

Click on any one of the visible waveforms to bring it to the front of the overview for
closer inspection, or use the controls:

Buffers to show

M Start:
ﬁl Backward:

LI Zoom in:

LI Zoom out:
m Forward:
M End:

If any of the channels has a mask applied, then you can select
the channel from this list. The Buffer Overview will then show
only the waveforms that failed the mask test on that channel.

Scroll to waveform number 1.

Scroll to the next waveform on the left.

Change the scale of the waveforms in the Buffer Overview
view. There are three zoom levels:

Large: default view. One waveform fills the height of the
window.

Medium: a medium-sized waveform above a row of small
waveforms.

Small: a grid of small waveforms. Click on the top or bottom row
of images to scroll the grid up or down.

Scroll to the next waveform on the right.

Scroll to the last waveform in the buffer. (The number of
waveforms depends on the Tools > Preferences > General>
Maximum Waveforms setting and on the type of scope
connected).

Click anywhere on the main PicoScope window to close the Buffer Overview window.
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6 Menus

Menus are the quickest way to get to PicoScope's main features. The Menu bar is
always present at the top of the PicoScope main window, just below the window's title
bar. You can click any of the menu items, or press the Alt key and then navigate to
the menu using the arrow keys, or press the Alt key followed by the underlined letter in

one of the menu items.

Click a menu for
more information

l

File Edit \iews Measurements Tools  Help

The list of items in the menu bar may vary depending on the windows that you have
open in PicoScope.
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6.1

File menu

Location:

Purpose:

N

B

Menu bar > File

gives access to file input and output operations

Open...

Save
Save Az,

Wawveform Library Browser
Startup Settings k

Print Preview...

Erint...
Recent Files »

Exit

Connect Device. This command appears only when there is no scope device
connected. It opens the Connect Device dialog, which allows you to select
the scope device you wish to use.

Open. Allows you to select the file you want to open. PicoScope can open
.psdata and .psd files, which contain both waveform data and scope device
settings, and .pssettings and .pss files, which contain only scope device
settings. You can create your own files using the Save and Save As...
commands, described below. If the file was saved using a different scope
device from the one that is presently connected, PicoScope may need to
modify the saved settings to suit the present device.

Hint: Use the Page Up and Page Down keys to cycle through all the
waveform files in the same directory.

Save. Saves all waveforms using the file name shown in the title bar. If you
haven't entered a file name yet, the Save As dialog opens to prompt you for
one.

Save As. Opens the Save As dialog, which allows you to save the settings,
waveforms, custom probes and math channels for all views in various formats.
Only the waveforms for the mode currently in use (Scope Mode or Spectrum
Mode) will be saved.

In persistence mode, this command is called Save Persistence As and saves
only the data for this mode.

Waveform Library Browser. Accesses the Waveform Library Browser.

Startup Settings. Opens the Startup Settings menu.

Print Preview. Opens the Print Preview window, which allows you to see how
your workspace will be printed when you select the Print command.

Print. Opens a standard Windows Print dialog, which allows you to choose a
printer, set printing options and then print the selected view.
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Recent Files. A list of recently opened or saved files. This list is compiled
automatically, but you can clear it using the Files page of the Preferences
dialog.

Exit. Close PicoScope without saving any data.

6.1.1  Save As dialog
Location: File > Save All Waveforms As or Save Current Waveform As

Purpose: allows you to save your waveforms and settings (including custom
probes and active math channels) to a file in various formats

PicoScope Automotive only: the Details dialog appears before the Save As dialog to
allow you to record details of the vehicle and the customer.

iy Save As H

Savein: | , PicoScope j L] |‘=_°F Ed~
L= Mame : Date modified Type Size
ok bt { o . "
Recent places 44 ch-scaled.psdata 28/03/2011 11:47 PicoScope data file 15KB
by capt-win-two-views.psdata 26/02/2008 11:29 PicoScope data file 44 KB
. Oy mask.psdata 14/05/2009 12:55 PicoScope data file 863 KB
Desktop by math-channels.psdata 13/03/2009 14:31 PicoScope data file 631 KB
— Uy PicoScope window M5S0, psdata 13/03/2009 14:23 PicoScope data file 564 KB
=l by PicoScope window.psdata 12/07/2000 10:41 PicoScope data file 11,090 KB
Libraries Uy reference-waveform.psdata 18/06/2007 09:21 PicoScope data file 10KB
L™
This PC
@
Network
File name: |2I}‘I 408220001 psdata j Save |
Save as type: |Data files [* psdata) hd e
.
Options Settings files (* pssettings)

T Al o § CSV {Comma delimited) files {*.cav)
" All waveforms (count: 32) 1124 b delimited) fles (~bd)

" Current waveform only (numb) Btmap images (" bmp)
GIF images (".gif}

7 5|Animated GIF image (".gif)
PMNG images (".pna)

1) Saving a file of approximate size MATLAE 4 files (".mat)
JPG Images (" jpag)

POF (" pdf)

™ Waveform numbers

Type your chosen file name in the File name box, and then select a file format in the
Save as type box. You can save data in the following formats:

Data files (.psdata) Stores waveforms and settings from the
current scope device. Can be opened on any
computer running PicoScope.

Settings files (.pssettings) Stores all settings (but not waveforms) from
the current scope device. Can be opened on
any computer running PicoScope.
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CSV (Comma delimited) files (.csv)

Text (Tab delimited) files (.txt)

Bitmap images (.bmp)

GIF images (.gif)

Animated GIF image (.gif)

PNG images (.png)

MATLAB 4 files (.mat)

JPEG (.jpg)

Options

Stores waveforms as a text file with comma-
separated values. This format is suitable for
importing into spreadsheets such as Microsoft
Excel. The first value on each line is the time
stamp, and it is followed by one value for each
active channel, including currently displayed
math channels. (Details)

Stores waveforms as a text file with tab-
separated values. The values are the same as
those in the CSV format. (Details)

Stores a picture of the waveforms, graticule
and rulers in Windows BMP format. The image
is 800 pixels wide by 600 pixels high, in 16
million colors, and uncompressed. BMP files are
suitable for importing into Windows desktop-
publishing programs.

Stores the waveforms, graticule and rulers in
Compuserve GIF format. The image is 800
pixels wide by 600 pixels high, in 256 colors,
and compressed. GIF files are widely used to
illustrate web pages.

Creates an animated GIF that displays all of
the waveforms in the buffer in sequence. Each
waveform is formatted as in the single GIF
format described above.

Stores the graticule, rulers and waveforms in
PNG format. The image is 800 pixels wide by
600 pixels high, in 16 million colors, with
lossless compression.

Stores the waveform data in MATLAB 4
format.

Stores the graticule, rulers and waveforms in
JPG format. The image is 800 pixels wide by
600 pixels high, in 16 million colors, with lossy
compression.

The first three options control what happens when the waveform buffer contains more

than one waveform:

All waveform buffers

Save all of the waveforms in the selected file
format. If the file format is PSDATA, all of the
waveforms are collected in a single file. You
can then load this into PicoScope and step
through the waveforms using the buffer
navigation controls. If the selected file format
does not support multiple waveforms,
PicoScope creates a new directory containing
multiple files.
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Current waveform buffer only

Waveform buffers

Only zoomed regions

Save the single waveform that is currently on
view.

Save the specified list or range of waveforms.
Each waveform is identified by its index
number. For example:

1,2,9,10

2, 5-10

If the waveform is zoomed horizontally, save
only the visible portion.

psw.en r39
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6.1.1.1  File formats for exported data
PicoScope 6 can export raw data in either text or binary format:
Text-based file formats
Easy to read without special tools
Can be imported into standard spreadsheet applications
Files are very large if there are many samples in the data (so files are limited to
about 1 million values per channel)

Text file format details

Binary file format

Files remain relatively small and can even be compressed in some situations (this
means that the amount of saved data is unlimited)

Either a special application is required to read the files or the user must write a
program to read the data from the file

If you need to save more than 64 K values per channel, then you must use a binary file
format such as the MATLAB® MAT-file format.

Binary file format details

Data types for storing PicoScope 6 data

Regardless of whether the data types were loaded from a binary file or from a text-
based file, we recommend the following data formats for storing the values loaded from
a PicoScope 6 data file:

Sampled data (such as voltages) should use 32-bit single-precision floating-point
data types.
Times should use 64-bit double-precision floating-point data types.

6.1.1.1.1 Text formats

Text-format files exported by PicoScope 6 are encoded in UTF-8 format by default.
This is a popular format which is capable of representing a huge range of characters,
whilst still retaining some compatibility with the ASCII character set if only standard
Western European characters and numbers are used in the file.

CSV (comma-separated values)
CSV files store data in the following format:

Time, Channel A, Channel B
(ps), (V), (V)

-500.004, 5.511, 1.215
-500.002, 4.724, 2.130
-500, 5.552, 2.212

There is a comma after each value on a line to represent a column of data and a
carriage return at the end of the line to represent a new row of data. The 1 million
values per channel limit prevents excessively large files being created.
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6.1.1.1.2

Note. CSV files are not the best choice of format if you are working in a language that
uses the comma character as the decimal point. Instead, try using the tab-delimited
format which works in almost the same way.

Tab-delimited

Tab-delimited files store data in the following format:

Time Channel A Channel B
(ps) (V) (V)
500.004 5.511 1.215
-500.002 4.724 2.130
-500 5.552 2.212

The files have a tab character after each value on a line to represent a column of data
and a carriage return at the end of the line to represent a new row of data. These files
work in any language and are a good choice for sharing data internationally. The 1
million values per channel limit prevents excessively large files being created.

Binary formats

PicoScope 6 can export data in version 4 of the .mat binary file format. This is an
open format and the full specification is freely available from the www.mathworks.com
website. PicoScope 6 saves data into the MAT-File format in a specific way, which is
detailed below.

Importing into MATLAB
Load the file into your workspace using this syntax:

load myfile

Each channel’s data is stored in an array variable named by the channel. So, the
sampled data for channels A to D would be in four arrays named A, B, C and D.

There is only one set of time data for all channels and this is loaded in one of two
possible formats:

1. A start time, an interval and a length. The variables are named Tstart, Tinterval
and Length.
2. An array of times (sometimes used for ETS data). The time array is named T.

If the times are loaded in as Tstart, Tinterval and Length then you can use the
following command to create the equivalent array of times:

T = [Tstart : Tinterval : Tstart + (Length - 1) * Tintervall];

Note: The size of the largest file that MATLAB can open depends on the resources of
the computer. It is therefore possible for PicoScope to create a MATLAB file that some
installations of MATLAB might be unable to open. Please be aware of this risk when
saving critical data.

Exploring the file format
The full file specification, available from www.mathworks.com, is comprehensive so this

guide does not describe the entire format. Instead, this guide describes enough of the
format to allow you to get data from the file and use it in your own program.
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The variables described above (under Importing into Matlab) are stored in a series of
data blocks, each preceded by a header. Each variable has its own header and data
block and the corresponding variable names are stored with them (such as A, B,
Tstart). The following sections describe how to read each variable from the file.

The order of the data blocks is not specified, so programs should look at the variable
names to decide which variable is currently being loaded.

The header

The file consists of a number of data blocks preceded by 20-byte headers. Each header
contains five 32-bit integers (as described in the table below).

Bytes Value

0-3 Data format (0, 10 or 20)
4 -7 Number of values

8 -11 1

12 - 15 0

16 - 19 Name length

Data format
The ‘Data format’ in the first 4-bytes describes the type of numerical data in the array.

Value Description

0 Double (64-bit floating point)
10 Single (32-bit floating point)
20 Integer (32-bit)

Number of values
The Number of values is a 32-bit integer describing the number of numerical values in

the array. This value may be 1 for variables that only describe one value; but for arrays
of samples or times, expect this to be a large number.

Name length
The Name length is the length of the name of the variable as a null-terminated 1-byte
per character ASCII string. The last null terminating character (\0) is included in the

Name length so if the variable name is TStart (same as TStart\0) then the name length
will be 7.

The data block
The data block begins with the name of the variable (such as A, Tinterval) and you
should read in the number of bytes described by the Name length part of the header

(not forgetting that the last byte in the string is \0 if your programming language needs
to take account of this).

The remaining part of the data block is the actual data itself, so read in the number of
values described in the Number of values part of the header. Remember to take
account of the size of each value as described in the ‘Data format’ part of the header.

Channel data such as voltages, in variables such as A and B, are stored as 32-bit
single-precision floating-point data types. Times such as Tstart, Tinterval and T are

stored as 64-bit double-precision floating-point data types. Length is stored as a 32-
bit integer.
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Startup Settings menu
Location: File > Startup Settings

Purpose: allows you to load, save and restore the PicoScope 6 startup settings
Save Startup Settings
Lead Startup Settings

Beset Startup Settings

Save Startup Settings. Saves your current settings ready for when you next select
Load Startup Settings. These settings are remembered from one session of PicoScope
6 to the next.

Load Startup Settings. Returns to the settings you created with the Save Startup
Settings command.

Reset Startup Settings. Deletes the startup settings you created with the Save
Startup Settings command, and restores the installation default settings.

psw.en r39
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6.1.3  Waveform Library Browser
Location: File > Waveform Library Browser (PicoScope Automotive only)

Purpose: allows you to search hundreds of user-uploaded waveforms by entering
various fields of required data. Once found, the waveform can be
previewed, opened, or even its individual channels used as reference
waveforms on your PicoScope screen.

i x
F Search Options Home Log Out
A
Vehicle detail:
ehicle detatls ' Car Details A coP (Coil on plug ignition) secondary voltage
VIN/ID Code Status: Good
VIN / ID Code: WAUZZZAE73N008253 Load
reres | D) Make/Model: Audi / AS
Model | AB =] Generation: D3
cemerat Year: 2003
enerstion Transmission: Automatic
Year | <Y Engine code: BFM
Primary fuel: Petrol
Transmission  Autg tic () =
utomatic (5 Secondary fuel: LPG
Test Conditions Cylinders: 8
Configuration: V
Engine details Engine capacity: 4.2 L
Engine Code ECU make/model: Bosch / Motronic ME 7.1.1
orimany Fuel Test conditions: Key on Engine Running Idle
rimany Fuel | Petrol &) Open Waveform 153 (KB) Notes: Secondary pickup on MV setting
Secondary Fuel | LG (5) Uploaded by: picophil
Cylinders | s ()
Configuration V (5) _ o
. . Car Details A COP (Coil on plug ignition) secondary voltage
apaci Status: Bad
. VIN / ID Code: WAUZZZAE73ND08253 Load
eSS Make/Model: Audi / AB
ECU Make Basch =) Generation: D3
ECU Model Ve 2_““.3 .
Transmission: Automatic
Channel details e i ]
primary fuel: Petrol
— Secondary fusl: LPG
Cylinders: 8
pseiectiaver [v][-] Configuration: V
[Select Good/Bad/Unknown] Engine capacity: 4.2 L
ECU make/model: Bosch / Motronic ME 7.1.1
Test conditions: Key on Engine Running Idle
@ vist view Open Waveform 1.85 (MB)  notes: Secondary pickup on MV setting
O Grid view Uploaded by: picophil
. Injector current
Car Details A saws: sad 9
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6.2

6.2.1

Edit menu

Location: Menu bar > Edit
Purpose: gives access to the clipboard-related and note editing functions

Copy as Image
Copy as Text
Copy Entire Window as Image

Motes

Details...

Copy as Image. Copies the active view to the clipboard as a bitmap. You can then
paste the image into any application that accepts bitmap images.

Copy as Text. Copies the data in the active view to the clipboard as text. You can
paste the data into a spreadsheet or other application. The text format is the same as
that used by the Save As dialog when you select the .txt format.

Copy Entire Window as Image. This copies a picture of the PicoScope window to the
clipboard. It is provided as an alternative equivalent to pressing Alt-PrtScn for users of
laptops without a PrtScn key. You can paste the picture into any application that can
display pictures, such as a word processor or desktop publishing program.

Notes. Opens a Notes area at the bottom of the PicoScope window. You can type or
paste your own notes in this area.

Details. [PicoScope Automotive only] Opens the Details dialog, which allows you to
enter or view vehicle details, customer details, Notes and Channel Labels.

Notes

Location: Edit > Notes
Edit > Details (PicoScope Automotive only)
Advanced Options toolbar > Notes button

Purpose: provides a text box for typing your own notes

‘o PicoScope 6 = =

File  Edit VYiews Measurements Tools Help
ﬂt]’l_lll.l| |-}ﬁ| EDDusfdiv|E|| x1 IE|| 16 kS =

Ay Auto  [+] DC [v]| 2y off [v] | Ny
m 10

_v\/\/\%\/\/\

g

s
25 20 1% 10 -0& 00 OB 10 15 20 325

[ e

MNotes

|Dl_rt|:n_rt of @ Sinemaster Pro. 5/N 314155

@ 0 | Trigger | Auto IEI ﬂ!| A IEI | Fay |
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A Notes area can be displayed at the bottom of the PicoScope window. You can enter
any text you wish in this area. You can also copy text from another program and paste
it here. This text is included when you save the waveform as a file.

6.2.2  Channel Labels (PicoScope Automotive only)

Location: Edit > Details
Advanced Options toolbar > Channel Labels button

Purpose: allows you to supply and view information on the waveforms

x
A | Injector current |v|| < looks like stuck injector Bad |E|
B Injector valtage |VI| -| normal Good |E|
C | Ignition cmlprlmar}wnltalvﬂ -|| | ask Phil Unknown |z|
Ignition coil secondary vclv || <|| HT too low Bad |z|
Channel Labels can be displayed at the bottom of the PicoScope window.
Label: Select a standard label from the drop-down list or type any text
in the box.
Description: Type any text in the box to describe the waveform.
Status: Select Good, Bad or Unknown. This helps other engineers to
identify whether the waveform is from a working engine or a
faulty one.
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6.2.3  Details dialog (PicoScope Automotive only)

Location:

Purpose:

File > Save As

Edit > Details

(" Vehicle Customer |

allows you to record channel labels, and vehicle and customer details,
before saving a file.

Recent Vehicles:

Make

Model

Generation

Year

Transmission

Test Conditions

Missan - Almera - 2 - 2004

B
Almera [
2

2004

Manual

v
(v

(]

Engine Code g
Primary Fuel | patrg|
Secondary Fuel

Cylinders ' 4

[ E E] E

Configuratior | |nline
Capacity (1) [ 1.5
Capacity (cu in) | g1

ECU Make | Hitachi

]
H

ECU Model

Camshaft sensor

Eattery voltage

Crankcase pressure

Motes

Vehicle recently given 40,000 mile service

B after replacement
E‘ headlights on
E known good sensar

Throttle Position Senst[ﬂ note dead spot

MEEE

|[ Cancel |

Details dialog showing vehicle information. Customer information (not
shown) can also be entered.

All of this information will be saved in the PicoScope data file. It can then be viewed in
PicoScope using the Edit > Details menu command.

Additionally, the Notes and Channel Labels can be displayed at the bottom of the
PicoScope window by clicking the Notes and Channel Labels buttons in the lower

toolbar.
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6.3 Views menu

Add View » | Location: Menu bar > Views, or right-click on a view

Sub View 3

e e Purpose: controls the layout of the current view, which is a
Ehmls , rectangular area of the PicoScope window that

Yohie , display scope, spectrum or other kinds of data
id:yg:ut The contents of the Views menu may vary depending on where

Reset View Sizes you click and how many views are open. If the current view

Move View To » | contains a Measurements table, a combined Measurements menu
Armange Views and Views menu will appear.

Auto-arrange axes

Reset View Layout Add View: Add a view of the selected type (scope, XY or
View Properties spectrum). In automatic grid layout mode (the

Bl Refersnce Waveforms  » default), PicoScope rearranges the grid to

i Masks ' make room for the new view, up to a limit of

[ AddMeasurement four views. Any further views will be added as

@  Edit Measurement . . . .

B Delete Messurement tabs in existing viewports. If you have
selected a fixed grid layout, PicoScope will not
change it.

Sub View: (Mixed signal oscilloscopes only) Switch the
analog view and digital view on and off
independently.

Rename View: Change the standard 'Scope' or 'Spectrum'’ label to a title of
your choice.

Close View: Remove a view from the PicoScope window. In automatic grid
layout mode (the default), PicoScope rearranges the grid to
make the best use of the remaining space. In fixed grid layout
mode (if you have selected a grid fixed layout), PicoScope will
not change the grid.

Channels: Select which channels are visible in the current view. Each
view, when created, shows all the input channels, but you
can switch them on and off using this command. Only the
input channels that are enabled (not set to Off in the Channel
Setup Toolbar) are available for viewing. The Channels menu
also list math channels and reference waveforms. You can
select up to 8 channels in any view.

X-Axis: Select any suitable channel to drive the X axis. By default,
the X axis represents time. If you select an input channel
instead, the scope view will become an XY view that plots
one input against another. A quicker way to create an XY
view is to use the Add View command (see above).

Grid Layout: The grid layout defaults to Automatic mode, in which

PicoScope automatically arranges views in a grid. You can
also select one of the standard grid layouts or create a
custom layout, which PicoScope will preserve as you add or
remove views.

Arrange Grid Layout: Adjust the grid layout to fit the number of views. Moves any
tabbed views to empty viewports. Overrides any previous
choice of grid layout.
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Reset View Sizes:

Move View To:

Arrange views:

Auto-arrange axes:

Reset View Layout:
View Properties:
Reference Waveforms:

Masks:
Add Measurement:

Edit Measurement:
Delete Measurement:

6.3.1  Custom grid layout dialog

If you have resized any of the views by dragging the vertical
or horizontal separator bars between viewports, this option
resets all the viewports to their original sizes.

Move a view to a specified viewport. You can achieve the
same effect by dragging the view by its name tab and
dropping it in @ new viewport. See How to move a view.

If multiple views are stacked in the same viewport, move
them into their own viewports.

Scale and offsets all traces to fill the view and avoid overlaps.

Reset the scale factor and offset of the selected view to their
default values.

Show the Properties sheet, which lists scope settings that are
normally hidden.

Copy one of the available channels to a new Reference

Waveform and add it to the view.

Select which masks (see Mask Limit Testing) are visible.

See Measurements menu.

Location: right-click on view > Views menu > Grid Layout > Custom layout...
or Views > Grid Layout

Purpose: if the Grid Layout section of the Views menu does not contain the
layout you want, this dialog gives further options
Custom grid layout
Rows Columns | OK |
2 [v] x |4 [v] —
— — | Cancel |

You can lay out the view grid with any number of rows and columns up to 4 by 4. You
can then drag the views to different locations in the grid.

psw.en r39
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6.4

Measurements menu

Location:

Purpose:

=

Menu bar > Measurements

controls the Measurements table

Add Measurement
Edit Measurement

Delete Measurement
Grid Font Size | 8.25 [v]

Column Auto-width

Add measurement. Adds a row to the measurements table, and opens
the Edit Measurement Dialog. You can also find this button on the
Measurements toolbar.

Edit measurement. This takes you to the Edit Measurement Dialog. You
can find this button on the Measurements toolbar, or you can edit a
measurement by double-clicking on a row of the measurements Table.

Delete measurement. Removes the selected row from the
measurements table. You can also find this button on the Measurements
toolbar.

Grid font size. Sets the font size for the entries in the measurements
table.

Column Auto-width. If this button is pressed, the columns of the
measurements table will continually adjust to fit the contents whenever
the table changes. Click again to release the button.
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6.4.1  Add / Edit Measurement dialog

Location: Measurements toolbar > [z Add Measurement or [ Edit
Measurement button

Views menu > & Add Measurement or [ Edit Measurement button
Double-click a measurement in the measurements table

Purpose: allows you to add a measurement of a waveform to the selected view,
or edit an existing measurement

Edit Measurement

Select the channel to measure | oK ‘|
m A M ——

| Cancel |
Select the type of measurement —_—
AC RMS [ Hep |
Choose which section of the graph will be measured
Whole trace |E| |" Advanced ‘l

PicoScope automatically refreshes the measurement every time it updates the
waveform. If this is the first measurement for the view, PicoScope will create a new
measurements table to display the measurement; otherwise, it will add the new
measurement to the bottom of the existing table.

Channel Which of the scope device's channels to measure.

Type PicoScope can calculate a wide range of measurements for waveforms.
See scope measurements (for use with scope views) or spectrum
measurements (for use with spectrum views).

Section Measure the whole trace, just the section between rulers, or, where
appropriate, a single cycle marked by one of the rulers.

Advanced Gives access to advanced measurement settings.
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6.4.2  Advanced measurement settings

Location: Add Measurement or Edit Measurement dialog > Advanced

Purpose: adjusts parameters of certain measurements such as filtering and
spectrum analysis

f General [ Filter ||

Hamonic Detector |

Threshold

Spectrum Span

Spectrum Peak Span

Threshold

Spectrum Span

Some measurements, such as Rise Time and Fall Time, can be
made using different thresholds. Select the appropriate ones
here. When comparing rise and fall times with manufacturers'
specifications, it is important to use the same thresholds for all
measurements.

When measuring peak-related parameters such as Frequency at
Peak in a spectrum view, PicoScope can search for a peak near
to the specified ruler location. This option tells PicoScope how
many frequency bins to search. The default is 5, which tell
PicoScope to search from 2 bins below to 2 bins above the ruler
frequency, giving a total range of 5 bins including the ruler
frequency.

| General f Fitter [

Hamonic Detector |

Fitter Control

Cutoff Frequency
Filter Size
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Filter control

Cutoff Frequency

Filter Size

|’ General || Filter ]

Hamonic Contral
Highest Harmanic

Search Range [bins]

PicoScope can low-pass filter the statistics to produce more
stable and more accurate numbers. Filtering is not available on
all measurement types.

Enable Filter - check to enable low-pass filtering, if available.
An F will appear after the measurement name in the
measurements table.

Automatic - check to set the low-pass filter characteristics
automatically

The filter cut-off frequency normalised to the measurement rate.
Range: 0 to 0.5.

The number of samples used to construct the filter

Harmanic Maise Floar [dB]

Hamonic Detector

Harmonic Control

Highest Harmonic

Search Range

Harmonic Noise
Floor

These options apply to distortion measurements in spectrum
views. You can specify which harmonics PicoScope uses for
these measurements.

The highest harmonic to include when calculating distortion
power

The number of frequency bins to search, centred on the
expected frequency, when looking for a harmonic peak

The level in dB above which signal peaks will be counted as
harmonics

psw.en r39
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6.5 Tools menu

Location: Menu bar > Tools
Purpose: gives access to assorted tools for signal analysis
™, Custom Probes...

AN

A e 3 K™

B 0

Maths Channels
Beference Waveforms
Serial Decoding

Alarms

Masks »

Macro Recorder

Breferences...

Custom Probes: Define new probes and copy, delete, move and edit existing
ones.

Math Channels: Add or edit a channel that is a mathematical function of one
or more other channels.

Reference Waveforms: Create, load or save a channel as a copy of an
existing channel.

Serial Decoding: Decode and display the contents of serial data stream such
as CAN bus.

Alarms: Specify actions to be taken on certain events.

Masks: Perform mask limit testing on a waveform. This detect when the
waveform departs from a specified shape.

Macro Recorder: Save a frequently-used sequence of operations.

Preferences: Set various options that control PicoScope's behavior.
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6.5.1

Custom Probes dialog

Location: Tools > Custom Probes,
or click the Channel Options button: Au
Purpose: allows you to select predefined probes and set up custom probes

Custom Probes n

Select a probe

----- % w1 ~ | MNew Probe... |
..... ¥10 _
..... g 20 | Edit. |
----- %100 R
----- [l WPs600 60 bar Range | Delete |

----- [l WPs600 600 bar Range

----- [l wess00x Range 1 (
----- [l wrs500% Range 2 )
----- [l wPs500% Range 3 ]
..... ™, Library |‘—Impc|r‘t... :

----- 160 A current ciamp) |f

Duplicate |

----- D 600 A current clamp ﬂl
----- D 2000 A current clamp
----- ™, Loaded
W
Explain what Built-in, Library and Loaded probes are.
| ok || Hep |

The selection of probes shown may vary depending on the version of the PicoScope
software that you are using.

Understanding the probe list

All the probes that PicoScope knows about are listed under three main headings: Built-
in, Library and Loaded. The probe list is preserved between sessions, so that
PicoScope will never forget your custom probes unless you delete them.

' Built-in probes. The built-in probes are supplied by Pico Technology and do not
change unless you download an authorized update from us. As a safeguard,
PicoScope does not allow you to edit or delete these probes. If you want to modify
one of them, you can copy it to your library by clicking Duplicate, and then edit the
copy in your library.

» Library probes. These are the probes that you have created using any of the
methods described in this topic. You can edit, delete or duplicate any of these
probes by clicking the appropriate button in this dialog.

» Loaded probes. Probes in PicoScope data files (.psdata) or settings files
(.pssettings) that you have opened appear here until you copy them to your
library. You cannot edit or delete these probes directly, but you can click Duplicate
to copy them to your library where you can edit them. You can also import probes
from the custom ranges stored in PicoScope 5 .psd and .pss files, but these lack
some of the features provided by PicoScope 6. (See Upgrading from PicoScope 5 for
more details).
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Adding a new probe to your library

There are three ways to create a new probe:

1. Use the Duplicate button as described above.

2. Click New Probe... to define a new probe.

3. Click Import to load a probe definition froma *.psprobe file and add it to your
library. These files are normally supplied by Pico, but you can also create your own

by defining a new probe and then clicking Export.

Methods 2 and 3 open the Custom Probe Wizard to guide you through the probe
definition process.

6.5.1.1 Custom Probe wizard

Location: Custom Probes dialog > New Probe

Purpose: allows you to define custom probes and set up custom ranges

The first dialog in the series is either the Create a new Custom Probe dialog or the Edit
an existing Custom Probe dialog.

6.5.1.1.1  Create New Custom Probe dialog

Location: Custom Probes dialog > New Probe
Purpose: introduces you to the process for creating a new custom probe
] Custom Probe Wizard

Create 3 New Custom Probe

This wizard will guide you through the process of creating a
new Custom Probe.

‘Wwhat is 8 Custom Probe?

[ Don't show me this introduction page again.

Help Mext = Cancel

How to use the dialog

Click Next to continue to the Probe Output Units dialog.
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6.5.1.1.2  Edit Existing Custom Probe dialog

Location: Custom Probes dialog > Edit
Purpose: introduces you to the process for editing an existing custom probe
] Custom Probe Wizard

Edit an Existing Custom Probe

This wizard allows you to change any aspect of the Custom
Probe. Press the "Next” button until you find the information
vou wish to edit.

Help Mext = Cancel

How to use the dialog

Click Next to continue to the Probe Output Units dialog, where you can edit the
custom probe.

Click Jump forward... if you have already set up the custom probe's basic
characteristics and want to add or change a custom range manually.
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6.5.1.1.3  Probe Output Units dialog

Location: Create new Custom Probe dialog > Next

Purpose: allows you to choose the units that PicoScope will use to display the
output of your custom probe

by Custom Probe Wizard “

Probe Qutput Units
Define the units that the Custom Probe will display.

Probes can display output in any units, which helps in the interpretation of results. These
units will be displayed in various places, including on the graph.

(* |Jse a standard unit from the list.
volts |E|

" |se the custom unit defined below.

Enter the full name of the umt Prowvide a short name for the umt
(e.g. volts) (e.g. WV for volts)

Help < Back Mext = Cancel

How to use the dialog

» To choose a standard SI unit, click Use a standard unit from the list and select
one from the list.

» To enter a custom unit, click Use the custom unit defined below and type the
unit name and symbol.

» Click Next to continue to the Scaling Method dialog.
» Click Back to return to the Create New Custom Probe dialog if this is a new probe,
or the Edit Existing Custom Probe dialog if this is an existing probe.
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6.5.1.1.4  Scaling Method dialog

Location: Probe Output Units dialog > Next
Purpose: allows you to define the characteristic that PicoScope will use to convert
the custom probe's voltage output to a measurement on the display
by Custom Probe Wizard H
Scaling Method

A Custom Probe can apply scaling to the data before it is displayed.

(¥ |se a linear equation to scale the data [y = mx = ¢

y= |1.0 x + |00 valts

Gradient {m) Offset (c)

" Use a look-up table {linearly interpolates between points on the table).

" Don't apply any scaling to the data.

Help < Back | MNext = | Cancel

How to use the dialog

» If you do not require any scaling or offset, click the Don't apply any scaling
button.

s If the probe requires linear scaling, click the Use a linear equation button and
enter the gradient (or scale factor) m and the offset c in the equation y = mx + ¢,
where y is the displayed value and x is the probe's voltage output.

s If you wish to apply a nonlinear function to the probe's output, choose Use a look-
up table..., then click the Create a Lookup Table... button to create a new lookup
table. This will take you to the Lookup-table Scaling dialog.

» Click Next to continue to the Range Management dialog.
» Click Back to return to the Probe Output Units dialog.
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6.5.1.1.4.1

Lookup-table Scaling dialog

Location: Scaling Method dialog > Create a Look-up Table or Edit the Lookup
Table...
Purpose: creates a look-up table to calibrate a custom probe
Lookup-table Scaling n
Input units Scaled units | oK |
millivalts IEI volts IEI —_—
|~ Cancel |
500 500 [
300 350 | Heb |
0 1]
300 350

Start typing here

sy Add Row
+3  Insert Row Above
+3  Insert Row Below
: Delete Row
|: Import.... :| |: Expart... :|

Editing the Look-up Table

First, select suitable values in the Input units and Scaled units drop-down boxes. For
example, if your probe is a current clamp that outputs one millivolt per ampere over the
range -600 to +600 amperes, select Input units of millivolts and Output units of
amperes.

Next, enter some data in the scaling table. Click the first empty cell at the top of the
table and type -600, then hit the Tab key and type -600. When you are ready to enter
the next pair of values, press the Tab key again to start a new row. You can also
right-click on the table to obtain a more detailed menu of options, as shown in the
picture. In the example above, we have entered a slightly nonlinear response; if the
response had been linear then it would have been easier to use the linear option in the
Scaling Method Dialog.

Import/Export

Using the Import and Export buttons, you can fill the look-up table from data in a
comma-separated or tab-delimited text file, and save the look-up table to new file.

Finishing

Clicking OK or Cancel will return you to the Scaling Method dialog.
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6.5.1.1.5 Range Managementdialog

Location: Scaling Method dialog > Next
Purpose: allows you to override PicoScope's automatic range-creation feature for
custom probes. In most cases, the automatic procedure will be
sufficient.
by Custom Probe Wizard H
Range Management

Choose whether the ranges available on this probe will be managed
automatically.

Each probe must have one or more ranges that refer to any of the input ranges on the
scope [the same input range can be referred to more than omce).

(* [Recommended) Let the software manage my ranges for me automatically.

This will directly map as many Custom Probe Ranges to scope Input Ranges as
possible. This method has the advantages of giving your Custom Probe the best
chance of being compatile with other scope hardware and also allowing auto-ranging
to work.

[+ Enable auto-ranging on this probe. What is auto-ranging?

" [Advanced) | will manage the Custom Probe Ranges manually,

Use this option if you want to limit the number of ranges available to the user {maybe
because the physical probe you are using has a very specific function), or if your ranges
require specific fixed limits that may not map well to the scope’s input ranges.

Help < Back | MNext = | Cancel

How to use the dialog

If you select Let the software manage my ranges for me automatically, then
clicking Next will take you to the Custom Probe Identification dialog. PicoScope's
automatic ranges should be ideal for most applications.

If you select I will manage the Custom Probe Ranges manually, clicking Next
will take you to the Manual Ranges Setup dialog.

Click Back to return to the Scaling Method dialog.

What is Auto-ranging?

When the Auto-ranging function is selected, PicoScope continually monitors the input
signal and adjusts the range when necessary to allow it to display the signal with
maximum resolution. This function is available on all standard ranges, and can be used
with custom ranges only if you select Let the software manage my ranges for me
automatically in this dialog.
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6.5.1.1.6  Manual Ranges Setup dialog

Location:

Range Management dialog > Advanced > Next

Purpose:

creates ranges manually for your custom probe

-lq

Manual Ranges Selup
Setup the Custom Ranges manually.

Custom Probe Wizard

probe,

custom ranges.

Use the list on the right to manually
configure the available ranges on the

Each hardware scope has its own set
of input ranges. Select a device from
below to consider whilst setting up

PicoScope 2203

Auto Generate Ranges |

The bar on the right demonstrates
how much of the scope’s input range
is being utilised by the custom range
currently selected from the list.

mg
Ed40.60v =

Ed30.70v
Edo.1wo0v

[Ed s0. 150V
[Ed -150.. 250 v
[Ed 450..550v
(g 950V .. 1.05kV

Scaled Range

Mew Range..
Edit..

Delete

Input Range

Help

< Back | MNext = |

Cancel

How to use the dialog

If you wish, you can click Auto Generate Ranges and the program will create a
number of ranges for the selected device. This will create the same list of ranges that
you would have obtained by selecting Let the software manage my ranges for me
automatically in the previous dialog. When you select a range, a diagram below the
list will show its relationship to the scope device's input range — this is explained
further under Edit range dialog. You can then edit the ranges by clicking Edit, or you

can also add a new range by clicking New Range. Both of these buttons take you to

the Edit Range dialog.

Click Next to continue to the Filter Method dialog.

Click Back to return to the Range Management dialog.

How to use a new custom range

After you have created
a custom range, it will

appear in the drop-
down list of ranges in
the channels toolbar,
like this:

Channels
toolbar

Mew custam
range

File  Edit Views

Measur

'}ﬁ| 1 ms
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6.5.1.1.6.1

Edit Range dialog

Location: Manual Ranges Setup dialog > Edit or New Range
Purpose: editing a manual range for a custom probe

Edit Range ﬂ

Standard Cptions [ Advanced | |

oKk |

o [Recommended) Automatically select the hardware S
input range for the range limits | specify below., | Cancel |

(" Use this hardware input range. [ N
pHtrang | Apply |

|  Help |

Scaled range limits

Min ATV l;' Max 53"..‘.' g'

Scaled Range

60%

Input Range (=50 mV)

Automatic mode

If you leave the Automatic radio button pressed, the program will automatically
determine the best hardware input range for the device as you change the Scaled
range limits. This is the best mode to use for almost all ranges. You should set the
Scaled range limits to the maximum and minimum values you wish to see on the
vertical axis of the scope display.

Fixed range mode

If you press the Hardware input range radio button and select a hardware input
range from the drop-down box, PicoScope will then use that hardware input range
whatever scaled range limits you choose. Set the upper and lower scaled range limits
to the limits you wish to appear at the top and bottom of the vertical axis in

PicoScope's scope view.

What is an input range?

An input range is the signal range, usually in volts, on the input channel of the scope
device. Your scaled range should match this as closely as possible to make the most of
the scope's resolution.

What is a scaled range?

The scaled range is the range that will appear on the vertical axis of the scope display
when the probe is selected.

The scaling that you chose on the Scaling Method page defines the relationship
between the input range and the scaled range. This dialog enables you to set up
ranges to display the scaled data on the scope view.
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The range utilization bar

This diagram at the bottom of the dialog shows how well the input range of the device

is matched to the scaled range.

Scaled Range

' 63% ]

T Input Fange T T
| | |

Unused Used Unused
portion of portion of portion of
input range input range scaled range

e Green - The section of the input range that is used by the scaled range. This

should be as large as possible, to maximise the use of the scope device's

resolution.

e Blue - Areas of the input range that are not being used. These indicate wasted

resolution.

e Grey - Parts of the scaled range that are not covered by the input range. These

will result in wasted space on the graph. The range utilization bar may not

represent these areas accurately when non-linear scaling is being used, so you

should always test the scaled range limits on the scope view.

Advanced tab

Finishing

Clicking OK or Cancel will return you to the Manual Ranges Setup dialog.
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6.5.1.1.6.2 Edit Range dialog (Advanced tab)
Location: Manual Ranges Setup dialog > Edit or New Range > Advanced tab
Purpose: configuring advanced options for custom probes
Edit Range ﬂ

Standard Cptions ] Advanced |

For advanced users only. It is strongly recommended that
you do not change these settings.

Waveform Inversion

{* [Fecommended] Do not Invert
i Always Invert

i Invert when negative

i Invert when positive

i
.,

QK

Cancel

Apply

Help

.
&

These options are for factory use and we recommend that you do not change them.

Finishing

Clicking OK or Cancel will return you to the Manual Ranges Setup dialog.
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6.5.1.1.7  Filter Method dialog

Location: Manual Ranges Setup dialog > Next
Purpose: sets up lowpass filtering for this custom probe
by Custom Probe Wizard
Filter Method

A Custom Probe can configure low-pass filtering.

Filter the data before applying scaling.

Filter Frequency | {1 Hz @ [ Enabled

This will automatically set and enable low-pass filtering for this probe.

Help < Back

| MNext = |

Cancel

This dialog has the same effect as manually enabling the Lowpass Filtering option in
the Channel Options dialog. Filtering will only occur if the attached scope device

supports filtering.

Back: Go to the Manual Range Setup dialog

Next: Go to the Custom Probe Identification dialog

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.
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6.5.1.1.8

Custom Probe Identification dialog

Location: Range Management dialog > Next
Purpose: entering text to identify the custom probe
by Custom Probe Wizard

Custom Probe ldentification
Provide descriptive details so wour new probe canbe identified later.

Enter a name for the probe

Acme current clamp

Write a short description for the probe, so it canbe easily identified [optional).

600 A current clamp, 1 my /A

Help < Back | MNext = |

Cancel

How to use the dialog

Click Back to return to the Filter Method dialog.

s The probe name will appear in the probe list.

» The description is not used in the present version of the software.

Fill in the text fields and click Next to continue to the Custom Probe Finished dialog.

psw.en r39
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6.5.1.1.9  Custom Probe Finished dialog

Location: Custom Probe Identification dialog > Next
Purpose: signals the end of the custom probe setup procedure
] Custom Probe Wizard

Finished

Help < Back | Finish | Cancel

How to use the dialog

Click Back to return to the Custom Probe Identification dialog.

Click Finish to accept your custom probe settings and return to the Custom Probes
dialog.
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6.5.2

Math Channels dialog

Location: Tools > Math Channels
Purpose: creating, editing and controlling math channels, which are virtual
channels generated by mathematical functions of input channels
Maths Channels ﬂ
Select a Maths Channel | oK |
Built-in I
~O= [ (e )
‘]| Invert B ‘ ’
[m a-8
D B A-B | Create |
0@ a+e —
e D O a&/B
Library ¥
Loaded
|\ Duplicate |
|~ Import |
Explain what Built-in Library and Loaded Maths | Expiort |
Channels are BsS

Math Channel list

Math Channel list

Create

The main area of the Math Channels dialog is the Math
Channel list, which shows all the built-in, library and loaded
math channels. To choose whether or not a channel appears in
the main PicoScope window, click the appropriate check box and
then OK. You can have up to 8 channels in any view, including
input channels and math channels. If you enable a 9th channel,
PicoScope opens a new view.

Built In: these math channels are defined by PicoScope and
cannot be changed

Library: these are the math channels that you define using the
Create or Duplicate button, Edit, or load with the Import
button

Loaded: these are the math channels present in any PicoScope
settings or data files that you have loaded

Opens the Math Channel Wizard, which guides you through the
process of creating or editing a math channel. The new channel
will appear under Library in the Math Channel list.

psw.en r39
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Edit

Delete

Duplicate

Import

Export

Opens the Math Channel Wizard to allow you to edit the selected
math channel. You must first select a channel in the Library
section of the Math Channel list. If the channel you want to
edit is in the Built In or Loaded section, first copy it to the
Library section by clicking Duplicate, then select it and click
Edit.

Permanently deletes the selected math channel. Only math
channels in the Library section can be deleted.

Creates a copy of the selected math channel. The copy is placed
in the Library section, from where you can edit it by clicking
Edit.

Opens a .psmaths math channel file and places the math
channels it contains in the Library section.

Saves all math channels from the Library section to a new
.psmaths file.
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6.5.2.1 Math Channel Wizard

Location:

Purpose:

Channel Setup toolbar > Math Channels button

creating, editing and controlling math channels, which are virtual

channels generated by mathematical functions of input channels

& Math Channel Wizard x|

Create a New Maths Channel

vough the process of reating a

1. Introduction

™ Don't show me this ntroduction page again

v Math Channel Wizard E

Enter the equation fr tis Maths Chamne

2. Equation

% Math Channel Wizard x|

Edit the channel rame and chanel color.

3. Channel name

v Math Channel Wizard |~ |

Selectthe range and unis for your Maths Channel

units

Long Name [Unknown Stort Name [7

Range
I™ Override automatic range selection

S

N — 4. Units and range

N Math Channel Wizard E

Finished.

5. Finished

psw.en r39
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6.5.2.1.1  Math Channel Wizard Introduction dialog

Location: Math Channels dialog > Create (if you have not ticked the Don't show
me this introduction page again check box)

Purpose: introduces the Math Channel Wizard

] Math Channel Wizard

Create a New Maths Channel

This wizard will guide you through the process of creating a
new Maths Channel.
What is 3 Maths Channel?

[ Don't show me this introduction page again.

Help Mext = Cancel

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved. psw.en r39



74

Menus

6.5.2.1.2

Math Channel Wizard Equation dialog

Location: Math Channel Wizard

Purpose: allows you to enter or edit the equation for a math channel. You can
type directly into the equation box, or click the calculator buttons and
let the program insert the symbols for you. A red error indicator Q will
appear to the right of the equation box if the equation contains a syntax

error.
Basic view
iy Math Channel Wizard x|
Enter the equation for this Maths Channel.
w-ByA | cE || c |

Lo - = e e ls flefe ]

| [ ” ) || Advanced ==

Help < Back Mext = Cancel

Math Channel Wizard Equation dialog, basic view

Basic buttons

Button Equation
LcE |

L c |

| = | +

| - | -

= .

| 7 | /

LA Lo ] A

Description

Clear Equation. Clears the entire contents of the
equation box.

Clear. Clears the single character to the left of the
cursor.

Add

Subtract (or negate)

Multiply

Divide

Input Channels. The selection available depends

on the number of enabled channels on the scope
device.

psw.en r39
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Other Operands. Shows a drop-down list of

{..., T available inputs to equations, including reference
waveforms and Time.

EE (.) Brackets. Expressions within brackets will be
evaluated before the expressions to either side.

Advanced view

Clicking the Advanced button reveals more function buttons. Initially these are the
Main group of buttons, as shown below.

g Math Channel Wizard ﬂ

Enter the equation for this Maths Channel.

L= e Jla]e e o]

| [ H ] H Advanced <<

(*) Main

ey m Jlex ] [ 7 [ 8] o |
() Trigonometric |
fre H du H lo | | 4 || 5 || 6 |
) Buffered q v d
() Filters |d.f'dX‘ I ‘ sqrt| | 1 ” 2 ” 3 |
(o e ]

Help < Back Mext = Cancel

Equation Editor Advanced view, showing Main buttons

Advanced buttons (numeric keypad)

Button Equation Description

| 0 | 9 | 0..9 0 to 9. The decimal digits.

Decimal point

E E Exponent. aEb means a x 10°.

Advanced buttons (Main group)

Button Equation Description

sort sqrt() Square root
x A Power. Raise x to the power of y.

7B

n In() Natural logarithm
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| abs | abs() Absolute value

| freq | freq() Frequency. Calculated in hertz.

Normalise. PicoScope calculates the maximum and
minimum values of the argument over the capture

norm .
| _ | orm() period, and then scales and offsets the argument so
that it exactly fits the range [0, +1] units.
Natural exponent. Raise e, the base of the natural
| e | exp()

logarithm, to the power of x.
| log | log() Logarithm. Base- 10 logarithm.
Derivative. Calculated with respect to the x-axis.
Note: the derivative of a sampled signal contains a
| dre | derivative() large amount of noise, so it is advisable to apply
digital low-pass filtering to all channels used as
inputs to this function.

| I | integral() Integral. Along the x-axis.

Click Trigonometric, Buffered or Filters to reveal alternative groups of buttons:
Advanced buttons (Trigonometric group)

Button Equation Description

| - | pi Pi. The ratio of a circle's circumference to its
Fl

diameter.
Inverse. Modifies the sin, cos and tan buttons to
| inv | the inverse trigonometric functions asin, acos and
atan.
| sin | sin() Sine. The operand is in radians.
| oS | cos() Cosine. The operand is in radians.
| tan | tan() Tangent. The operand is in radians.
| sinh | sinh() Hyperbolic sine.
| cosh | cosh() Hyperbolic cosine.
| tanh | tanh() Hyperbolic tangent.

Advanced buttons (Buffered group)

When the scope is running, these functions operate continuously on all waveforms
since the scope started capturing. If a math channel containing these functions is
enabled when the scope is stopped, it operates on the contents of the waveform
buffer instead.

Button Equation Description
. . Minimum. Negative peak detect of all previous
| _ | min() waveforms ’ P P
| I | max() Maximum. Positive peak detect of all previous
waveforms.
= Average. Arithmetic mean of all previous
|—| average() Wavef(?rms P
|peak | peak() Peak detect. Display maximum-to-minimum range of

all previous waveforms.
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Advanced buttons (Filters group)

Parameters:
i is the input channel or other operand (see under Basic buttons above)
f (or f, and f,) are the -3 dB cutoff frequencies of the filter, in hertz

Button Equation Description

||.C| HighPass(i,f) High pass filter. Attenuates low frequencies.

|D.| LowPass(j,f) Low pass filter. Attenuates high frequencies.

A - Band pass filter. Attenuates high and low
BandPass(if,,f h : e

|g| G Fy15) frequencies outside the specified range.

|E| BandStop(i,f,,f,) Band stop filter. Attenuates mid-band frequencies

inside the specified range.

These are digital filters with a finite number of taps and therefore cannot attenuate
down to DC. They have a minimum cutoff frequency of 1/64 000 of the scope's
sampling rate. You can find the current sampling rate displayed in the Properties sheet.

Additional functions
There are a few operators that can be entered only by using the equation box:

Signum function. The sign() operator returns the sign of its input. The result is +1
when the input is positive, -1 when the input is negative, and 0 when the input is 0.

Advance/Delay. Add [t] after a channel name to advance it by t seconds. For
example, A[0.001] is equal to Channel A advanced by 1 millisecond, and A[-0.001] is
equal to Channel A delayed by 1 millisecond.
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6.5.2.1.3  Math Channel Wizard Name dialog

Location: Math Channel Wizard
Purpose: allows you to enter or edit the name and color of a math channel
iy Math Channel Wizard x|

Edit the channel name and channel calor.,

Name  |(A+B)/A

Color B Glack Custom

Help < Back Mext = Cancel

PicoScope initially sets the name to the text of the equation, but you can edit it to
anything you like. The name will appear in the channel list in the Math Channels dialog.
You can set the color of the trace to one of the standard colors in the drop-down-list,
or click Custom to choose any possible color allowed by Windows.
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6.5.2.1.4  Math Channel Wizard Units and Range dialog

Location: Math Channel Wizard

Purpose: allows you to specify the measurement units and the range of values to

display for a math channel

by Math Channel Wizard

Select the range and units for your Maths Channel,

Units

Range

[ Override automatic range selection.

Long Mame |Unknown Short Mame |7

Min |-1 Max |2

Help < Back

Mext =

Cancel

Units, Long Name: This is for your reference only.

Units, Short Name: This will be displayed on the measurement axis in scope and

spectrum views, in the ruler legend and in the measurements table.

Range: If you leave the check box empty, PicoScope will choose the most appropriate
range for the measurement axis. If you prefer to set your own values for the minimum
and maximum extremes of the measurement axis, tick the check box and enter them in

the Min and Max boxes.

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.
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6.5.2.1.5  Math Channel Wizard Finished dialog

Location: Math Channel Wizard
Purpose: shows you the settings for the math channel that you have just created
or edited
] Math Channel Wizard

Finished.

The Maths Channel creation process is
complete, Press Finish to continue,

Formula, (A+ B4

Colar, Black

Automatic range scaling.
Automatic unit selection.

Help < Back Finish Cancel

Back. Click this button to return to previous dialogs in the Math Channel Wizard if you
wish to change any of the settings.

Finish. Click this button to accept the settings shown and return to the Math Channels
dialog. If you want the new or edited channel to appear on the scope or spectrum
display, remember to tick the appropriate check box in the channel list. You can change
them later by clicking the Math Channels button in the Channel Setup toolbar.
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6.5.3  Reference Waveforms dialog
Location: Tools > Reference Waveforms

Purpose: enables you to create, edit and control reference waveforms, which are
stored copies of input channels

Reference Waveforms
select a Reference Channel | ok ~|
Available I
. oy |  Help |
- ,
Reference lib B
Waveforms Ly 1OTATY
Iist ...... |:| nﬂise
e |:| ramp up
Loaded
e ] EE
| Duplicate |
|~ Import... |
Explain what Available, Library and Loaded | e ~|
Reference Channels are. _—
Reference The main area of the Reference Waveforms dialog is the Reference

Waveforms list Waveforms list, which shows all the available input channels and the
library and loaded reference waveforms. To choose whether or not a
waveform appears in the main PicoScope window, click the
appropriate check box and then OK. You can have up to 8 channels in
any view, including input channels, math channels and reference
waveforms. If you try to enable a 9th channel, PicoScope will open
another view.

Available: these input channels are suitable as sources for reference
waveforms

Library: these are the reference waveforms that you have defined
using the Duplicate button or loaded with the Import button

Loaded: these are the reference waveforms present in any PicoScope
settings or data files that you have loaded

Edit Opens the Edit Reference Waveform dialog to allow you to edit the
selected reference waveform. You must first select a waveformin the
Library section of the Reference Waveforms list. If the waveform
you want to edit is in the Loaded section, first copy it to the Library
section by clicking Duplicate, then select it and click Edit.

Delete Permanently deletes the selected reference waveform. Only reference
waveforms in the Library section can be deleted.
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6.5.3.1

Duplicate Creates a copy of the selected input channel or reference waveform.
The copy is placed in the Library section, from where you can edit it
by clicking Edit. A quicker way to do the same thing is to right-click
on the view, select Reference Waveforms and then click the
channel that you wish to copy.

Import Opens a .psreference reference waveform file and places the
waveforms it contains in the Library section.

Export Saves all reference waveforms from the Library section to a new
.psreference or MATLAB 4 .mat file.

Edit Reference Waveform dialog

Location: Reference Waveforms dialog > Edit
Purpose: allows you to edit the name and color of a reference waveform
Reference Waveform
Mame noise
Color | M Custom [+ | | Custom ... |
| oK | | cancel |

Name. PicoScope initially names the waveform after the input channel used as its
source, but you can edit it to anything you like. Here we have named it
sine. The name will appear in the waveform list in the Reference Waveforms

dialog.

Color: You can set the color of the trace to one of the standard colors in the
drop-down-list, or click Custom to choose any color allowed by Windows.
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6.5.4  Serial Decoding dialog
Location: Tools > Serial Decoding
Purpose: lets you choose which channels to use for serial decoding and set other
options

The following formats are supported:

I12C

CAN Bus

LIN

FlexRay

I12s

RS232 (UART)

SPI

USB (Single Ended)

L3 I

Channels

Protocolk Enabled

Protocol Settings

Channel

[ Advanced Settings |[ 57 Auto Setup |

Threshaold 1 Threshold 2

|IB

M [esemvBE O [0 B2

|IA

o [zemv BRI D [ EIZ]

Display Settings

Mame 12C-B

Show Decoded Data

In Graph |He1{

In Table |Hex

Information: Number of Samples required is 160 5

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved. psw.en r39



84

Menus

Protocols table

| NS <Maone selected> [

<

o 12C ]
< Mome selected >

CAMN High
CAM Low

Flexk ai' I

LIM

R5232/UART
USB{Single Ended)
SPICustam)

125

5Pl

This is where you select which channels to decode, and what serial protocol to use for

each channel. All the available channels are listed in the Channels column.

» If the channel you want to use is not listed, enable it first by using the Channels

toolbar.
» For each channel that you want to decode, click in the Protocols column. A drop-

down list will appear, containing all the protocols that PicoScope understands. The
list may vary depending on which version of PicoScope you are using. For multi-
channel protocols like I?C and SPI, select the data channel. Any other channels will
be specified later. For half-duplex protocols like RS-232, you must decode each
direction (Tx and Rx in this case) using a separate channel.

» Select the protocol you wish to use.

» Change the settings in the Protocol Settings panel if required.

» Change further settings by clicking Advanced Settings if required.

» Check the Enabled box for the channels that you want to decode.

Protocol Settings

The options in this section depend on which protocol is selected.

Protocol Settings I: Advanced Settings :I I: ;7 Auto Setup :I
Channel Threshaoldl Threshold2
I m A omv 7] omv (2]
Clk mE ] [w3v BEZ 14v 2]
ChipSel  'm C ] 1sv EZ 16v 2]
Controls:
|_Advanced Settings | Opens the Advanced Decoder Settings dialog for options

that are rarely changed.
Baud Rate. The symbol frequency in baud. Choose one of the
standard values from the drop-down list, type in an

arbitrary value, or click 7 to detect the baud rate
automatically.

psw.en r39
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Channel.

Threshold1.

Threshold?2.

Signals:

I/0, Data or D.

Clk, CLK or Clock.

Chip Sel.

Word Sel.

Display Settings

Display Settings
MName 12€-B

Show Decoded Data

The channel attached to the specified signal. Configure
this to match the connection of the inputs to the scope
device.

For single-threshold decoding, the voltage that defines
the transition in either direction between high and low
logic states. For dual-threshold decoding, the voltage
that defines the transition from low to high logic states.
To activate dual-threshold decoding, check the check
box to the left of the Threshold2 control.

The voltage that defines the transition from high to low
logic states. Used only with dual-threshold decoding. To
activate dual-threshold decoding, check the check box to
the left of the Threshold2 control.

Data channel for various protocols. Bit order, number of
bits and polarity are specified in Advanced Decoder

Settings.

Note: bidirectional SPI can be decoded as two separate
buses, one with Data In (DI) as the I/0O signal and the
other with Data Out (DO) as the I/O signal. The Clk (and
Chip Sel if present) can be shared by both buses.

Clock for various protocols. The polarity is defined in
Advanced Decoder Settings.

Chip Select for SPI protocol. Polarity is defined in
Advanced Decoder Settings. If there is no Chip Select
signal, clear the check box.

Word Select for I°S protocol. Indicates which stereo
channel the data belongs to.

In Graph Hex [+]

In Table Hex [+]

Name. Type a name to display on the scope view.

In Graph shows the data in logic-analyzer style, on the same time axis as the

analog waveform.

Hover the mouse pointer over any decoded packet to display its contents.
e Click-and-drag the decoded data up or down the scope view.
o If the In Graph display is visible, double-click on any packet to highlight it in the

table.
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In Table displays the decoded data in a table in the serial data window, with
advanced search and filtering functions.

Hex... Select the format for displaying decoded data: Hexadecimal, Binary, ASCII
or Decimal.

Information panel

If the serial decoding parameters entered are incorrect, this panel displays an error
message. If there is no error, it states the minimum number of samples required for the
selected serial data format. For accurate decoding, please make sure that PicoScope is
capturing at least this number of samples. The current number of samples is shown in
the Properties Window (Views menu > View Properties).
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6.5.4.1  Advanced Decoder Settings dialog

Location: Tools > Serial Decoding > Advanced Settings

Purpose: Controls serial decoding settings that are not shown in the Serial

Decoding dialog.

Protocol Bit Order

Clock 5ampling Edge

Decoding Graph section

Packet Display Bit Crder

MSE first ~

Rising

Whole trace

MSE first [v] ™
ok |

Each protocol has its own selection of options from the following list:

Protocol Bit Order

Decoding Graph Section

Clock Sampling Edge
Invert Packet Bits

Packet Start Edge

Data Bits
Parity Bits
Stop Bits

ChipSelect Active State

The bit order, most-significant first or least-significant
first, as defined by the protocol. For protocols with
application-specific bit order, such as UART, you must
set this to match to the data format.

Which section of the waveform to decode: all of it, or
just the part between the time rulers

On which edge of the clock to sample data bits
Invert all data bits

For self-clocked protocols, whether rising or falling
edge indicates start of packet

The number of bits in the data payload of each packet
The number of parity-checking bits in each packet
The number of fixed bits at the end of each packet

The polarity of the Chip Select signal
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6.5.4.2

Serial Data window

Location: Channels toolbar > Serial Decoding button > select In Table in the
Serial Decoding dialog
Purpose: shows decoded serial data in alphanumeric format and allows advanced

filtering and searching

For more information on the format of the table for each serial protocol, see Serial
protocols.

If you also selected In Graph in the Serial Decoding dialog, the data will also appear in
graphical form on the scope view. You can click on one of the data packets in the
scope view to go to the corresponding row in the table, or you can double-click a row
in the table to zoom to the corresponding frame in the scope view.

Click any heading to sort
column. Right-click to
change display format.

Export Accumulate | View Link: | <Mone [v|[+] Startfrom.. Filter Statistics Search | |
L
[~]
. - . El
=] Ceatz - - 01 Yes 5.2 ms 3323 ms
4 Dtz - - oz ez 5.3 ms 5434 ms
T Address T WRITE - Yes 5.507 ms 5607 ms
] Data - - 1F es 8.514 ms £.615m |7|
| A_I2C
*

Channel selection tab

Control bar

The controls in the control bar are as follows:

Export Save the decoded data to a Microsoft Excel spreadsheet.

Accumulate By default, PicoScope clears the table each time the scope captures
a new buffer full of data. Click this button to enter Accumulate

mode, which continues adding serial frames to the end of the table
until you click the button again.

View Controls which details of the data appear in the table. The sub-
menus are as follows:

Frames/Packets: which types of frames or packets are displayed

Fields: which columns appear in the data table
Display Format: hexadecimal, binary, ASCII or decimal format
Font Size: the character size used in the table

Link Link: “:N'Z""EE| This drop-down list selects a link file that

maps numbers to strings. The serial data
window will show these strings in place of
matching numerical values.

IEI Creates a new link file. Use a text editor to
add your own number-string pairs, save the
file, and then open it using the drop-down
control. (See also: How to create a link file).
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Start from...

Filter

Statistics

Search

Refresh

Clear

Use this button to enter a condition that PicoScope will wait for
before collecting data. When PicoScope detects a packet that
matches this condition, it will collect all subsequent data (subject to
filtering, if used - see above) and display it in the table.

Click to show the filter bar, which allows you to enter arbitrary data
above each column in the table. The table will display only those
packets that match the data you have entered. For example,
entering 6C7 in the filter box at the top of the ID column will cause
only frames with an ID of 6C7 to be displayed.

Toggle the statistics columns that list measurements such as packet
start and end times, and signal voltages.

Search for any data value in a specified column of the table.

Instructs PicoScope to decode the raw data again. This is necessary
if you have changed the Start from... condition, for example.

Clear all data and settings in the table. New data will appear the next
time that the scope captures a waveform.
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6.5.5  Alarms dialog

Location: Tools > Alarms

Purpose: gives access to the alarms feature, which specifies actions to be taken

on various events

Event | Capture

| Beep

| Run Executable

execution

Alarms H

Cancel
| Save Current Buffer [201 502 |—|

Enable external code

[+] [ oK :|

| Appy |

| Hep |

[ Add :I
I: Edit :I
| Remove |
| Move Up |

|:I".-1 ove Down |

Event:

(Actions list):

Select the event that will trigger the alarm:

Capture: when a waveform is captured. If triggering is enabled,
this option corresponds to a trigger event. You can therefore use
this function to save a file on each trigger event.

Buffers Full: when the number of waveforms in the waveform
buffer reaches the maximum waveform count.

Mask(s) Fail: when any channel fails a mask test.

Add an action to this list by clicking Add. Whenever the specified
event occurs, PicoScope will execute the all the actions in the list
from top to bottom.

NOTE: For an action to execute, its check box must be
selected.

Apply: Set up the scope according to the settings in this dialog.
Add: Add an event to the Actions list. Possible events are:
Beep: activate the computer's built-in sounder. 64-bit PCs
redirect this sound to the headphone output.
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Enable external
code execution:

Play Sound: specify the name of a .wav sound file to play.
Stop Capture: equivalent to pressing the red Stop button.

Restart Capture: equivalent to pressing the green Start button.
Use only if the Stop Capture action was used earlier in the list.

Run Executable: run the specified EXE, COM or BAT program file.
You can type the ¢ file% variable after the program name to pass
the name of the last file saved as an argument to the program.
PicoScope will stop capturing while the program runs, and resume
after the program terminates.

Save Current Buffer: save the current waveform from the buffer
as a .psdata, .pssettings, .csv or .mat file. You can use the 2
buffers variable to insert the buffer index number into the
filename, or the 3stime% variable to insert the time of capture.

Save All Buffers: save the entire waveform buffer as a
.psdata, .pssettings, .csv or .mat file.

Trigger Signal Generator: if the scope device has a triggerable
sighal generator, start generating a signal.

As a security feature, to enable Run Executable you must also
select the 'Enable external code execution' option.
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6.5.6  Masks menu
Location: Tools > Masks
Purpose: gives control over Mask Limit Testing
Add Masks
Clear Mask
Save Mask
Add Masks: Add a mask to the display using the Mask Library dialog.
Clear Mask: Remove the mask from the display.
Save Mask: Save the displayed mask to disk as a .mask file.
6.5.6.1  Mask Library dialog
Location: Tools > Masks
Purpose: allows you to create, export and import masks for Mask Limit Testing
Mask Library “
Channel |l A |E| | oK |
Available Masks | Cancel |
Library —
B s of 4| | Apply |
Loaded
| Generate |
| Delete |
| Import... |
| Export.. |
Channel: Select the channel to which you want to apply the mask.
Available The Library section shows all the masks that you have saved in the
masks: past and not deleted. The Loaded section shows all the masks currently
in use.
Generate: Create a new mask based on the last waveform captured from the
selected channel. Opens the Generate Mask dialog.
Import: Load a mask that has previously been saved as a .mask file.
Export: Save a mask as a .mask file for future import.
Apply: Use the selected mask on the selected channel but remain in the Mask
Library dialog.
OoK: Use the selected mask on the selected channel and return to the scope

view.
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6.5.6.2  Editing a mask

To edit a mask in Mask Limit Testing mode, right-click on the scope view and select

Edit Mask:

Add View

Channels

K-Auis

Grid Laycut

Auto-arrange axes

Reset View Layout

View Properties

Mazks

IoE 2K

Reference Waveforms

Add Measurement
Edit Measurement

Delete Meazurement

k

A
Edit Mask

Save Mazk

A mask is made up of one or more shapes called polygons. Click on the polygon you
wish to edit. PicoScope will then draw edit handles on the selected mask polygon and
display the mask edit box. If you drag any of the handles to edit the polygon, the

statistical results will be updated immediately.

The mask edit box looks like this:

445 ps
45 ps
4575 ps
4775 ps
4B 25 ps
4935 ps
E025 ps
BLTo ps
E25 ps

5325 ps

2]
=]

2Vi—

118 v

118 v

1I6T ¥

1167 V

IREIRY

1115

1114

1078 v

1056 ¥

1028 v

10i1gv

EBIE s 405 mV |7|

Normal view

]

Minimized
view

If the edit box is not immediately visible, it may have been minimized; in which case,

click the restore button:

. If you edit the coordinates of a vertex, the statistical

results will be updated immediately. You can also export the mask to a .mask file with

the export button: H. Use the + and - buttons to add or remove vertices. The minimize
button has its usual function. To leave mask editing mode, close the mask edit box with
the close (X) button.

To add or remove an entire polygon, right-click the scope view and select either the
Add Mask Polygon or the Remove Mask Polygon command:

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.
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A
Exit Mask Edit
Save Mask
Add Mask Polygon
Rermnove Mask Palygon
6.5.6.3  Generate Mask Dialog

Mask Library dialog > Generate
allows you to set parameters for the automatically generated mask.
PicoScope will then create a new mask based on the last captured

PicoScope automatically chooses a name for the new mask. You can edit

The horizontal distance between the waveform and the mask.

51 / [%]  This button toggles the offset value between absolute units
(SI) and relative units (% of full scale).

(=] This button resets the offset value to its default.

Location:
Purpose:
waveform.
Mame | Mask of &
X Offset | 100ns [E[s1](<]
Y Offset | 200mV [H[s1][%]
|~ Generate | | Cancel |
Name:
the name in this box.
X Offset:
Y Offset:

The vertical distance between the waveform and the mask.

psw.en r39
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6.5.7  Macro Recorder

Location: Tools > Macro Recorder

Purpose: records a sequence of commands to be replayed later

The Macro Recorder helps when you wish to execute a series of commands

repeatedly. It saves all commands to a .psmacro file, which can be modified using an

XML editor.

Recorded
commands

Start recording

_.@ E :. [+] Bxecute in real time @

Ay Macro Recorder

e |

976 ms Run, Click

| Close

Replay Open saved macro
Stop recording Save current macro
or playback

Execute in real time:

Play back the macro at the same speed as when recorded.
Without this option, playback will be as fast as possible.

Note: .psmacro files can also be played back from the PicoScope command line.
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6.5.8  Preferences dialog
Location: Tools > Preferences

Purpose: Allows you to set options for the PicoScope software. Click one of the
tabs in the picture below to learn more.

Preferences
| Regional & Language || Prnting | Colors || Options || Updates | [ i
————————————— oK
General T Power Management |[ Sampling |[ Keyboard —l

[ Cancel |
[ Reset 'Don't show this again’ dialogs | E—

[ Reset preferences J

Help |
M .
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6.5.8.1  General page

Location: Tools > Preferences > General
Purpose: contains general controls for PicoScope
[ Regional & language || Prrting || Colos || Options | Updates |

General [ Power Management || Sampling || Keyboard |

| Reset 'Don't show this again’ dialogs \|

| Reset preferences |

Waveform Buffer

Sets the maximum number of waveforms that can be stored in the
waveform buffer. The actual number will depend on how many samples
are collected in each waveform.

Maximum Waveforms 32 |§|

Collection Time Units
'E'Times per Division

! : | Total collection time

Measurement Statistics

Sets the number of captures over which measurements statistics are
calculated

Statistics Captures [2 - 1000] 20 3|

Reset "Don't show this again" dialogs
Restore any missing dialogs that you asked PicoScope not to show again.

Reset preferences
Set all preferences back to their default values.

Waveform Buffer
Maximum Waveforms: This is the maximum number of waveforms that PicoScope
will store in the waveform buffer. You can select a nhumber from 1 to the maximum
allowed by the oscilloscope that is connected: see the scope specifications for
details). The actual number of waveforms stored depends on the available memory
and the number of samples in each waveform.

Collection Time Units
Change the mode of the Timebase control in the Capture Setup toolbar.

Times per division: the Timebase control displays time units per division - for

example, 5 ns /div. Most laboratory oscilloscopes display timebase settings in this
way.

Total collection time: the Timebase control displays time units for the entire width
of the scope view - for example, 50 ns.

Measurement Statistics
Capture Size - the number of successive captures that PicoScope uses to calculate
the statistics in the Measurements Table. A larger number produces more accurate
statistics but causes them to be updated less frequently.
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6.5.8.2  Power management page

Location: Tools > Preferences > Power Management
Purpose: controls features of the oscilloscope that affect its power consumption
[ Fegoral&language || Prrting || Colos |[ Options |[ Updates |

[ Generml Power Management [ Sampling || Keyboard |
Select the power mode to configure

Capture Rate Battery

Reduce the number of waveforms per second that the scope will
capture to extend battery life or allow other applications to run faster.

Unlimited [+]

Current power mode:  Mains

-.-h"_'-"-‘.... .

Capture Rate

This control limits the speed at which PicoScope captures data from the scope device.
The other PicoScope settings, the type of scope device and the speed of the computer
will all affect whether this limit can actually be reached. PicoScope automatically
selects the appropriate limit according to whether your computer is running on batteries
or on mains (line) power.

The settings are in captures per second. By default, the capture rate is set to
Unlimited when your computer is running on Mains (line) power, for maximum
performance. If other applications run too slowly on your PC whilst PicoScope is
capturing, then reduce the capture rate limit. When your computer is running on
Battery power, PicoScope imposes a performance limit to save the battery. You can
increase this limit manually, but this will cause the battery power to drain very quickly.
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6.5.8.3

Sampling page

Location: Tools > Preferences > Sampling
Purpose: controls the sampling behavior of the oscilloscope
|' Regional & Language \||' Prirting \||' Colors \||' Options \||' Updates \|

|' General | | Power Management ] Sampling Keyboard |

Slow Sampling Transition

Sets the collection time at which PicoScope & will try to go into slow
sampling mode, This is the mode where PicoScope & will update the
screen before the total collection time has expired.

Collection Time | 200 ms/div [+

Depending on device specifications, PicoScope & may not be able to go
into slow sampling mode at the required collection time, in which case
the nearest collection time possible will be used.

The slow sampling transition for the current Device: 200 ms/div

Slow Sampling Display

| Display previous Waveform Buffer
play p

Sinf/ Interpolation

on (= off

Specify sample threshold at which interpolation activates when
operating at the fastest sample rate; applicable only in scope mode.

2000 =

Slow Sampling Transition

In normal (fast) sampling mode, PicoScope collects enough data to fill the screen and
then redraws the whole view at once. This method is suitable for fast timebases, when
the screen is redrawn many times each second, but with slow timebases it can cause a
unacceptable delay before the data appears on the screen. To avoid this delay,
PicoScope automatically switches to slow sampling mode, in which the scope trace
advances gradually across the screen as the scope captures data.

The Collection Time control lets you select the timebase at which PicoScope switches
to slow sampling mode.

Slow Sampling Display

When this box is checked, PicoScope displays the previous waveform in the buffer while
gradually redrawing the new waveform over the top of it. Thus, at any time, the left-
hand side of the view shows the beginning of the new waveform, while the right-hand
side shows the end of the previous waveform. A vertical bar separates the two
waveforms. This operation uses the Fast Streaming Mode capability of the PicoScope
oscilloscope hardware.

Sin(x)/x Interpolation

When the number of pixels across the scope view is greater than the number of
samples in the waveform buffer, PicoScope interpolates - that is, it fills the space
between the samples with estimated data. It can either draw straight lines between
the samples (linear interpolation) or connect them with smooth curves (sin(x)/x
interpolation). Linear interpolation makes it easier to see where the samples are, which
is useful for high-accuracy measurements, but results in a jagged waveform. Sin(x)/x
interpolation gives a smoother waveform but disguises the true locations of the
samples, so should be used with care when the number of samples on the screen is
low.

You can adjust the number of samples below which sin(x)/x interpolation is switched
on. Sin(x)/x interpolation is used only on the scope's fastest timebase.
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6.5.8.4 Keyboard page

Location: Tools > Preferences > Keyboard

Purpose: displays, and allows you to edit

, keyboard shortcuts

A keyboard shortcut is a combination of keys that can be pressed on the keyboard to

activate a PicoScope operation.

|' Regional & Language || Printing || Colors || Options || Updates |
|' General || Power Management || Sampling ] Keyboard
Keyboard Shortcuts
[] Show Full Key List
= Auto Setup h
L Auto Setup
All available = Buffer Keyhoard
PicoScope L Next Ctrl = Alt = Right shartcuts {if
operations are . Previous Cri=Alt=Left * | defined) are
listed here - Channel listed here
EI Channel A
EI Analog Offset
: E----Decrement
Increment
: L Reset
E--Coupll‘ng
© o beNext
: - Previous
- Enabled
L b Clear v
Press shortcut Keys:
Define new
] shortcuts
Select keyboard map. . . Manage
User [v] | Export | keyboard maps

psw.en r39
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Keyboard Shortcuts This is a list of PicoScope operations and their associated
keyboard shortcuts (if defined). The extent of the list
depends on the Show Full Key List option (see below).

To edit or add a keyboard shortcut:

e Scroll the list of PicoScope commands until the required
operation is visible.

Select the required operation.

Select the 'Press shortcut keys:' box.

Press the required key combination on the keyboard.
Click Assign.

Show Full Key List Check this box to show all available operations. By default,
only the most common operations are listed, plus any other
operations that have a keyboard shortcut assigned to them.

Keyboard Maps A set of keyboard shortcuts is called a map. You can define
multiple maps for different applications.
Default: This map cannot be edited. Use it to return to the
factory-defined basic shortcuts.
Advanced: This is another factory-defined map that cannot
be edited. It contains a more comprehensive set of shortcuts.
User: This is the map that you most recently created or
imported. It is preserved between PicoScope sessions.
Import: Load a keyboard map froma .pskeys file.
Export: Save the current keyboard map to a .pskeys file.
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6.5.8.5 Regional & Language page

lets you select the language and other location-dependent settings for

Location: Tools > Preferences > Regional & Language
Purpose:
PicoScope's user interface
[ Geneml | Power Management I Samping || Keyboard |

Regional & Language

[ Prirting || Colors || Options || Updates |

Language Mode Selection

Language

English [English]

[v]

|:| Show languages with missing fonts

Measurement System

Specify which measurement system to use,

System Default

(v

Language

Measurement System

Select, from the drop-down box, the language you wish to
use for the PicoScope 6 user interface. PicoScope will ask
you to restart the program before switching to the new
language.

Select metric or U.S. units.

psw.en r39
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6.5.8.6  Printing page
Location: Tools > Preferences > Printing
Purpose: lets you enter the details that will appear at the bottom of printed
output
[ Geneml | Power M?nagemerrt ) [ Sampling

[ Keyboard |
| Regional & Language ]

[ Colors || Options || Updates

Printing

Default Print Settings

Set the default contact information for printing

Company Mame

|Pico Technolagy

Company Website

|www.picotech.com

Telephone Mumber |—44-14SD-396395

Company Logo

P1CO| [ aa )

Default Print

When you print a view from the File menu, these details will be added
Settings

to the bottom of the page.
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6.5.8.7  Colors page

Location: Tools > Preferences > Colors
Purpose: lets you set the colors for various parts of the user interface
[ Geneml |f Power Management [ Sampling || Keyboard |
|’ Regional & Language || Prirting ] Colors [ Options || Updates
Custom Colors
=I- Channels
Ll Channel A
B Channel B
B Channel C
E Channel D

+- Masks
+- Misc
Persistence

¥

Item

B Default |E| |: Custom...

Line Thickness

ST | Une Thickness

Grid Lines i —
[v] |———1pt [~

|: Reset Colors to Default :|

Custom Colors
These controls let you specify the colors for various parts of the PicoScope screen:

Channels the trace color for each scope channel

Digital Channels if you have a mixed-signal oscilloscope (MSQ), the color of each
channel can be set here

Masks the mask areas in Mask Limit Testing

Misc miscellaneous items:

Grid lines the horizontal and vertical lines on the graticule

Background the area behind the waveforms and graticule. (In persistence
mode this setting can be overridden by the Persistence Options
dialog).

Live trigger the trigger marker for the current trigger position

Trigger secondary trigger marker (appears when the live trigger has

moved since the last waveform capture)

Horizontal axis the numbers across the bottom of each view, which usually
indicate time measurements
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Rulers the horizontal and vertical rulers that you can drag into position
to help measure features on the waveform

Persistence the three colors to use for each channel in digital color
persistence mode. The top color is used for the most frequently
hit pixels, the middle and bottom colors for the less and least
frequently hit pixels.

Line Thickness
These controls let you specify the thickness of the lines drawn on the scope and
spectrum views:

Channel the waveforms and spectrum traces for all scope channels
Grid Lines the horizontal and vertical lines on the graticule
Markers the horizontal and vertical rulers that you can drag into position

to help measure features on the waveform
Reset Colors to Default

Resets all of the color and line thickness settings to their default values.
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6.5.8.8  Options page
Location: Tools > Preferences > Options
Purpose: lets you set various options that control the way that PicoScope 6 works
[ Geneml |f Power Management )if I \I{ey'board ]
|’ Regional & Language || Prirting || Colors ] Options Updates |
Device Startup Settings
Remember the last device connected and attempt to connect by default
[ ] Remember Last Device
Advanced Features
Enable PicoScope & advanced features,
Spectrum [+«] Trigger Delay
Persistence Rapid Trigger
[+] Zoom Cverview
RFM [] Bottom taclbar attap
Recent Files
s B
|: Reset recent files list
Device Startup Settings
Remember Last Device. This option is used when PicoScope finds more than one
scope device. If the check box is ticked, PicoScope will attempt to use the same
device that was used last time. Otherwise it will use the first device available.
Advanced Features
The advanced capture modes are enabled by default in PicoScope 6 and disabled by
default in PicoScope 6 Automotive. Regardless of the version that you have, you can
enable or disable these features using the following options:
Spectrum Spectrum view and spectrum analyzer features
Persistence Digital Color, Analog Intensity and custom
persistence display modes
Zoom Overview A window that appears when you zoom in, to help
to move around large waveforms with the
minimum of mouse clicks
RPM Revolutions per minute, displayed alongside hertz
in the frequency legend
Trigger Delay The time-delay control in the Triggering toolbar.
Rapid Trigger The 'Rapid' entry in the Trigger mode control in
the Triggering toolbar.
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Move Trigger toolbar to top

Bandwidth Limit

Recent Files

The toolbar containing the Start/Stop, Triggering,
Measurements and Rulers controls is at the
bottom of the PicoScope window by default. This
option moves it to the top.

A fixed-frequency single-pole analog filter.

The maximum number of files listed in the File > Recent Files menu. Click the button

to clear the list.
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6.5.8.9  Updates page

Location: Tools > Preferences > Updates

Purpose: configures the automatic update checker and related services

[ Geneml | Power Management

| Samping || Keyboard |

|' Regional & Language || Printing || Colors || Options ] Updates

Automatic Updates

Software updates are free and contain new features,
performance improvements and bug fixes. Please choose if you
would like to be notified when updates become available:

':' Don't check for updates

'§' Motify me when updates are available

|:| Also notify me about pre-release (beta) versions

| Reset 'Don't prompt me again for these versions’

Usage Statistics

Help improve PicoScope & by submitting anonymous usage
statistics, These statistics help us prioritise the most

frequently used features,

View our privacy policy

Automatic Updates

Don't check for updates.

Notify me...

Reset...

Usage Statistics

If you prefer, you can visit www.picotech.com periodically
to check for updates.

PicoScope will regularly check for updates to your
software. (Requires an internet connection).

If you checked the Don't remind me again... option in the
Software Updates dialog, this button enables reminders
again.

To help us to continue improving PicoScope, the program periodically sends back to our
developers anonymous information about which features you use the most. This
information does not contain your name, email address or any other personal details,
but does allow us to identify which country you are in. If you do not wish to send us
this information, uncheck this box.
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6.6 Help menu

Location: Help

Purpose: gives access to the PicoScope 6 User's Guide and related information

@ User's Guide...
Online Documentation
COnline Forum
Send Feedback
Check for Updates...

About PicoScope ...

User's Guide This is the most complete source of information on
PicoScope.

Online Documentation Find manuals and training guides for Pico Technology
products.

Online Forum Request technical support and discuss questions with fellow
PicoScope users. New software features are sometimes
announced here before they make it into the User's Guide.

Send Feedback Send us suggestions for improving PicoScope.

Check for Updates Check online for later versions of PicoScope. If you have
both stable and beta versions installed, this checks for
updates to both of them. You can configure the settings for
automatic update checking under the Tools > Preferences

> Updates menu.

About PicoScope 6 Displays useful information such as the model and serial
numbers of your scope, and software and driver version
numbers.
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6.7 Automotive menu (PicoScope Automotive only)

Location: Menu bar > Automotive
Purpose: gives access to a database of preset tests
Charging and Starting " Show Web Help: When this box is checked,
selecting a preset test also opens a help file
Sensors g with instructions and technical information.
Actuators 3 Clear this box to disable.
Ignition k

Communication Metwarks »

Advanced Tests b
Pressure Sensors »
Motorcycle-Specific 3

Accessories GQuide

Show Web Help

1. Select a preset test.

2. PicoScope opens the relevant information page that explains how to setup the test
for the scope that is connected, run the test and interpret the results (a few tests
do not have an information page).

3. PicoScope displays an example waveform.

4. PicoScope configures itself with the necessary settings. In most cases all you need
to do is press the space bar to start the test.
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6.8 Connect Device dialog
Location: File > Connect Device
or plug in a new device

Purpose: when PicoScope finds more than one available scope device, this dialog
allows you to select which one to use

Connect Device H

Select a device to use from the list below. If you plug in a QK |
new device now, it should appear in the list, E—
Cancel |

PicoScope 22054, CW338/002 Help |

‘ PicoScope 3204M50, ALSET/001
% Demao

Refresh List |

See How to change to a different device if you wish to switch to a different scope
device later.

Procedure

Wait for a list of devices to appear. This may take a few seconds.

Select a device and click OK.

PicoScope will open a scope view for the selected scope device.

Use the toolbars to set up the device and the scope view to display your signals.

_J
_J
_J
_J

Demonstration mode

If you start PicoScope with no device connected, the Connect Device dialog
automatically appears with a Demo (demonstration) device as one of the options. This
is a virtual device that you can use to experiment with the features of PicoScope. If
you select the Demo device and click OK, PicoScope adds a Demo Signal Generator
button to the toolbar. Use this button to set up the test signals from your Demo
device.
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6.9 Converting files in Windows Explorer

You can convert PicoScope data files to other formats for use in other applications, or
to different forms of data for use with PicoScope.

The easiest way to do this conversion is through the context menu in Windows
Explorer. The context menu is the menu that pops up when you right-click it with the
mouse or activate it with the menu button on a Windows keyboard. When you install
PicoScope, a Convert entry is added to the context menu to enable you to convert
PicoScope data files.

N L PicoScope = B
“ Home Share View 9
T » PicoScope v & Search PicoScope o
A
-{ Favourites : ' . . H:H:
"M Computer :
R t pl d Open
=| Recent places
P capt.psdata Print
B Desktop
Convert b
& Downloads
Open with...
Send to b
Cut
Copy
]
4 items 1 item selected 43.8 KB Create shortcut
Delete
Rename
Properties

The PicoScope context menu in Windows Explorer
Converting to PicoScope 6.2.4 format

The example above shows four pre-existing PicoScope data files represented by
standard PicoScope icons. PicoScope 6.2.4 introduced a new feature that allows
PicoScope data files to appear as waveforms instead of icons. To enable this feature
for old data files, you need to convert them to the new format using the context menu
of Windows Explorer.

If PicoScope is running, close it.
In Windows Explorer, right-click a PicoScope data file.

Select Convert > All waveforms > .psdata. A PicoScope icon “w will appear in the
Windows notification area while the conversion is in progress.

PicoScope will ask you to confirm that you wish to overwrite the .psdata file with a
new version. Click Yes.

Wait for Windows Explorer to update the display.

Repeat for all .psdata files.
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The .psdata files should nhow appear as in this picture:

SN AL Waveforms - O -
Home Share WView o

(_): * T L » Waveforms v ¢ Search Waveforms -]
- Favourites " I | I I. Il ll

4 Downloads
= Recent places

18 Computer

4 views.psdata 1000 sine " CAN Dero 12C_Sample.psdat
waves.psdata 1.psdata a

4 (M This PC =

> | Documents -

» 4 Downloads 0

W Music ikt drichg]

» | =] Pictures mask serial

& vid overview.psdata decoding.psdata
> ideos
v

B itemns €= | =

Converting to other formats

For all of these conversions, you can choose either All waveforms or Current
waveform. A .psdata file can contain either a single waveform or the entire contents
of the waveform buffer, which can hold a number of waveforms from successive trigger
events. If the .psdata file contains more than one waveform, then you can choose to
convert all of them or just the one that was last viewed in PicoScope.

> Right-click a PicoScope data file.
» To convert all waveforms in the file, select Convert > All waveforms or Convert >

Current waveform and then the file format that you require. A PicoScope icon “
will appear in the Windows notification area while the conversion is in progress.

Complex operations

For more complex operations, such as converting all files in a directory, you can run
PicoScope in a command window (see Command-line syntax).
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/  Toolbars and buttons

A toolbar is a collection of buttons and controls with related functions.

7.1 Advanced Options toolbar

The Advanced Options toolbar controls Phase (or Rotation) Rulers, Notes and (in
PicoScope Automotive only) Channel Labels.

Rulers B Motes B Channel Labels B

It contains the following buttons:

Rulers Opens the Ruler Settings dialog that controls the Phase
rulers (or in PicoScope Automotive, Rotation rulers)

Notes Displays the Notes at the bottom of the window

Channel Labels (PicoScope Automotive only) Displays the Channel Labels at
the bottom of the window

This toolbar normally resides at the bottom of the program window, but can be moved
to the top using the Tools > Preferences > Options > Bottom toolbar at top
control.
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7.2

7.2.1

Channels toolbar

The Channels toolbar controls the settings for each vertical input channel. The
screen shot below shows the toolbar for a two-channel scope device, but different
scope devices may have different numbers of channels. (See also PicoLog 1216 toolbar
that is used for the PicoLog 1000 Series).

Ay | Auto [+] | oc [v]|| By |Auto [+] |oc ] | ==

Each channel has its own set of buttons:

Au Channel Options button. Opens the Channel Options menu with

options for probes, resolution enhancement, scaling and filtering.

Auto |1|| Range control. Sets up the scope device to capture signals over
the specified range of values. The list of options depends on the

selected scope device and probe. A red warning symbol - L
appears if the input signal exceeds the selected range. If you
select Auto, PicoScope will continually adjust the vertical scale so
that the height of the waveform fills as much of the view as
possible.

pC |7 Coupling Control. Sets up the input circuitry.

AC coupling: rejects frequencies below about 1 Hz.

DC coupling: accepts all frequencies from DC to the scope's
maximum bandwidth.

50Q DC: low-impedance option (see Device feature table).
Accelerometer: switches on the current source output for IEPE-
enabled scopes such as the PicoScope 4224 IEPE. The User's Guide
for the oscilloscope has details of the IEPE channel specifications.
Frequency: enable the built-in frequency counter. Only one
channel at a time can be operated in this mode. Available only if
your scope device has hardware support for this feature: see
Device feature table. Not available in Demo mode.

=5 Digital Inputs button (MSOs only).

Channel Options menu

The Channel Options menu appears when you click the probe |1 e

Resolution Enhancement
Channel Options button (for example: Au ) on the Channels seectthe maimun 505, (2]
toolbar. number of its.

When should | use this feature?

Lowpass Filtering

[] Activate Filtering

Analog Options

DC Offset ov E=
Axis Sealing

Scale 100 EH)
Offset o00%  [=[4]

Zero Offset

| zeo |
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*1 (][]

Resolution Enhancement

Select the maximum

_ 8.0bits  |v]
number of bits, —

When should | use this feature?

Scale | 1.00 |§||§|

Offset| 0.00%  [[4]
| [

Analog Cptions

DC Offset oV =
Lowpass Filtering
1 kHz 1 kHz =

Activate Filtering

Lfero Offset

| Zero |

Probe list. Indicates the probe currently in use
and allows you to select a different one. Use it to
tell PicoScope what type of probe is connected
to a channel. By default, the probe is assumed to
be x1, which means that a one-volt signal at the
input to the probe will appear as one volt on the
display.

Expand probe list. Click this to select from a list
of probes.

Open Custom Probes dialog. The Custom
Probes dialog allows you to edit your library of
custom probes.

Resolution enhancement. Allows you to
increase the effective resolution of your scope
device using Resolution enhancement. The
number in this box is a target value that the
software will attempt to use whenever possible.

AXxis Scaling. These are the axis scaling controls
that allow you to set the scale and offset for
each vertical axis individually.

Analog Options. Options that can be applied to
the oscilloscope input hardware, if the
oscilloscope hardware supports them.

DC Offset: an offset voltage added to the analog
input before digitization. For availability, see the
Device feature table.

Bandwidth Limit: a fixed-frequency single-pole
analog filter. This can be useful for rejecting noise
and harmonics that would otherwise cause
aliasing. This advanced feature needs to be
enabled in Tools > Preferences > Options before
use. For availability, see the Device feature table.

Lowpass Filtering. An independent digital
lowpass filter for each input channel, with
programmable cut-off frequency. This can be
useful for removing noise from your signal to make
more accurate measurements. For availability, see
the Device feature table.

Zero offset. Digitally removes any offset from the
input channel. Before starting this operation,
remove any input signal from the selected
channel and short-circuit the input. Click Zero to
begin the adjustment. Click Clear to restore the
input to its uncorrected state.
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7.2.1.1

Resolution enhancement

Resolution enhancement is a technique for increasing the effective vertical resolution
of the scope at the expense of high-frequency detail. In some scope operating modes
PicoScope may reduce the number of samples available to maintain display
performance.

For this technique to work, the signal must contain a very small amount of Gaussian
noise, but for many practical applications this is generally supplied by the scope itself
and the noise inherent in normal signals.

The resolution enhancement feature uses a flat moving-average filter. This acts as a
low-pass filter with good step response characteristics and a very slow roll-off from the
pass-band to the stop-band.

Some side-effects will be observed when using resolution enhancement. These are
normal and can be counteracted by reducing the amount of enhancement used,
increasing the number of samples captured or changing the timebase. Trial and error is
usually the best way to find the optimum resolution enhancement for your application.
The side-effects include:

Widened and flattened impulses (spikes)

Vertical edges (such as those of square waves) turned into straight-line slopes
Inversion of the signal (sometimes making it look as if the trigger point is on the
wrong edge)

A flat line (when there are not enough samples in the waveform)

Procedure

Click the Channel Options button “a in the Channel Setup toolbar.

Use the Resolution Enhancement control in the Advanced Options menu to select
the effective number of bits, which can be equal to or greater than the vertical
resolution of your scope device.

Quantifying Resolution Enhancement

The table below shows the size of the moving-average filter for each resolution
enhancement setting. A bigger filter size requires a higher sampling rate to represent a
given signal without significant side-effects (as detailed above).

Resolution Number of
enhancement values

e (bits) n
0.5 2
1.0 4
1.5 8
2.0 16
2.5 32
3.0 64
3.5 128
4.0 256
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Example. Your scope device is a PicoScope 5204 (resolution = 8 bits). You have
selected an effective resolution of 9.5 bits. The resolution enhancement is therefore:

e =9.5 - 8.0 =1.5 bits.
The table shows that this is achieved using a moving average of:

n = 8 samples.
This number gives a guide to what sort of filtering effect the resolution enhancement
will have on the signal. The best way of seeing the actual low-pass filter effect is to
add a spectrum view and look at the shape of the noise floor (try dragging the y-axis
upwards to see the noise more clearly).

Related topics

See Hardware resolution (applies to Flexible Resolution Oscilloscopes only).
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7.2.1.2  Axis scaling controls

The axis scaling controls are control boxes that let you change the scale and offset
of each vertical axis individually. If the axis belongs to a reference waveform then you

can also adjust its delay relative to the live waveforms.

Scale 1.00 %lEl Scale 1.00 %lil

Offset| 0.00% [« Offset 0.00% (4]

BE  ow

Controls for a live |%| |%|
waveform -

Controls for a
reference waveform

There are two ways to open the axis scaling control:

For any channel displayed in a view: click the colored scaling button ( ) at the
bottom of the vertical axis
For any input channel: Click the Channel Options button in the Channels toolbar

*

1.00 (<)

()

0.00% (e

Scale control. Increase to magnify the waveform, decrease to reduce
it. The vertical axis rescales accordingly so that you can always read

the correct voltage from the axis. Click the reset button (1)) to retumn
to a scale of 1.0. The scaling button always shows the selected scale.

Offset control. Increase to move the waveform up the display, decrease
to move it down. The vertical axis shifts accordingly so that you can
always read the correct voltage from the axis. Adjusting this control is
equivalent to clicking and dragging the vertical axis. Click the reset

button ([2) to return to an offset of 0.00%.

Delay control (for reference waveforms only). Increase to move the
waveform to the left relative to the timing reference point, decrease to
move it to the right. Click the reset button (2)) to return to a delay of 0
s.

The location of the timing reference point depends on which trigger
mode PicoScope is in. If the trigger mode is None then the delay is
measured relative to the left-hand edge of the display. In all other
trigger modes, the delay is measured relative to the trigger marker.

Send to back. Draws the channel behind all others. Use if the channel is
obscuring another channel of interest.

Bring to front. Draws the channel in front of all others. Use if the
channel is hidden behind another.
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7.2.1.3  Lowpass filtering
The lowpass filtering feature can reject high frequencies from any selected input
channel. The filtering control is found in the Advanced Channel Options dialog, which is
opened by clicking the Channel Options button ( Ax ) for the relevant channel on the
Channels toolbar. The control determines the cut-off frequency of the filter, which
must be below half the sampling rate shown in the Properties sheet.
Lowpass Filtering
1 kHz 1 kHz E
Activate Filtering
For availability, see the Device feature table.
Lowpass filtering is useful for rejecting noise. The split screenshot below shows the
effect of applying a 1 kHz lowpass filter on a noisy signal. The underlying shape of the
signal is preserved but the high-frequency noise is eliminated:
iy PicoScope 6 - 0
Eile Edit Niews Measurements Tools Help |
A alu |y | 2 @] [5msaw [v]|] 1 Bl 1ms Bl 320732 Y LIRAE
Ag |z100mv [v] Dc [v] | By oOff | ny
C N
my
E0.0 /F\
40,0
200
0o
-20.0
-40,0 \
-60.0
-20.0 "
100.04 /
-25.0 -200 -15.0 -10.0 -5.0 0.0 5.0 10.0 15.0 200 250
B ms
Running @ 0 | Trigger |Auto ﬂ!| A | i | ov EH 50% EI =Y
Left: before lowpass filtering. Right: after 1 kHz lowpass filtering.
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Filter details

The lowpass filtering algorithm is chosen according to the ratio of the selected cut-off
frequency (f.) to the sampling rate (f;), as follows:

fc

0.0to 0.1 Moving average

= f,

s Filter type

0.1to <0.5 |FIR

Description

A moving average filter is used for low cut-off
frequencies. The length of the filter is adjusted to
achieve the selected cut-off frequency, which is
defined as the first minimum in the frequency
response. There is significant signal leakage above
the cut-off frequency. This filter changes a vertical
edge into a linear slope.

A finite impulse response filter is used for medium to
high cut-off frequencies. This has a monotonic roll-
off above the cut-off frequency and therefore
suffers from less leakage than the moving average
filter.

You can force PicoScope to use one or other of the filter types by adjusting the
Samples control in the Capture Setup toolbar to make the ratio f/f; fall into one of

the two ranges shown in the table. As the table shows, the cut-off frequency must be

below half the sampling frequency.

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.
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7.2.2  ConnectDetect

Availability: PicoScope 4225 and 4425 automotive scopes only.
DC coupling mode only.

Purpose: Indicates whether a test probe has a good physical connection to the
component under test or not.

Location: To enable ConnectDetect, click the ConnectDetect button @ in
PicoScope.

When ConnectDetect is activated for a channel, the LED for that channel is either
green to indicate that the test probe is directly connected across a component, or red
to indicate that it is not. An icon representing the LED is also shown on the PicoScope
screen, as in the example below where ConnectDetect is activated on Channel A.

Ede  [Eda  iwews b
Pl ] s mae ]|
Ay Ao =] o ~] | 8

.
4 - smh

Ruberi. [ Mosri [ Charnel Labei [
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7.2.3

7.2.3.1

Digital Inputs button
Location: Channels toolbar (MSOs only)

controls the settings for the digital inputs of a mixed signal oscilloscope

Purpose: (MSO)

Digital = Digital

on/off ;E setup

|*£% | Digital on/off. Switches the digital view on or off. If digital inputs are
activated in the Digital Setup dialog, they remain active even when hidden
from view.

E| Digital setup. Opens the Digital Setup dialog for channel selection and
options.

Digital Setup dialog
Location: MSO button

Purpose: controls the digital inputs of an MSO (mixed signal oscilloscope)

Select Digital Channels/Groups H

Set Thresholds:

=
~
<
in
-
[<[2]
E
=
@
in
<
[:[2)

D13
D14
D13
D12
01
D10
Dg

D&

o7
[l
[k
D4
03
D2
[ad}
Do

Available
channels

EEEOOEED

EECOCEED

Channels and Groups for Display:
----- L 015 -

(_create Group |
----- m 13 [ Enablean |
..... mn p11 [ Disable Al :I

..... nn og | Remave All |

Motes:

-In a group the bottom channel is LSB.
- Right click on channel/group for more options,

[ ok |[ cance | [ Hew |
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Set Thresholds

Choose the digital threshold voltage from the drop-down list, or select the Custom
threshold and set your own voltage using the numeric entry control. The preset
thresholds are:

TTL: L5V Each port has its own
CMOS: 2.5V independent threshold. Port
ECL: -1.3V 0 contains channels D7...D0
PECL: 3.7V and Port 1 contains
LVPECL: 2V channels D15...D8.

LVCMOS 1.5 V: 750 mv

LVCMOS 1.8 V: 0.9V

LVCMOS 2.5 V: 1.25V

LVCMOS 3.3 V: 1.65V

LVDS: 100 mV

0V Differential: ovVv

Available Channels

This section lists the available digital input channels. They will not be displayed unless
you add them to the Channels and Groups for Display section of the dialog. Click and
drag individual channels into the Channels and Groups for Display section, or select
a range of channels and drag them all at once, or double-click a channel to add it
directly.

Channels and Groups for Display

This section lists the digital channels that have been selected for display. Any groups
of channels that you have defined will also be listed here.

mn  indicates a digital channel.

indicates a group of digital channels. By default, channels added to a group are
placed with the most significant bit at the top of the list.

To rename a channel or group, click the name and type. For other operations, right-
click the channel or group for a menu of actions:

Enable
Disable
Invert
Rename

Reverse Channel Crder

Remove

Enable: Show the channel. All channels in the list are
enabled by default.

Disable: Hide the channel from display.

Invert: Reverse the polarity of this channel. Useful for
active-low signals.

Rename: Type a new name for the channel.

Reverse Channel Order: (Groups only) Reverse the order of channels in the
group.

Remove: Remove channel from the list.

psw.en r39
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7.3 PicoLog 1000 Series Channels toolbar

The Channels toolbar controls the settings for each vertical input channel. The
toolbar has a different appearance for PicoLog 1000 Series Data Loggers than for
PicoScope oscilloscopes (see Channels toolbar for the standard version).

[ienai)[ch2 [-)[ch3 [7][ch4 [F)(Ch5 [-)[ch6 [-][ch7 [[cha [)[cho [Jch10[[chit [F[ch 2 F)ich 3 [)[ch e [[chi5 [ [ch 16 )| %

|chi |~/ Channel control. This control contains two buttons in one rectangular
outline. Click the small triangle on the left to open the Channel Options
dialog with options for probes, resolution enhancement, scaling and filtering.
Click the channel name to toggle the channel on or off.

Digital Outputs button. For controlling the 2 or 4 digital outputs of the
PicoLog 1000 Series device. Opens the Digital Outputs dialog.

>
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7.3.1  PicoLog 1000 Series Digital Outputs control

Location: Digital Outputs button & on the Channels toolbar
Purpose: controls the data logger's built-in signal generator
Digital Out 4
PWM  [v]  Period 1ms

L I

Duty Cyde 50
Digital Outputs
High ) ) . i
|l |l |ﬂ |ﬂ
0 1 2 3

Digital Outputs dialog for the
PicolLog 1216

Low

The range of controls available depends on which model of data logger you have.

PWM Output

PWM. The PWM output on some devices can be set to generate
a pulse-width modulated waveform. This is a logic signal that is
toggled with a specified period and duty cycle. The average
value of the signal is proportional to its duty cycle, so it can be
processed by an external low-pass filter to produce a signal that
is proportional to the duty cycle.

Off: Disable the PWM output.
PWM: Enable the PWM output with the specified
controllable Period and Duty Cycle.

1 ms

Period. Select the duration of one cycle of the PWM output.

([

0%

([

Duty Cycle. The percentage of the PWM signal period that the
signal spends at the logic high level. For example, if the period is
1 ms and the duty cycle 25%, then the signal will spend 25% of 1
ms = 250 ps of each cycle at the logic high level, and the
remaining 750 us at the logic low level. The voltages of the logic
high and low levels are specified in the User's Guide for the data
logger, but are typically 0 volts (low) and 3.3 volts (high). Using
our example figures, the average value of the PWM output will be
25% x 3.3 volts = 0.825 volts.

Digital Outputs PicoLog PC Data Loggers have one or more digital outputs
capable of driving low-current loads.

High
l Each output can be set to a high or low logic level by moving the
|

slider.
Low
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7.4 USB DrDAQ Channels toolbar

The Channels toolbar for the USB DrDAQ controls the settings for each input and
output channel:

|ouna[][ a8 _[+](scope[~][onms [-][ pH_[][Teme [-][tiont [-)[Bxt 1 [z [[ex3 ]| A 15 &

kound[~| Sound waveform sensor control. The small arrow sets options for the
sound waveform input (measured in uncalibrated amplitude units) using the
on-board microphone. Click the channel name to toggle the channel on or
off.

[ a8 [+| Sound level sensor control. The small arrow sets options for the sound
level input (measured in decibels) using the on-board microphone. Click the
channel name to toggle the channel on or off.

[scope[+|  Scope input control. The small arrow sets options for the oscilloscope input
(the BNC socket marked Scope), with options for probes and scaling. Click
the channel name to toggle the channel on or off.

| ~| Resistance input control. The small arrow sets options for the 0 to 1 MQ
resistance-measuring input on the screw-terminal block. Click the channel
name to toggle the channel on or off.

[ pH [*] pH input control. The small arrow sets options for the pH and ORP
(oxidation/reduction potential) measuring input. Click the channel name to
toggle the channel on or off.

| | Temperature sensor control. The small arrow sets options for the on-
board temperature sensor. Click the channel nhame to toggle the channel on
or off.

nt [+ Light sensor control. The small arrow sets options for the on-board light
level sensor. Click the channel name to toggle the channel on or off.

[Ext1 [+] External sensor controls. The small arrows set options for external sensor
|£|:| inputs 1 to 3. Click the channel name to toggle the channel on or off.

N Signal generator button. Opens the Signal Generator dialog, which allows
you to set the characteristics of the signal generator output.

13 RGB LED button. Opens the RGB LED Control dialog, which allows you to set
the color of the on-board LED.

g Digital Outputs button. Opens the Digital Outputs dialog, which allows you
to control the states of the four digital outputs.
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7.41  USB DrDAQ RGB LED control

Location: USB DrDAQ Channels toolbar > RGB LED button:

Purpose:
colors

Enable LED Control

ﬁ Brightness
’ 100

<]

%]
=
m
m
=
n
[
(B 0| |

15

allows you to set the color of the on-board LED to any one of 16.7 million

Enable LED Control: Box checked: you can set the on-board RGB LED to any color
Box clear: the LED has its normal function of flashing to
indicate data capture on the input channels

Other controls: Experiment with these to see what they do!

psw.en r39

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.



PicoScope 6 User's Guide 129

7.4.2  USB DrDAQ Digital Outputs control
Location: USB DrDAQ Channels toolbar > Digital Outputs button: &

Purpose: allows you to set the characteristics of the four digital outputs on the
screw-terminal block.

Each output has its own set of controls:

Digital Out 1
PIM |E| Period 1ms z
Duty Cyde |50 =)
Digital Out 2
PWM [v] Pperiod 1 ms =
DutyCyde |50 =
Digital Out 3
Out [»] High .
Il
Low
Digital Out 4
Out |E| High ]
Iﬂ
Law

PWM/Out Control: Set to Out: you can set the output to either a fixed logic low
(near 0 V) or a fixed logic high (near 3.3 V)
Set to PWM: the output is a two-level waveform (alternating
between 0 V and 3.3 V) with variable Duty Cycle and Period.
The signal can be filtered to produce a DC level proportional to
the duty cycle.

Period: the time between successive pulses on the output

Duty Cycle: the percentage of the Period for which the output is high.
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7.5

Capture Setup toolbar
The Capture Setup toolbar controls the time-related or frequency-related settings of

your oscilloscope.

Scope Mode

In scope mode, the toolbar looks like this:

A ML dlu |

| 2 4| smsdiv [v]] x1 E| 1ms | 12bits [v]

(See below for different versions of the toolbar in spectrum mode and persistence

mode).

s

fat

100 psfdie [+

Scope Mode. Sets up PicoScope to operate as an oscilloscope. Use
the Auto Setup button to optimize the settings. If you wish, you
can add a secondary spectrum view from the context menu (by right-
clicking on the scope view).

Persistence Mode. Toggles persistence mode, which allows old
traces to remain on the screen in faded colors while new traces are
drawn on top in brighter colors. The use of colors is controlled by
the Persistence Options dialog. PicoScope will remember any views
that were open, so that you can return to them by clicking the
Persistence Mode button again.

Spectrum Mode. Sets up PicoScope to operate in spectrum analyzer
mode. Use the Auto Setup button to optimize the settings. If you
wish, you can add a secondary scope view from the context menu
(by right-clicking on the scope view).

Auto Setup. Searches for a signal on one of the enabled input
channels, then sets up the timebase and signal range to display the
signal correctly.

Home. Restores PicoScope to its default settings. Equivalent to the
File > Startup Settings > Load Startup Settings command.

Timebase control. Sets the time represented by a single division of
the horizontal axis when the horizontal zoom control is set to x1.
The timebases available depend on the type of scope device you are
using and, for some devices, on the number and combination of
channels enabled and the selected trigger mode.

Choosing a timebase equal to or longer than PicoScope's Slow
Sampling Transition setting (200 ms/div by default) causes the scope
to switch to a different mode of data transfer. The internal details of
this are taken care of by PicoScope, but the slow mode limits the
sampling rate to the 'streaming mode sampling rate' specified in the
scope device's data sheet. The Slow Sampling Transition setting can
be changed in the Tools > Preferences > Sampling dialog.

You can change this control to display the total time across the
scope view, rather than the time per division, using the Collection
Time Units control in the General page of the Preferences dialog.

psw.en r39
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w1

1 M3

12 bits

Spectrum Mode

[+][=][=]

%'

Horizontal zoom control. Zooms the view, in the_horizonial
direction only, by the specified amount. Click the || and [=] buttons
to adjust the zoom factor, or the 12/ button to reset.

Samples control. Sets the maximum number of samples that will be
captured for each channel. If this is larger than the number of pixels
across the scope view, you can zoom in to see more detail. The
actual number of samples captured is displayed on the Properties
sheet, and may be different from the number requested here,
depending on which timebase is selected and which scope device is in
use. To capture one waveform that occupies the entire buffer
memory, first set the Trigger Mode control to Single.

Hardware resolution (Flexible Resolution Oscilloscopes only). Sets
the number of hardware bits used for sampling. The range of options
depends on the number of channels enabled and the sampling rate
selected. Automatic Resolution chooses the highest resolution
compatible with the currently selected sampling rate and capture
size. To find out what resolution is actually in use, view the
Effective Resolution value in the Properties Sheet. Resolution can
be further increased by software filtering: see resolution
enhancement.

In spectrum mode, the Capture Setup toolbar looks like this:

A MLl dg | 2 64| eommz [] ] x1 =

125 MHz

[v]

Spectrum Range control. Sets the frequency range across the
horizontal axis of the spectrum analyzer when the horizontal zoom
control is set to x1.

Spectrum Options. Appears if a spectrum view is open, regardless of
whether scope mode or spectrum mode is selected. It opens the
Spectrum Options dialog.

Persistence Mode

In persistence mode, the Capture Setup toolbar looks like this:

Ay (L1l | Iy | 2 44| | 50 psyaiv [v] | | %1 3]

K

Persistence Options. Opens the Persistence Options dialog, which
controls several parameters affecting the way that PicoScope
represents old and new data in persistence mode.

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved. psw.en r39



132

Toolbars and buttons

7.5.1  Spectrum Options dialog

This dialog appears when you click the Spectrum Options button in the Capture Setup
toolbar. It is available only when a spectrum view is open. It contains controls that
determine how PicoScope converts the source waveform in the current scope view to a

spectrum view.

FFT Cptions
Spectrum Bins

Window Function

¥ Axis
Display Mode

Scale

Logarithmic unit

X Axis
X-Scale

Spectrum
Bins

Window
Function

Display
Mode

16384 [»]
Elackman |z|
Magnitude |z|

'f' Lagarithmic
() Linear

dBu [>]

Linear |z|

The number of frequency bins into which the spectrum is divided.
This control sets the maximum number of frequency bins, which
the software may or may not be able to provide depending on
other settings. The main constraint is that the number of bins
cannot greatly exceed half the number of samples in the source
waveform.

If the source waveform contains fewer samples than required
(that is, fewer than twice the number of frequency bins), then
PicoScope zero-pads the waveform up to the next power of two.
For example, if the scope view contains 10,000 samples, and you
set Spectrum Bins to 16384, then PicoScope zero-pads the
waveform to 16,384 samples, which is the nearest power of two
above 10,000. It then uses these 16,384 samples to provide
8,192 frequency bins, not the 16,384 requested.

If the source waveform contains more samples than required,
then PicoScope uses as many samples as necessary, starting
from the beginning of the waveform buffer. For example, if the
source waveform contains 100,000 samples and you request
16,384 frequency bins, PicoScope needs only 2 x 16,384 = 32,768
samples, so it uses the first 32,768 samples from the waveform
buffer and ignores the rest. The amount of data actually used is
displayed as the Time Gate setting in the Properties sheet.

Allows you to choose one of the standard window functions to
reduce the effect of operating on a time-limited waveform. See
Window functions.

You can choose Magnitude, Average or Peak Hold.

psw.en r39
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Magnitude: the spectrum view shows the frequency spectrum of
the last waveform captured, whether live or stored in the
waveform buffer.

Average: the spectrum view shows a rolling average of spectra
calculated from all the waveforms in the waveform buffer. This
has the effect of reducing the noise visible in the spectrum view.
To clear the averaged data, click Stop and then Start, or change
from Average mode to Magnitude mode.

Peak Hold: the spectrum view shows a rolling maximum of the
spectra calculated from all the waveforms in the buffer. In this
mode, the amplitude of any frequency band in the spectrum view
will either stay the same or increase, but never decrease, over
time. To clear the peak hold data, click Stop and then Start, or
change from Peak Hold mode to Magnitude mode.

Note: when you switch to Average or Peak Hold mode, there may
be a noticeable delay while PicoScope processes the entire
contents of the waveform buffer, which may contain many
waveforms, to build up the initial display. If this occurs, a
progress bar appears at the bottom of the window to show that
PicoScope is busy:

I |
Scale Specifies the labelling and scaling of the vertical (signal) axis.

This can be one of the following:

Linear:
The vertical axis is scaled in volts.

Logarithmic:
The vertical axis is scaled in decibels, referred to the level
selected below in the Logarithmic unit control.

dBV: Reference level is 1 volt.

dBu: Reference level is 1 milliwatt with a load resistance of
600 ohms. This corresponds to a voltage of about 775 mv.

dBm: Reference level is one milliwatt into the specified load
impedance. You can enter the load impedance in the box
below the Logarithmic unit control.

Arbitrary dB: Reference level is an arbitrary voltage, which
you can specify in the box below the Logarithmic unit
control.

X Scale Specifies the scale of the frequency axis:

Linear: The axis is scaled in equal intervals from DC to the
frequency set by the Spectrum Range control.

Log 10: The axis is scaled in decades ending at the specified
Spectrum Range frequency, and beginning at a number of
decades below that as specified by the Number of Decades
control.
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Number of Decades Specifies the number of decades into which the frequency axis is
divided when X Scale is set to Log 10.
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7.5.2

Persistence Options dialog

This dialog appears when you click the Persistence Options button k" in the Capture

Setup toolbar.

It is available only when persistence mode is selected. It controls the

colors and fading algorithm used to distinguish new or frequent data from old or
intermittent data in the persistence view.

Spectrum Bins

16384 [v]

Window Function | glackman [+]

Display Mode

Magnitude  |v|

S cale (*) Logarithrmi
() Linear
Logarithmic unit dEu [w]
Mode Digital Color. This mode uses a range of colors to indicate the

Decay Time

Saturation

Decayed
Intensity

frequency of waveform data. Red is used for the most frequent data,
and less frequent data is represented successively by yellow and blue.

Analog Intensity. This mode uses color intensity to indicate the age of
waveform data. The latest data is drawn at full intensity in the selected
color for that channel, with older data being represented by paler shades
of the same color.

Fast. A mode with simplified display options to enable the fastest
possible update rate.

Advanced. This mode opens up a Custom Options section at the
bottom of the dialog that let you customise the persistence mode
display.

The time, in milliseconds, taken for waveform data to fade from maximum
intensity to minimum intensity or from red to blue. The longer the decay
time, the longer the older waveforms will remain on the screen.

The intensity or color with which new waveforms are drawn.

The intensity or color to which the oldest waveforms decay when the
decay time expires. If the decayed intensity is zero, then older
waveforms will be completely erased from the display after the decay
time. For non-zero values of decayed intensity, old waveforms will
remain indefinitely on the screen at that intensity unless overwritten by
new ones.

Custom Options

Line Drawing

The type of line drawn between samples that are adjacent in time.

Phosphor Emulation. Joins each pair of sample points with a line whose
intensity varies inversely with the slew rate.

Constant Density. Joins each pair of sample points with a line of
uniform color.

Scatter. Draws sample points as unconnected dots.
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Color
Scheme

Background

Data Hold

Persistence
Mode

Phosphor. Uses a single hue for each channel, with varying intensity.

Color. Uses a color from red to blue to represent the age of each
waveform.

Black. Overrides the Color Preferences dialog. This is the default.

White. Overrides the Color Preferences dialog.

User Preference. Sets the background color to the preference set in
the Colors page of the Preferences dialog.

This option is enabled only when Persistence Mode (see below) is set
to Time Delay.

Decay Timeout. Old waveforms fade until they reach Decayed
Intensity and then disappear.

Infinite. Old waveforms fade until they reach Decayed Intensity and
then remain indefinitely unless overwritten by new waveforms.

Fast. The Line Drawing, Decay Time, Saturation and Decayed
Intensity options are disabled to maximize the update rate. In addition,
resolution enhancement, lowpass filtering, sin(x)/x interpolation and
nonlinear custom probes are unavailable in this mode. This mode requires
a scope that supports Rapid Triggering (see Device Features table).

Time Delay. Points on the display are drawn at full intensity when hit by
a waveform, and are then allowed to decay to Decayed Intensity. The
behavior after this depends on the Data Hold setting (see above).

Frequency. Points on the display are drawn with a color or intensity
that depends on the frequency with which they are hit by waveforms.
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7.6 Buffer Navigation toolbar

The Buffer Navigation toolbar allows you to select a waveform from the waveform
buffer.

4l o6 | P &

What is the waveform buffer?

Depending on the settings you have chosen, PicoScope may store more than one
waveform in its waveform buffer. When you click the Start button or change a capture
setting, PicoScope clears the buffer and then adds a new waveform to it each time the
scope device captures data. This continues until the buffer is full or you click the Stop
button. You can limit the number of waveforms in the buffer to a humber between 1
and 10,000 using the General preferences page.

You can review the waveforms stored in the buffer using these buttons:
M First waveform button. Display waveform 1.

y! Previous waveform button. Display the previous waveform in the buffer.

42080  waveform number indicator. Show which waveform is currently

displayed, and how many waveforms the buffer holds. You can edit the
number in the box and press Enter, and PicoScope will jump to the
specified waveform.

o> Next waveform button. Display the next waveform in the buffer.
M Last waveform button. Display the last waveform in the buffer.
&)

Buffer Overview button. Open the Buffer Overview window for quick
selection of buffer waveforms.
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7.7 Measurements toolbar
The Measurements toolbar controls the measurements table.

Measurements G | Rulers G Motes G

It contains the following buttons:

& Add Measurement Adds a row to the table, and then opens the Add
Measurement dialog.

@ Edit Measurement Opens the Edit Measurement dialog for the currently
selected measurement. You can also edit a measurement
by double-clicking on a row of the measurements table.

[@ Delete Measurement Deletes the currently selected row from the
measurements table.

[ Rulers Opens the Ruler settings dialog to control the operation
of phase rulers.

This toolbar normally resides at the bottom of the program window, but can be moved
to the top using the Tools > Preferences > Options > Bottom toolbar at top
control.
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7.8

7.8.1

7.8.1.1

Signal Generator button

The Signal Generator button allows you to set up your scope device's test signal
generator, if it has one, or the demo signal settings if PicoScope is in demo mode.

N

If your scope has a built-in signal generator then clicking the Signal Generator
button opens the Signal Generator dialog.

If PicoScope is in demo mode then clicking the Signal Generator button opens the
Demo Signals menu.

Signal Generator dialog (PicoScope devices)

Location: g
Signal Generator button

on the toolbar

Purpose: controls the scope device's built-in signal generator

Not all scope devices have a signal generator, and those that do have a varying range
of controls in the signal generator dialog. See the Device feature table for details.

Basic controls

Signal Generator x

Signal On
| Arbitrary... | |square [v]
Start Frequency 1 kHz =
Amplitude 1y |§|
Offset oV %
Sweep Mode ] Active

Signal On. Tick this box to enable the signal generator.

Signal Type. Select the type of signal to be generated. The list of signal types
depends on the capabilities of the scope device.

Import. Opens a file selection dialog that allows you to import an arbitrary waveform
file. The file will be loaded into the arbitrary waveform generator and the generator
switched on. This button is available only if your scope has an arbitrary waveform

generator.

Arbitrary. Opens the Arbitrary Waveform window. This button is available only if your
scope has an arbitrary waveform generator.

Start Frequency. Type in this box or use the spin buttons to select the frequency. If
the scope device has a frequency sweep generator, then this box sets the start
frequency of the sweep.

Amplitude. The amplitude of the waveform measured from peak to peak. For example,
if Amplitude is 1 V and Offset is 0 V, the output will have a negative peak of -0.5V
and a positive peak of +0.5 V.
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Offset. The mean value of the signal. For example, when Offset is 0 V, a sine or square
wave will have equal positive and negative peak voltages.

7.8.1.2  Sweep controls
The signal generator normally generates a fixed frequency set by the Start Frequency
Control. In sweep mode, it generates a frequency that varies between two specified
limits.

Sweep Mode Active

Sweep Type Up |E|

Stop Frequency 2 kHz =

Frequency Increment 10 Hz |§|

Increment Time Interval 1 ms |§|
Active. Tick this box to enable sweep mode.
Sweep Type. Specifies the direction in which the frequency is swept.
Stop Frequency. In sweep mode, the generator stops increasing the frequency when
it reaches the Stop Frequency.
Frequency Increment. In sweep mode, the generator increases or decreases the
frequency by this amount every Increment Time Interval.
Increment Time Interval. In sweep mode, the generator increases or decreases the
frequency by Frequency Increment each time this interval ends.

7.8.1.3  Trigger controls

The signal generator normally runs continually. If you enable triggering, the signal
generator waits for a specified event before generating an output.

Triggers Active
Trigger Source Scope |:|
Type Rising |E|
Cycles Per Trigger 1 |§|
Threshold

Manual Trigger

Active. Tick this box to enable signal generator triggering.

Trigger Source. Specifies the signal that will be used to trigger the signal generator:
Scope. The same trigger condition that triggers the scope.
Manual. The Trigger Now button.
Ext Input. The input marked EXT (if fitted) on the scope device.

An Alarm can also be made to trigger the signal generator. This operation is
configured in the Alarms dialog.

Type. The condition that must be met by the trigger signal:
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Rising. The signal generator starts running when the trigger signal goes from low to
high.

Falling. The signal generator starts running when the trigger signal goes from high
to low.

Gate High. The signal generator runs whenever the trigger signal is high.

Gate Low.The signal generator runs whenever the trigger signal is high.

Cycles per Trigger. The number of cycles of the specified waveform to generate each
time the generator is triggered. If the trigger Type is Gate High or Gate Low, the
generator will stop when the gate signal goes inactive even if the requested number of
cycles has not been generated.

Threshold. Available only when Trigger Source is Ext Input. Sets the voltage level
used to distinguish between the high and low states of the trigger signal.

Manual Trigger. Available only when Trigger Source is Manual. Triggers the signal
generator to produce the specified number of cycles (or sweeps, if the signal generator
is in sweep mode).
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7.82  Signal Generator dialog (USB DrDAQ)

Location:

Signal Generator button M on the USB DrDAQ Channels toolbar

Purpose: controls the USB DrDAQ's built-in signal generator

Signal Generator b 4

Amplitude (Peak) | 4

Offset ov

[+] Signal On Sine [v]
| Arbitrary... |
Frequency 1 kHz

[H I E)

Signal generator dialog
for the USB DrDAQ

Basic controls

Sine |z|
| Arbitrary... |
1 kHz |§|
1y E
ov E

Signal On. Tick this box to enable the signal generator.
Signal Type. Select the shape of the waveform to be generated.

Arbitrary. Opens the Arbitrary Waveform window, allowing you to
define your own waveform shape.

Frequency. Type in this box or use the spin buttons to select
the frequency of the output waveform.

Amplitude. The amplitude of the waveform measured from peak

to peak. For example, if Amplitude is 1 V and Offset is 0 V, the

output will have a negative peak of -0.5 V and a positive peak of
+0.5 V.

Offset. The mean value of the signal. For example, when Offset
is 0 V, a sine or square wave will have equal positive and
negative peak voltages.
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7.8.3  Arbitrary waveform files

Some PicoScope PC Oscilloscopes have an arbitrary waveform generator (AWG), which
is enabled using the Signal Generator dialog. PicoScope can program the AWG with a
standard waveform, such as a sine or square wave, or an arbitrary waveform that you
create or import from a text file.

A text file for PicoScope 6 is a list of decimal floating-point values, as in this example:

m 1.0
K

0.6

0.4

n.z

n.a
-0.3 -0.2

0.0 040
02-01-0001 020304050607 08

m=

The file may have between 10 and 8,192 values, as many it needs to define the
waveform. Each line may have more than one value, in which case the values must be
separated by tabs or commas.

The values are samples between -1.0 and +1.0 and must be equally spaced in time.
The output is scaled to the amplitude selected in the Signal Generator dialog. and the
selected offset is added if necessary. For example, if the signal generator amplitude is
set to 1 V and the offset to 0 V, then a sample value of -1.0 corresponds to an output
of -1.0 V and a sample of +1.0 corresponds to an output of +1.0 V.

The file should contain exactly one cycle of the waveform, which will then be played
back at the speed specified in the Signal Generator dialog. In the example above, the
signal generator was set to 1 kHz, so one cycle of the waveform lasts for 1 ms. There
are 10 samples in the waveform, so each sample lasts for 0.1 ms.
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7.8.4  Arbitrary Waveform Generator window
Location: Signal Generator dialog > Arbitrary

Purpose: allows you to import, edit, draw and export arbitrary waveforms to load
into your scope's arbitrary waveform generator. You can also import and
export the data in CSV format for use in other applications.

Arbitrary Waveform Generator - B
FRE B /] Semples 320 | G © & | pPico
'-|_| f\_’ /\J /I R rLl Cycles Min Max Duty Cycle

il

+ M NN

-1

Cursor at: 0,992, 2389 | ok || cancet | [ appwy | [ Hen |

Once the desired waveform appears in the window, click OK or Apply to start using it.
Toolbar buttons
=4 Import from channel. Opens the Import from Channel

dialog, which lets you copy a waveform from the scope into
the arbitrary waveform window.

Er Import. Displays an Open dialog to allow you to import an
arbitrary waveform from a text file.

5us] Export. Displays a Save As dialog to allow you to save the
arbitrary waveform as a text file.

Freehand drawing. Enters freehand drawing mode. in which
you can draw any waveform shape using the mouse.

7 Straight-line drawing. Enters straight line mode, in which
you can click on the waveform to draw a straight line from
the previous point. To start a new series of lines, click the
button again.
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1024 =3 Samples. The number of samples in the arbitrary waveform.
_ Each sample represents the signal value at a given instant in
time, and the samples are equally spaced in time. For
example, if there are 1024 samples and the arbitrary
waveform generator is set to play back at 1 kHz, then each
sample represents (1/1 kHz + 1024) or about 0.98
microseconds.

Samples

il Bit stream. Draws a sequence of bits according to binary or
hex data that you specify. The logic high and low levels are
adjustable.

Clear. Deletes the arbitrary waveform.

Normalize. Adjusts the waveform vertically so that it
occupies the full [-1,+1] range.

=1

Wy Undo and Redo. The Undo button reverses the last change
made to the arbitrary waveform. The Redo button reverses
the last action of the Undo button.

& G & Zoom tools. To zoom the time axis in or out, click the + or -
zoom button and then click on the waveform area. Click the
100% button to restore the time axis to its original scale.

Waveform settings

MLl A LA L Standard waveform shapes. Draw a standard waveform
with the settings specified in the numerical controls below
the toolbar. The current waveform will be erased.

Cycles 2 = Cycles. The number of cycles to draw. This control is used
o in conjunction with the Standard waveform shapes
buttons. Select one of the standard waveform shapes and
then enter the number of cycles, and PicoScope will draw
the requested number of cycles of the waveform.

Minimum. When one of the Standard waveform shapes
buttons is pressed, this control sets the minimum signal
level.

Min | -1.00

([

Maximum. When one of the Standard waveform shapes
buttons is pressed, this control sets the maximum signal
level.

Max | 0.99

([

Duty Cycle| 50 %% (= Duty cycle. When a square, triangular or ramp waveform is
o selected using one of the Standard waveform shapes

buttons, this control sets the duty cycle of the signal. Duty
cycle is defined as the time that the signal spends above
zero volts divided by the total cycle time. Thus, a
symmetrical square or triangular wave has a duty cycle of
50%. Reducing the duty cycle shortens the positive part of
the cycle and lengthens the negative part, and increasing
the duty cycle does the opposite.
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Other buttons

OK Copies the waveform from the graphical editor into the
arbitrary waveform generator and returns to the main

PicoScope window.

Apply Copies the waveform from the graphical editor into the
arbitrary waveform generator and remains in the Arbitrary
Waveform Generator window.
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7.8.4.1  Importfrom a Channel dialog

Location:
ocation: Arbitrary Waveform window > Import from a Channel button ( © )
p ) allows you to copy captured data from a scope channel to the Arbitrary
urpose: ;
Waveform window
Import from a Channel H
Select Channel m A [~] [ ok |
|f Cancel |
select Samples D
) _ _ | Help |
() between samples 1 = 6255 | ‘ }

I_J) between Time rulers

Mumber of samples on channel A : 12504

Dretails

Samples being imported: 6254
AWG limit: 4096

Data Resampled.

Select Channel: You can import the latest waveform from any available channel.

Select Samples: By default, the entire capture is imported. This control allows you
to specify a subset of the capture, either between specified
sample numbers or between rulers. The subset will be scaled to fit
the number of samples specified in the Samples control in the
Arbitrary Waveform window.
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7.8.5  Demo Signals menu

Location: start PicoScope with no scope connected
» Connect Device dialog
) select demo device

N

» Signal Generator button

Purpose: allows you to set up test signals so that you can experiment with
PicoScope when no scope device is connected

When you click the Signal Generator button b , a drop-down list of all the available
channels in the demo device appears, like this:

A | Sine 1kHz |z|
B | Sine 1.01kHz [v]
C | Triangle 1.02 kHz IEI

D | Ramp Up 1.03 kHz |z|

Click one of the channels to open the Demo Signals dialog, which will allow you to set
up a signal from that channel.
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7.8.6  Demo Signals dialog
Location: start PicoScope with no scope device plugged in
» Connect Device dialog
» select DEMO device

]

» Signal Generator button (
s select channel

Purpose: controls one channel of the demo signal source, a feature of PicoScope
that creates a variety of test signals to simulate a scope device.

Signal On Sine [v]
(Avbiteary.. )

Frequency 1kHz —

Amplitude soomv

Offset oV E
Signal On: Tick this box to enable the demo signal source.
Sine [~] Signal type: Select from a list of standard signal types.
[W] Arbitrary Waveform: Open the Arbitrary Waveform Editor.
1 kHz = Frequency: Type your desired frequency in hertz, or use the spin

buttons.

Amplitude: Type your desired amplitude in volts, or use the spin
buttons.

800 mY =

!

Offset: Enter a number to add a d.c. offset to the demo signal. By
default, the demo signals have a mean value of zero volts.

=
=z
[
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7.9 Start / Stop toolbar

The Start / Stop toolbar allows you to start and stop the scope device. Click
anywhere on the toolbar, or press the start/stop key on the keyboard (by default, the

space bar), to start or stop sampling.

[FEX

O Start icon. Highlighted if the oscilloscope is sampling.

(=] Stop icon. Highlighted if the oscilloscope is stopped.

This toolbar normally resides at the bottom of the program window, but can be moved
to the top using the Tools > Preferences > Options > Bottom toolbar at top

control.

psw.en r39 Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.



PicoScope 6 User's Guide

151

7.10  Triggering toolbar

The Triggering toolbar tells the scope device when to start capturing data. See also:

Trigger.
Trigger Rapid

Auko |E|

Fa

(v]

| A o] |[ugg] % | [ov B e B | e[ 10 5

Trigger Mode. The list of available modes varies depending on the
type of scope device in use.

None: PicoScope acquires waveforms repeatedly without waiting for
a signal to trigger on.

Auto: PicoScope waits for a trigger event before capturing data. If
there is no trigger event within a reasonable time, it captures data
anyway. It repeats this process until you click the Stop button.
Auto mode does not set the trigger level automatically.

Repeat: PicoScope waits indefinitely for a trigger event before
displaying data. It repeats this process until you click the Stop
button. If there is no trigger event, PicoScope displays nothing.

Single: PicoScope waits once for a trigger event, then stops
sampling. To make PicoScope repeat this process, click the Start
button. The Single trigger is the only type that allows one capture
to fill the entire buffer memory.

Rapid: PicoScope instructs the scope device to acquire a sequence
of waveforms with the minimum possible delay between them. The
display is not updated until the last waveform in the sequence has
been captured. When the operation is finished, you can step through
the waveforms using the Buffer Navigation toolbar.

Note: rapid triggering is available only on certain devices (see device
feature table) and on the fastest timebases.

ETS: Equivalent Time Sampling. PicoScope captures many cycles of
a repetitive signal, then combines the results to produce a single
waveform with higher time-resolution than is possible with a single
capture. For accurate results, the signal must be perfectly repetitive
and the trigger must be stable. ETS is not available on mixed-signal
oscilloscopes when digital channels are enabled.

If you select ETS when an Advanced Trigger type is enabled, the
trigger type will revert to Simple Edge and the Advanced
Triggering button will be disabled.

Advanced Triggering. Click to open the Advanced Triggering dialog,
which gives you extra trigger types beyond the simple edge trigger.
If this button is disabled, it is because either None or ETS is
selected in the trigger mode control, or your scope device does not
support this mode. To enable the Advanced Triggering button, set
the control to another trigger mode, such as Auto, Repeat or
Single.

Trigger Source. This is the channel that PicoScope monitors for
the trigger condition.

Rising Edge. Click to trigger on the rising edge of the waveform.
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Y Falling Edge. Click to trigger on the falling edge of the waveform.
20 = Trigger Level. Sets the trigger level. You can also set the trigger

level by dragging the trigger marker up or down on the screen.

E0%. == Pre-trigger Time (0% to 100%). This parameter controls how much
- of the waveform appears before the trigger point. It defaults to 50%
, Which puts the trigger marker in the middle of the screen. You can
also control this parameter by dragging the trigger marker to the left
or right.

b Post-trigger Delay Enable. Click this button to toggle the Post-
trigger Delay control (see next item).

|2|:| us |$|| Post-trigger Delay. The post-trigger delay is the time that
PicoScope waits after the trigger point before sampling. You can also
modify this parameter by dragging the trigger marker while the Post-
trigger Delay button is enabled. As you drag the marker, you will
see the post-trigger arrow displayed briefly. For this control to have
an effect, you must first make sure that the Post-trigger Delay
button is enabled.

See the reference topic Trigger Timing for information on how the
Pre-trigger Time and Post-trigger Delay controls interact.

- 10 = Rapid Captures. In Rapid trigger mode, this is the number of
_ waveforms to capture in a sequence. They will be captured with the
minimum possible dead time between them.

This toolbar normally resides at the bottom of the program window, but can be moved
to the top using the Move Trigger toolbar to top control in Tools > Preferences >

Options.
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7.10.1  Advanced Triggering dialog

- . '
Location: Triggering toolbar > Advanced Triggering button ( - )

Purpose: allows you to set up more complex trigger types than simple edge-
triggering

© simple Edge Saurce A |E| Threshald ov |§|

_§  Advanced Edge

Direction Rising []
L Window
L Pulse Width
R Interval
L Window Pulse Width
UM Level Dropout
UL, Window Dropout
ﬂ_mﬂ Runt
P Digital o
e
i Logic
Rising
| Help | | Close |
§ simple Edge Advanced trigger types list. This control lists
all the available advanced trigger types. Click
_f Advanced Edge on the condition you require, and a diagram and
16— Windo _ glfaasig;lptlon will appear on the right of the
i .

If ETS triggering is enabled in the triggering
toolbar, the trigger type will be set to Simple

Edge.

Advanced triggering options. The options
available depend on the trigger type selected.
See Advanced trigger types. Instructions and
diagrams also appear in the dialog.

Source .Y

Direction Rising

’#‘WIML
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7.10.2  Advanced trigger types

The advanced trigger types can be switched on in the Advanced Triggering dialog.

For all trigger types except Digital, the first step is to select which signal the scope
should use as the trigger; so set Source to either A, B, Ext or AuxIO. These names
correspond to the BNC input connectors on the scope device. Then choose one of the
trigger types below.

5

Simple Edge. This type provides the same Rising and Falling edge triggers that
are available from the Triggering toolbar. It is included in this dialog as an
alternative method of setting up the Simple Edge trigger.

You can set the trigger Threshold while in the advanced triggering dialog, or
alternatively you can drag the Trigger marker on the scope view.

This is the only trigger type that is compatible with ETS mode.

Advanced Edge. This trigger type adds an extra Rising or Falling edge trigger,
and Hysteresis, to the Simple Edge trigger. The Rising or Falling option
triggers on both edges of a waveform, and is useful for monitoring pulses of both
polarities at once. Hysteresis is described in a separate topic.

Window. This trigger type detects when the signal enters or leaves a specified
voltage window. The Direction control specifies whether the trigger should
detect the signal entering the window, leaving it, or both. Threshold 1 and
Threshold 2 are the upper and lower voltage limits of the window. The order in
which you specify the two voltages does not matter. Hysteresis can be set to
reduce the number of false triggers on a noisy signal, and is described in a
separate topic.

Pulse Width. This trigger type detects pulses of a specified width.

First set the Pulse Direction to either Positive or Negative according to the
polarity of the pulse you are interested in.

Next, set one of the four Condition options:
Greater than triggers on pulses wider than the specified time.

Less than triggers on pulses that are narrower (useful for finding
glitches).

Inside time range triggers on pulses that are wider than Time 1 but no
wider than Time 2 (useful for finding pulses that meet a specification).

Outside time range does the opposite: it triggers on pulses that are
either narrower than Time 1 or wider than Time 2 (useful for finding
pulses that violate a specification).

Next, set the trigger Threshold in volts or other units, or drag the Trigger
marker on the scope view.

Finally, set up Time 1 (and Time 2 if present) to define the pulse width.
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i

Interval. This type lets you search for two successive edges of the same
polarity that are separated by a specified interval of time.

First, set the Starting edge to either Rising or Falling according to the polarity
of the edges you are interested in.

Next, select one of the four Condition options:

Greater than triggers when the second edge occurs later than Time 1
after the first edge (useful for detecting missing events).

Less than triggers when the second edge occurs earlier than Time 1
after the first edge (useful for detecting timing violations and spurious
edges).

Inside time range triggers when the second edge is later than Time 1
after the first edge and earlier than Time 2 (useful for finding valid
edges).

Outside time range triggers when the second edge is earlier than
Time 1 after the first edge or later than Time 2 (useful for finding
spurious edges).

Finally, set up Time 1 (and Time 2 if present) to define the time interval.

Window pulse width. This is a combination of the window trigger and the pulse
width trigger. It detects when the signal enters or leaves a voltage range for a
specified period of time.

Level dropout. This detects an edge followed by a specified time with no
edges. It is useful for triggering on the end of a pulse train.

Window dropout. This is a combination of the window trigger and the dropout
trigger. It detects when the signal enters a specified voltage range and stays
there for a specified time. This is useful for detecting when a signal gets stuck
at a particular voltage.

Runt. Detects a pulse that crosses one threshold and then falls below the same
threshold, without crossing the second threshold. This is typically used for
finding pulses that fail to reach a valid logic level.

Digital. (MSO devices only) Triggers on a combination of the state of the digital
inputs and a transition (edge) on one digital input. See Digital trigger.

Logic. This detects a logical combination of the scope's inputs. The conditions
that can be applied to each input vary: analog inputs can be edge-, level- or
window-qualified; EXT and D15...DO0 (if present) are level-qualified with a
variable threshold; and AUXIO is level-qualified with a fixed TTL threshold. See

Logic trigger.
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7.10.2.1

Hysteresis

Hysteresis is a feature of the advanced trigger types in PicoScope 6 that reduces
false triggering on noisy signals. When hysteresis is enabled, a second trigger threshold
voltage is used in addition to the main trigger threshold. The trigger fires only when the
signal crosses the two thresholds in the correct order. The first threshold arms the
trigger, and the second causes it to fire. An example will help to illustrate how this
works.

E4T 2
m

1161
-149.5
-415.0

-650.5
-286.1 -106.3 7315 2328 4324 p=s G120

Noisy signal with a single threshold

Consider the very noisy signal above. It is difficult to trigger reliably on this signal with
a normal rising edge trigger because it crosses the trigger threshold, the red line in this
picture, several times in one cycle. If we zoom in on the highlighted parts of the signal,
we will see how hysteresis can help.

3377 o 3T
m M i \-I"r-h\‘

2202 3 2202 .L:.—-

161.4 1&_? 161 .4 "'1 5

1025 2 1026

4383 J; 4383 u_hhi

-238 88971 5853 2065 355 35033 1830 1978 2127 2275 2423 2571

Noisy signal with hysteresis threshold

In these zoomed-in views, the original threshold is the lower red line. The upper red line
is the second threshold used by the hysteresis trigger.

The signal rises across the lower threshold at (1) and (2), arming the trigger but not

firing it. At (3) the signal finally crosses the upper threshold, firing the trigger. On the
falling edge of the signal, at (4) and (5), rising edges of noise pulses cause the signal
to cross the upper and lower thresholds, but in the wrong order, so the trigger is not
armed and does not fire. Thus the trigger occurs at only one well-defined point in the
cycle (3), despite the noise on the signal.

Hysteresis is enabled by default for all the advanced trigger types. The Hysteresis
controls in the Advanced triggering dialog let you change the hysteresis voltage as a

percentage of full scale. The trigger marker é? shows the size of the hysteresis window.
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7.10.2.2 Digital trigger dialog

Location:

Purpose:

I, il
Advanced triggering dialog > Digital ==+ and Logic “— buttons

sets up triggering on digital inputs

Applicability: MSO devices only

_§ Simple Edge

i Advanced Edge

e Window

e Pulse Width

LM Interval

L Window Pulse Width
UL, Level Dropout

U, Window Dropout

] Runt

— Logic

Pattern table

\- w | I T £I% ||?‘|/1

Set Trigger Pattern :\
o RN
s | [ £

1|
¥ |

: | ":" =3 " % I Pattern
¥ |

=)

O

|_||:||5|| table
3 i B F 3

8 [~ [+
i [~ [£[%]

=

(m]

j=]

b=

-

Binary 1000000 Pattern
D7 Do summary

Trigger when the channel levels of all the selected channels agree with the
chosen pattern at the same time,

| Help | | Close

Lists all available inputs as selected in the Digital Setup dialog. Each one can be
monitored for a low or high level or a rising or falling edge, or ignored. Any number of
levels can be specified, but no more than one transition (edge).

Pattern summary

D7 = X (don't care)
D7 =0 (low level)
D7 =1 (high level)
D7 =R (rising edge)
D7 = F (falling edge)

This section contains the same settings as the pattern table but in a more concise

format.
Binary
RN 10 103X

D15 1]

The numerical format to use for this section: Binary or
Hex(adecimal).
The complete triggering pattern and transition. In
Binary mode the bits are labeled as follows:

X = don't care

0 =binary 0

1 =binary 1

R = rising edge

F = falling edge
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7.10.2.3 Logictrigger dialog

Location: =
Advanced triggering dialog > “~= Logic button
Purpose: sets up triggering on a combination of inputs

Applicability: all devices with more than one active input

_§  Simple Edge

_§  Advanced Edge

L Window

e Pulse Width

R Interval

L Window Pulse Width
TN, Level Dropout

T, Window Dropout

Nml] Runt

ZEX Digital
)

=

Input controls

A I B l Dig'rtall Logic
O Level (=) window Used (%) AND
™ () NAND
Direction Insid e _ .
nside hd O or Logltc |
Ex - contro
Threshold1 | OV = ) NOR
Threshold2 OV B ) ¥oR
Hysteresis 150% ) ~) XNOR
Input
controls

Trigger when the signal levels of all the selected channels agree with the
chosen logic condition at the same time.

| Help | | Close

There is a set of controls for each active input of the oscilloscope. The selection of
inputs depends on the model of oscilloscope in use. The selection of controls
(thresholds, hysteresis, window mode and so on) for each input also depends on the
hardware capabilities of the oscilloscope.

Used

Channel A
Channel B
Channel C
Channel D

EXT input (if present)

AUX input (if present)

Digital inputs (mixed-signal oscilloscopes only). The controls
here are the same as those in the Digital Trigger dialog.
Check this box to include the relevant input in the Logic
Trigger condition. If the box is not checked, the input will be
ignored by the Logic Trigger.

psw.en r39
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Logic control

Logic Specifies the Boolean operation used to combine the input
trigger conditions. Only inputs with the Used box checked (see
above) are included in the trigger logic.

+§EED AND: all of the input trigger conditions must be met

- NAND: none of the input trigger conditions must be met
[_JOR . . e

) NOR OR: one or more of the input trigger conditions must be
() XOR net

) XNOR NOR: none of the input trigger conditions must be met

- XOR: an odd number of input trigger conditions must be met
XNOR: an even number of the input trigger conditions must be
met
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711 Zooming and Scrolling toolbar

The Zooming and Scrolling toolbar allows you to move around a scope view or
spectrum view. Each button has a keyboard shortcut, as listed below.

YWEFEEIE

Y Ctrl+S Normal Selection tool. Restores the pointer to its normal
or appearance. You can use this pointer to click buttons, drag rulers and
Esc operate any other controls in the PicoScope window.

& Ctrl+D  Hand tool. Turns the pointer into a hand (@) that you can use to

click and drag the view to pan it vertically and horizontally when you
are zoomed in. You can also pan using the scroll bars. Press the Esc
key to return to the Normal Selection tool.

a Ctrl+M Marquee Zoom tool. This button turns the pointer into a marquee

zoom tool: &, Use it to draw a box (called a marquee) on the view
and PicoScope will magnify that box to fill the view. Scroll bars will
appear, which you can drag to pan around in the view, or you can
pan by using the Hand tool (see above). Zooming in also opens the
Zoom Overview window. Press the Esc key to return to the Normal
Selection tool.

If you point to the time axis, the pointer changes into the horizontal

marquee zoom tool (ﬁ), which restricts zooming to the horizontal
axis. This lets you zoom in by an arbitrary amount without disturbing
the vertical zoom factor.

Holding down the Ctrl key while dragging also restricts zooming to the
horizontal axis.

& Ctri+I Zoom-in tool. Turns the pointer into a zoom-in tool: gﬁ Click on the

view with this tool to zoom in to the specified location. Zooming in
also opens the Zoom Overview window.

If you point to the time axis, the pointer changes into the horizontal

zoom-in tool (@), which restricts zooming to the horizontal axis. This
lets you zoom in without disturbing the vertical zoom factor.

Holding down the Ctrl key while dragging also restricts zooming to the
horizontal axis.

Holding down the Shift key while dragging changes the zoom mode to
'zoom out'.

S Ctrl+0  zoom-out tool. Turns the pointer into a zoom-out tool: ﬁ. Click on

the view with this tool to zoom out around the specified location.

If you point to the time axis, the pointer changes into the horizontal

zoom-out tool (5»:%), which restricts zooming to the horizontal axis.
This lets you zoom out without disturbing the vertical zoom factor.

Holding down the Ctrl key while dragging also restricts zooming to the
horizontal axis.
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Holding down the Shift key while dragging changes the zoom mode to
'zoom in'.

1) Undo zoom. Returns the view to the previous zoom and pan settings.

& Ctrl+U Zoom to full view. Resets the view to normal size. The view will no
longer have scroll bars, and panning will no longer be possible.

7.11.1  Zoom Overview

Whenever you zoom in using the Zooming and Scrolling toolbar, the Zoom Overview
window should appear*:

The Zoom Overview shows the full waveforms on all enabled
channels. The rectangle indicates the area that is visible in the
current view.

I
You can move around the waveform by dragging the rectangle.
I
You can also adjust the zoom factor by dragging the edges of
the rectangle to resize it.
I

Minimize button: reduce the Zoom Overview window in size
RJ without affecting the zoom settings.

Close button: close the Zoom Overview window and return
_[% the zoom factor to 100%.

*Note: if the Zoom Overview does not appear, the feature may have been switched
off. Check the Zoom Overview option in Tools > Preferences > Options.
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8 How to...

This chapter explains how to perform some common tasks.

8.1 How to change to a different device

Unplug the old device.

Cancel the Check USB cable dialog.

Plug in the new device.

PicoScope will detect the new device and begin to use it. If more than one device is
connected, PicoScope will ask you which one to use.
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8.2 How to use rulers to measure a signal
Using a single ruler for signal-to-ground measurements

» Look at the Channels toolbar to find the color code for the channel you wish to
measure:

Ay | Auto DC | '

» Find the ruler handle (the small colored square in the top-left or top-right corner of
the scope view or spectrum view) of this color:

V=TI

» Drag the ruler handle downwards. A signal ruler (horizontal broken line) will appear
across the view. Release the ruler handle when the ruler is where you want it.

» Look at the ruler legend (the small table that appears on the view). It should have a
row marked by a small colored square matching the color of your ruler handle. The
first column shows the signal level of the ruler.

256.0mY —— ——

Using two rulers for differential measurements

» Follow the steps above for using a single ruler.

» Drag the second ruler handle of the same color downwards until its ruler is at the
signal level to be measured.

» Look at the ruler legend again. The second column now shows the signal level of the
second ruler, and the third column shows the difference between the two rulers.

SEE.0mY -433.0m" 1.079%
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8.3 How to measure a time difference
» Find the time ruler handle (the small white square in the bottom left corner of the

scope view).
0.8 \\-._/;
Time ruler
handle -izn.ﬁ 20
ms
Running '@ O | Trigger Auto |E|

» Drag the ruler handle to the right. A time ruler (vertical broken line) will appear on
the scope view. Release the ruler handle when the ruler is at the time you wish to
use as the reference.

YN
| \
|
lL Cursor changes

s «|—»’WE_- - — when dragging
the handle

» Drag the second white ruler handle to the right until its ruler is at the time to be
measured.

» Look at the ruler legend (the small table that appears on the scope view). It should
have a row marked by a small white square. The first two columns show the times of
the two rulers, and the third column shows the time difference.

O -129.0ps 4410 ps 850 s

» The frequency legend shows 1/A, where A is the time difference.

| 3337 Hz, 2002.0 RPhd

You can use a similar method to measure a frequency difference on a spectrum view.
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8.4

How to move a view

You can easily drag a view from one viewport to another. This example shows four view
ports, which contain scope views called Scope 1 to Scope 4. Suppose that you wish
to move the Scope 4 view to the top left view port.

Yy PicoScope & = E'“
File Edit Views Measurements Tools Help
A 0y | 2 @] [sopa] | ][ o H | 2oz L @[RMNARS D Klico
Ag lauto  []loc ][ By on  [v] | ca o & Do ~J w

scope 1 sapez |

n w0

) ‘A \/\
A\ f’/

0
25 20 15 10 05 00 05 10 15
EEl

®
20 25

J\ffw

54D51005n035 DTS/_Dlj

Scope 3
CIRE 0

VY

~,
Scoped %{
10

\/\J f\/ \

A E °
725 20 -15 -0 05 00 05 w15 20 25 25 20 15 -0 05 00 05 10 w0 25
=,
o nguc\wg o D] a0 D\ 0% G Messarements &3
N PicoScape 6 -cIEH
Fle Edit Views M ents  Tools Help
Y- a Fjws FH 4l 2oz [DoRNAAS ) ]ico
A Cloc )] aglor [ |calon [ Dy 2] yl -
scope 1 \> Sopez |
s 10 %3 " o
E e
20 s 15 a5 o0 a5 0 35 2 2 s 20 15 b o5 oo us 1 15 20 o8
e, s
sco Soped |
. "o
W
m \ / \
E o
20 415 40 05 00 05 10 15 20 25 -\25 20 15 40 05 00 05 10 15 20 l.i
Em
Runrin g.o\m, o D] a Ol |[2 mvm\ EEEE) Messurements &3
N PicoScape 6 -cIEH
Ele Edit Views Messurements Tools Help
:|Jldn \}@ soopyand) | 1 [=|[00ks (5] 4] sear D

| co [or

Slico
o w O] ) -

sorez |

(A

zs 20 5 0 05 0D 05 10 15 20 z.:

Jxﬂf\ \

20 -5 40 05 00 05 10 15
m

20 zs

Running .Q\T,W, Auto

[~ 2] [a

1 | [ 2002 mv | [50%

R Messuremer

1. Click on the name tab of the Scope 4
view and hold the mouse button down.

h—

v Fal

Scope 4
m 10

2. Drag the mouse pointer to the new
location next to the name tab of the
Scope 1 view.

Scope 1

e

v Ia}

3. Release the mouse button, and the
view will move to the new location.

( Scope 1 f Scope 4 [:g

m 10
v i
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8.5

How to scale and offset a signal

PicoScope offers several ways to change the size and position of a signal during or
after capture. These methods apply equally to scope views and spectrum views. They
do not change the stored data, only the way in which it is displayed. These options are
provided in addition to the analog offset capability of some scopes (see Device feature

table).

Global zooming and scrolling

This is usually the quickest way to get a closer look at the fine detail on your signals.
The global zooming and scrolling tools move all the signals at once and are found on
the zooming and scrolling toolbar.

When a view is zoomed in, it has vertical and horizontal scroll bars that let you move
the signals around as a group. You can also use the hand tool to scroll around the
graph.

Auto-arrange axes

Right-click the scope or spectrum view and select Auto-arrange axes:

Add View 3
Channels »
K-l 3
Grid Layout [

Auto-arrange axes L}
Reset View Layout

View Properties
@ Reference Waveforms  »
Ed Add Measurement
PicoScope automatically scales and offsets the channels to make them fit on the view

without overlapping. This is the quickest way to tidy up the scope view:

- ol v PicoScope 6 - olEd
| Ele £t Views ]

Bla_cae Dodnassalico

odlraassalico
> o &oc &[]

& oc ] o [ oc [ Mg

. /\/\ ™\ / A
f / \
Y / o \/
- ) \ J u L J L
—> |
00 / \ \ ] A A A A
2 oz / \ = \\_\ / > \ / : N\ /o
. \ \/
o i
. o
Stopped @) Trgger [Nore [2) 17| T 7] stopped_ @ @) Trigger Mene (-] | Measurements 7]

psw.en r39

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.




PicoScope 6 User's Guide 167

Axis scaling and offset

Use these tools if Auto-arrange axes (see above) does not give you the results you
want. It allows you to position channels individually on the view (unlike the global
zooming and scrolling tools, which are applied to all of the channels at the same time).

Click the scaling button at the bottom of the axis you wish to modify, and the axis
scaling controls will appear. To adjust the offset without using the axis scaling controls,
click on the vertical axis and drag it up or down.

How is this different from scaling my data with a Custom Probe?

| Mew Probe.. |

You can create a Custom Probe to apply scaling to the raw data. A Custom Probe may
change the scale and position of data on the graph but it has a few important
differences from the other scaling methods.

Custom Probe scaling is a permanent transformation. The scaling is applied when the
waveform is captured and cannot be changed afterwards.

The actual data values themselves are changed, so the graph axes may no longer
display the original voltage range of the device.

Custom Probe scaling can be nonlinear and so may alter the shape of the signal.

Custom Probes are useful when you want to represent the characteristics of a physical
probe or transducer that you plug into your scope device. All of the zooming, scrolling,
scaling and offset tools still apply to data that has been scaled with a Custom Probe in
exactly the same way that they would apply to the raw data.
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8.6

How to set up the spectrum view
Creating a spectrum view

First, ensure that the trigger mode is not set to ETS, as it is not possible to open a
spectrum view in ETS trigger mode.

There are three ways to open a spectrum view:

Click the Spectrum Mode button in the Capture Setup toolbar. We recommend
using this method to get the best spectrum analysis performance from your scope.
Once in Spectrum Mode, you can still open a scope view to see your data in the
time domain, but PicoScope optimizes the settings for the spectrum view.

Go to the Views menu select Add view, then select Spectrum.

File  Edit VYiews Measurements Tools Help

Add View L Scope
Sub View » Spectrum
Rename Yiew Wy

Cloze View

Channels »

K-Pois 3

Grid Layout 2

Arrange Grid Layout

Beset View Sizes
Move View To »

Arrange Views

Auto-arrange axes

Reset View Layout
View Properties
This method opens a spectrum view in the currently selected mode, whether this is

Scope Mode or Spectrum Mode. For best results, we recommend that you switch to
Spectrum Mode, as described in the method immediately above.

Right-click on any view, select Add view, then select Spectrum. The menu is
similar to the Views menu shown above.

Configuring the spectrum view

See Spectrum Settings dialog.

Selecting the source data

PicoScope can produce a spectrum view based on either live or stored data. If
PicoScope is running (the Start button is pressed in), the spectrum view represents live
data. Otherwise, with PicoScope stopped (the Stop button pressed in), the view
represents data stored in the currently selected page of the waveform buffer. When
PicoScope is stopped, you can use the buffer controls to scroll through the buffer and
the spectrum view will be recalculated from the waveform currently selected.
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8.7

How to find a glitch using persistence mode

Persistence mode helps you find rare events hidden in otherwise repetitive waveforms.

In normal scope mode, such an event may appear on the display for a fraction of a

second, too quickly for you to press the space bar to freeze it on the screen.

Persistence mode keeps the event on the display for a predetermined time, allowing you

to set up the trigger options to capture it more reliably.

Step-by-step guide

» Set up the scope to trigger on a repetitive waveform like the one below. We suspect
that there are occasional glitches but we can see nothing wrong yet, so we shall

use persistence mode to investigate.
Click the Persistence Mode button to continue.

Persistence Mode button

Uy PicoScope 6 - O

Filg Edit Views Measurements Tools Help

mﬁ_ﬂn| | 2 4] [50nssaiv [+] ]| 1 B 1ms  E||dl| 320132

4

Ay z2v  [v]| By o V]| cq o ]| D lor [v] | ng

|
W
20
15
12
0a
04
oo
0.4
-0
124

-323F 0 -AT3Y 0 2EEY 0 Y3V 1237 -T36B3 23630 2632 7632 1263
nz

176.3

Running @olTrigger Auto J'E| A |,§’ “‘$.\| 168 mv @|
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Our original scope view is replaced by a persistence view, as shown below.
Immediately, we can see three pulses with different shapes. At this point we have
the Saturation control in Persistence Options turned up to maximum to help us spot
the various waveforms easily.

“yp PicoScope 6 -

File Edit Views Tools Help |
(il | Ty | 2 184 | | 20 nssaiv [] | | x1 Bl €™ G & & 9 | &
Ay z2v  [v]| By oOfFf [v] | cy ot = [v] |

i e B e |

Running @ '..J | Trigger |Auto |E| Jf| A |E| | ATk | 1.8 mV/ % |
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Now that we have found some glitches, we will turn the Saturation control down to
minimum. Click the Persistence Options button to open the Persistence Options
dialog, and then use the slider to adjust the saturation. The display then appears as
below.

The waveforms are now darker but have a wider range of colors and shades. The
most frequently occurring waveform is shown in red, and is the normal shape of the
pulse. A second waveformis drawn in light blue to shows that it occurs less
frequently, and it shows us that there is an occasional jitter of about 10 ns in the
pulse width. The third waveform is drawn in dark blue because it occurs less
frequently than the other two, and indicates that there is an occasional runt pulse
about 300 mV lower in amplitude than normal.

Persistence Options button

g ‘ PicoScope 6 - O

File Edit |Views Tools Help |

Al | IR | 2 4] [20 nsyaiv [+] ] | x1 Bl Q& & 9 | &g
Ay z2v  [v]| By O [+ | cgof | Dy [v] | g

oL l1l___1___14

Running |G} @ | Trigger |Auto [v] J_'l':| A [v] | A h | 1mamv [ |
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» Persistence mode has done its job. We have found our glitches, and now we want to

examine them in more detail. The best way to do this is to switch back to normal
scope mode, so that we can use the advanced triggering and automatic
measurement functions built in to PicoScope.

Click the Scope Mode button. Set up an advanced pulse-width trigger to look for a
pulse wider than 60 ns. PicoScope then finds the runt pulse straight away.

iy PicoScope 6 = =
Eile Edit Views Measurements Tools Help |

ATl | e | 2 4% | 20 psvaiv [v] | | %1 B 1ms @”@ 311 of 211 8)”*{“?@.('\('\ &

Ay |Auto pc [v] | By o | co o | Do |J’l¥|-

m 0
'

CcCO

186

12

0.2

0.4

0.0

0.4

-0.8

-1.2

-16

204
-82.71 -68.71 -43.71 2871 87

1 11.29 3125 51.2% 71.29 91.2% M3

{m us
Running @ 0 | Trigger |Repeat ﬂfl | | | 44 % EI = | Measurements [z

We can now add automatic measurements or drag the rulers into place to analyze the
runt pulse in detail.
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8.8 How to set up a Mask Limit Test

1. Display a stable waveform in a scope view. Adjust the voltage range and timebase
so that the feature of interest fills most of the view. In this example, we are viewing a

repetitive pulse as might be found on a data bus.

o) PicaScope 6 = @
File Edit Views Measurements Tools Help
ALy 2 6| om0 B[[1ws Sl 2oz D OMTARSD(4] pico
Ay Ao [v]pc V] | By ot =] | cq ot ] | Da ] \W| .
m 20
v
16
12
08!
04
0.0,
04
08
-2
1.6
200 ®
04 0.2 0.0 02 04 06 0.8 10 12 14 16
Lo J
\ Running (G @ | rigger |Aute  [+] 18| (4 O gl s [lov B|[z0% EJ= | Measurements [ |

2. Select the Tools > Masks > Add Masks command.

™, Custom Probes..
¥  Maths Channels
@ Reference Waveforms
o

ons Serial Decoding

@ Alarms

1 Masks » Add Masks
=] Macro Recorder Clear Mask
E Preferences... Save Mask
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3. You should now be in the Mask Library dialog:

Mask Library

Channel |H A

ok |
Cancel |

Available Masks

Library
Y Apply |
Loaded

Generate |
Delete |

Import... |

Export... |

Channel A is selected by default. You can change this if you want to apply the mask

to a different channel.

4. Click the Generate button to open the Generate Mask dialog:

Mame  Mask of A
X Offset | 100ns [&[s1][4]
¥ Offset | 200 mV @

[ Generate | [ Cancel |

psw.en r39
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5. For now, accept the default settings and click Generate. Then click OK in the Mask
Library dialog to return to the scope view:

File Edit Views Measurements Tools Help
e[« E|[1es B[ 202 [ @NTA RS 0|9
Ay st [focld|eyon G| lfcufor O ifowor B M

|Test  |Failures | Value | Min Average | Cepture Count | Span

Mask Failures Pass O 32 Whole trace

stopped @|Q)] rrigger Alle Eflgs]lov B R0 (] Messurements D3] ruters

You now have a mask drawn around the original waveform.

6. PicoScope stops capturing when you enter the Mask Library dialog, so press the
space bar to restart. If any captured waveform fails to fit inside the mask, the

offending parts are drawn in a contrasting color. The Measurements table shows the
number of failures:

File Edit Views Measurements Tools Help
200 ns/div[ | B# =o= ) @[
Gaor O] il o

| Test | Failures | Value | Min | Average 5
Mask Failures Fail 73 - - - 6 Whole trace

Stopped @@ Trigger Auto it|[a L s | o EEEE S || Measurements 3] Rulers
S

7. You now have a functioning mask limit test. Please read the Mask Limit Test topic for
information on editing, importing and exporting masks. It is also possible to set up a
Mask Limit Test on a spectrum or XY view.

For further information on this feature, see: Mask Limit Testing.
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8.9

How to save on trigger

Save-on-trigger is just one of a number of functions that are possible with the Alarms
feature.

1. Set up PicoScope to display your waveform, and enable triggering:

‘)q PicoScope 6 - B
File Edit Views Measurements JTools Help |
g MLl |l | 2 43 (1 psraw (]| (=0 Elllos B4l ez AR l.'JiL‘()
Ay Ao [v]Dc [v] | By [off ] | cu [oft =] | D ] |JW| '
g
v
16
1.2,
08
04
0.0,
04
08
RS
16
200 @
-2.0 -1.0 0.0 10 20 30 40 50 6.0 70 80
o
| Running (@@ | Tigger Auto[v] 1| [ Mg lov  E|[2% &= Tt 1 | Ruters

2. Select the Tools > Alarms command:

Custom Probes...

Maths Channels
Reference Waveforms
Serial Decoding

Alarms

Masks »

Macro Recorder

Breferences...

should now be in the Alarms dialog:
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Event | Buffers Full |

4. Set Event to Capture:

Buffers Full
W] Capture

s [ | Buffers Full
[ Mask(s) Fail

5. Select the first item in the Actions list, click Edit, and change Action to Save

Current Buffer:
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Alarms

Event | Capture [T]
N (.. )

Alarm Action ]

Action  Beep

EBeep

Play Sound
Stop Capture
Restart Capture ]
Run Executable
Save Current Buffer |
Save All Buffers |
Trigger Signal Generator

Enable external code
4 execution

6. Click the [ button to the right of the File box and enter the name and location of

the file to save:

Alarms

Event | Capture 0K |
g eee—y

Apply |

Alarm Action ]

Action | Save Current Buffer

File =
Cancel |

Enable external code
4 execution

7. Ensure that both the Save Current Buffer check box and the Enable Alarm check

box are set:
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Alarms H

Event | Capture [T]
| Save Current Buffer [20140¢ [E]
o)
[ Hew |

Add |

Edit |

Enable external code
4 execution

7. Click OK. PicoScope will now save a file on every trigger event.

8. Switch off the alarm when you have finished using it, to avoid creating unwanted
files.
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8.10

How to create a link file

A link file is used by the Serial Decoding In Table view to convert numerical data to
text. This is useful for displaying decoded packets in a human-readable format.

1. In the Tools > Serial Decoding menu, enable serial decoding and select the
required serial protocol. In this example we shall use I°C. Ensure that the In Table
view is enabled.

2. PicoScope will show the decoded data in numeric format:

Export  Accumulate | View Link: |Mone [v|[+] Startfrom.. Filter Statistics | Search Refresh
B
Z Address(T) oD - - o 5558 ns 20071 s
3 Datz . . 0z 0 S431p TE0Ips (=
4 Dists - - 28 ] 106 ps 126.6ps
5 Data - - A3 ] 1576ps 1783 ps |=|
B E-l2C

2. To create a link file, begin by creating a blank template. Click + next to the Link

label in the Serial Data Table toolbar:

Export Accumulate | View |ink: |Mone [v|[+] Startfrom.. Filter Statistics | Search | Refresh  Clear

A
A Save As dialog will appear. Choose the Save As Type (.xlIs for Microsoft Excel
format, or .csv for comma-separated text format) and then save the link file to a
convenient place such as your Windows desktop.

. Open the link file with an appropriate text or spreadsheet editor, and add number/

string pairs appropriate to the target system:

Address Address Description Read/Write Read/Write Description Data bytes Data bytes Description Acknowledge Acknowledge Description
0D ModeReg

v
02 Play
"8 Stop
A3 Pause

In this example we have specified that the string 'ModeReg' will appear in place of
the value '0D' in the Address field, and so on. The numerical values are treated
literally, so if the View > Display Format control in the data window is set to Hex,
the link file must contain the string '0D' to match the hexadecimal value 0D. If the
View > Display Format control is changed to Decimal, for example, a new link file
containing decimal values will be required.

. Save the link file.

. Click Browse next to the Link label in the Serial Data Table toolbar:

EI:lIEl Start from...  Filter Statisticsl Search |Refresh Clear

=

Export Accumulate | View Link:
M

. An Open dialog will appear. Select the link file and click OK.
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7. PicoScope will now replace the numeric data with the text strings that you have
defined:

Serial Decoding

2 Agdresz(T) ModeReg a EEEEns 20T1ps

3 D=tz - - Plzy a B43ps T501ps =

4 D=tz - - Stop a 106 p= 1266 ps

5 D=tz - - Pzuzs Q 1576 1783

=
B B-12C
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9.1

9.1.1

Reference

This is where you can find detailed information on the operation of PicoScope.

Measurement types

The Edit Measurement dialog presents a selection of measurements that PicoScope can
calculate for the selected view.

Sco pe measurements

AC RMS. The root mean square (RMS) value of the waveform minus the DC Average.
It is equivalent to a ripple measurement.

Cycle Time. PicoScope will attempt to find a repeated pattern in the waveform and
measure the duration of one cycle.

DC Average. The mean value of the waveform.

Duty Cycle. The amount of time that a signal spends above its mean value, expressed
as a percentage of the signal period. A duty cycle of 50% means that the high time is
equal to the low time.

Falling Rate. The rate at which the signal level falls, in signal units per second. Click
the Advanced button in the Add Measurement or Edit Measurement dialog to
specify the signal level thresholds for the measurement.

Frequency. The number of cycles of the waveform per second.

Fall Time. The time the signal takes to fall from the upper threshold to the lower
threshold. Click the Advanced button in the Add Measurement or Edit
Measurement dialog to specify the signal level thresholds for the measurement.
High Pulse Width. The amount of time that the signal spends above its mean value.
Low Pulse Width. The amount of time that the signal spends below its mean value.
Maximum. The highest level reached by the signal.

Minimum. The lowest level reached by the signal.

Peak To Peak. The difference between maximum and minimum.

Rise Time. The time the signal takes to rise from the lower threshold to the upper
threshold. Click the Advanced button in the Add Measurement or Edit
Measurement dialog to specify the signal level thresholds for the measurement.
Rising Rate. The rate at which the signal level rises, in signal units per second. Click
the Advanced button in the Add Measurement or Edit Measurement dialog to

specify the signal level thresholds for the measurement.

True RMS. The root mean square (RMS) value of the waveform, including the DC
component.

Mask Failures. A special measurement that counts the number of failed waveforms in
Mask Limit Testing mode. This measurement is added to the table automatically when

you use Mask Limit Testing, so there is usually no need to select it manually.
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9.1.2

Spectrum measurements
To add a spectrum measurement, open a spectrum view and then click the Add

Measurement button. You can use these measurements in either scope mode or

spectrum mode.

Frequency at peak. The frequency at which the peak signal value appears.
Amplitude at peak. The amplitude of the peak signal value.

Average amplitude at peak. The amplitude of the peak signal value averaged over a
number of captures.

Total power. The power of the whole signal captured in the spectrum view, calculated
by adding the powers in all of the spectrum bins.

Total Harmonic Distortion (THD). The ratio of the sum of harmonic powers to the
power at the fundamental frequency.

W VW) Y )
VI

THD = 20 logm[

Total Harmonic Distortion plus Noise (THD+N). The ratio of the harmonic power plus
noise to the fundamental power. THD+N values are always greater than the THD values
for the same signal.

B Jsum of squares of RMS values excluding datum
THD + N =20 Iogm[ RMS value of datum

Spurious-free Dynamic Range (SFDR). This is the ratio of the amplitude of the
specified point (normally the peak frequency component) and the frequency component
with the second largest amplitude (call it SFDR frequency). The component at the SFDR
frequency is not necessarily a harmonic of the fundamental frequency component. For
example, it might be a strong, independent noise signal.

Signal+Noise+Distortion to Signal+Noise Ratio (SINAD). The ratio, in decibels, of
the signal-plus-noise-plus-distortion to noise-plus-distortion.

SINAD = 20/0910[ RMS value of datum J

Jsum of squares of all RMS components except datum

Signal to Noise Ratio (SNR). The ratio, in decibels, of the mean signal power to the
mean noise power. Hanning or Blackman windows are recommended because of their
low noise.

SNR = 20log
w[Jsum of squares of all values excluding datum and harmonics

RMS value of datum J
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Intermodulation Distortion (IMD). A measure of the distortion caused by the
nonlinear mixing of two tones. When multiple signals are injected into a device,
modulation or nonlinear mixing of these two signals can occur. For input signals at
frequencies f1 and f2, the two second-order distortion signals will be found at
frequencies: f3 = (f1 + f2) and f4 = (f1 - f2).

IMD is expressed as the dB ratio of the RMS sum of the distortion terms to the RMS
sum of the two input tones. IMD can be measured for distortion terms of any order, but
the second-order terms are most commonly used. In the second-order case, the
intermodulation distortion is given by:

F?+F}
IMD = 20lo ERREE
9o F’+F’

where

F3 and F4 are the amplitudes of the two second-order distortion terms (at
frequencies f3 and f4 defined above)

and

F1 and F2 are the amplitudes of the input tones (at frequencies f1 and f2, as marked
by the frequency rulers in the spectrum window).

For reference, the third-order terms are at frequencies (2F1 + F2), (2F1 - F2), (F1 +
2F2) and (F1 - 2F2).

Note: Hanning or Blackman windows are recommended because of their low noise. An
FFT size of 4096 or greater is recommended in order to provide adequate spectral
resolution for the IMD measurements.

Mask Failures. See Mask Limit Testing.
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9.2

Signal generator waveform types

The list of waveform types available in the Signal Generator dialog varies according to
the type of oscilloscope connected. The full list is as follows:

Sine

Square

Triangle

RampUp

RampDown

Sinc

Gaussian

HalfSine

WhiteNoise

PRBS

DCVoltage

Arbitrary

/\
\\-/
e

[[TTT]

A A ﬂ‘ﬁ\ 0 / \
/,M;\(\/ \ \,\ | U W \f«\m/kn\mﬂf W

N\

-,

Sinusoid

Square wave

Symmetrical triangle wave

Rising sawtooth

Falling sawtooth

sin(x)/x, truncated on the x axis

The 'bell curve' of the normal distribution,
truncated on the x axis

A rectified sinusoid

Random samples at the maximum update rate of
the AWG

Pseudo-random binary sequence - a random
sequence of bits with adjustable bit rate

Constant voltage, adjustable using the Offset
control

Any waveform created by the arbitrary waveform
editor
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9.3 Spectrum window functions

To create a spectrum view, PicoScope captures a block of sampled data over a finite

time interval and then uses a Fast Fourier Transform to compute its spectrum. The

algorithm assumes a signal level of zero at all times outside the captured time interval.

Typically, this assumption causes sharp transitions to zero at either end of the data,

and these transitions have an effect on the computed spectrum, creating unwanted

artefacts such as ripple and gain errors. To reduce these artefacts, the signal can be

faded in and out at the start and end of the block. There are several commonly used

"window functions" that can be convolved with the data to effect this fading, and

which are chosen according to the type of signal and the purpose of the measurement.

The Window Functions control in the Spectrum Options dialog lets you select one of

the standard window functions for spectrum analysis. The following table shows some

of the figures of merit used to compare the functions.

Window Main peak |Highest Side lobe Notes

width (bins |side lobe |roll-off
@ -3 dB) (dB) (dB/octave)

Blackman 1.68 -58 18 often used for audio work

Gaussian 1.33t0 1.79 |-42to -69 |6 gives minimal time and
frequency errors

Triangular 1.28 -27 12 also called Bartlett window

Hamming 1.30 -41.9 6 also called raised sine-
squared; used in speech
analysis

Hann 1.20to 1.86 |-23to -47 |12 to 30 also called sine-squared; used
for audio & vibration

Blackman-Harris [1.90 -92 6 general-purpose

Flat-top 2.94 -44 6 negligible pass-band ripple;
used mainly for calibration

Rectangular 0.89 -13.2 6 no fading; maximal sharpness;
used for short transients
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9.4  Trigger timing (part 1)

The pre-trigger time control and post-trigger delay control functions are described
individually under Triggering toolbar, but the interaction between the two controls is
also important to understand. Here is a screen shot of a scope view with post-trigger
delay enabled:

iy PicoScope 6 = =

File Edit Views Measurements Tools Help |
ALy | 2 G| soopsanlv] | [0 BF] 1ms  B||dd| 12efn2 ADNEEEEEIEY pico
Ag Ao [v][pc [v] | By |off [~] | cq of [~] | Dw [~] |N¥|
B 20

v

12

0.3

04

0.0

04

-08

-1.2

-8

200 @

-1.3 0.8 0.3 02 0.7 1.2 1.7 2.2 27 3.2 3.7
o .
| Running (&) & | Trigger | Auto [] ﬂ!| h [v] | A \X| owv E” 20% = )’% 200 us |§|| Measurements [z |

I I I
Trigger Pre-irigger Post-trigger Post-frigger
reference delay delay delay
point control button trol

Note 1. The trigger reference point (<*) does not lie on the waveform. This is because
the post-trigger delay is set to 200 ys, which means that the trigger occurred
200 ps before the reference point, somewhere off the left-hand edge of the
scope view. The time axis is aligned so that the trigger reference point is at
200 ps.

Note 2. The pre-trigger delay is set to 30%, which makes the trigger reference point
appear 30% of the way across the scope view from the left-hand edge.

Note 3. PicoScope limits the trigger-to-reference-point delay to a multiple of the total
capture time. Once you have reached this limit, the program will not let you
increase the pre-trigger delay, and if you increase the post-trigger delay,
PicoScope will reduce the pre-trigger delay to stop the total exceeding the
limit. The multiple is typically 100 in most trigger modes, and 1 in ETS mode.
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9.5

psw.en r39

Trigger timing (part 2)

Trigger timing (part 1) introduced the concepts of pre-trigger delay and the post-
trigger delay. This diagram below shows how they are related.

Picoscape 6 - oliEl
Fle Edt Yiews

\
Y \
\ f \ Trigger / \ / \ / \ { \
5 \ f 1 { reference \
Trigger event — \ / o \ b L
/ \ | 4 / f ! | \ J point

Post-trigger delay

The pre-trigger delay positions the scope view in relation to the trigger reference
point so that you can choose how much of the waveform should be before the
reference point, and how much after it.

The post-trigger delay is like the delayed trigger of a conventional oscilloscope.
PicoScope waits for this time after the trigger event before drawing the trigger
reference point. Scope devices have a limit to the number of sampling intervals that

can elapse between the trigger event and the end of the capture, so the software may
adjust the pre-trigger delay to keep within this limit.

Tip: If you have set up a post-trigger delay, you can click the post-trigger delay

button while the scope is running whenever you want to switch between viewing the
trigger event and the trigger reference point.
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9.6 Serial protocols
The serial decoding feature of PicoScope understands the following serial protocols.

Copyright © 2007-2015 Pco Technology Ltd. All rights reserved. psw.en r39



190 Reference

9.6.1  RS232/UART protocol

You can decode RS232 (UART) data using the serial decoding feature built into
PicoScope.

About RS232

RS232 is the serial data standard used by UARTs (Universal Asynchronous Receiver/
Transmitters) in the serial or COM ports once commonly found on computers. It was
developed in the 1960s for connecting modems to terminals. The full standard uses a
voltage swing of £12 V, larger than most other standards. The simplest RS232
connection consists of two signals: Rx (receive) and Tx (transmit).

The in-table view of the data looks like this:

| Export  Accumulate | View | <Mone= |z||£| Start from... Filter Statistics Search Refresh  Clear | |
g472 Dats 0 SF |~
5355 Data o 5F =
1070 Dats o s5F =]
5153 Ltz ] 5F [v]
<]l [ |

W A-RS5232/UART

The columns in the data table are as follows:

Column Description

No. Serial number of the packet (decimal). If Accumulate mode is off,
this counts from the start of the selected waveform. If
Accumulate mode is on, this counts from the start of the first
waveform in the waveform buffer.

Packet Packet type: all packets in this format are classified as Data.
Start Bit If present, this is the fixed "1" bit at the start of the word.
Data bytes Contents of data packets.

Parity Bit The error-correction bit, if present, at the end of the word.
Stop Bit If present, this is the fixed "1" bit at the end of the word.
Error Indicates whether there was a data error.

Start Time Time according to PicoScope timebase at start of frame.
End Time Time according to PicoScope timebase at end of frame.
Packet Time* The duration of the packet (End Time - Start Time).

Min Voltage* Minimum voltage.

Max Voltage* Maximum voltage.

Voltage Delta* Voltage range of the signal (Max Voltage - Min Voltage).

* Display of these items is toggled on and off by the Statistics button.
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9.6.2

SPI protocol
You can decode SPI Bus data using the serial decoding feature built into PicoScope.

About SPI Bus

SPI (Serial Peripheral Interface) Bus is a serial data standard used for communication
between microprocessors and peripheral devices. It was developed by Motorola. The
original standard uses a 4-wire link, although 3-wire and 2-wire versions are also used.

The in-table view of the data looks like this:

| Export Accumulate | View Link: <MNonex |E||E| Start from...  Filter  Statistics Search Refresh  Clear | |
o
2 D=tz &0 1.788ms 1.88EBms ‘E‘
3 Dats F& 3.081 ms 318 ms B
4 D=tz &0 4,805 ms 4,853 ms
5 Cat= 00 5.5 ms 5.985 ms |7|
m A-SPI

The columns in the data table are as follows:

Column Description

No. Serial number of the packet (decimal). If Accumulate mode is off,
this counts from the start of the selected waveform. If
Accumulate mode is on, this counts from the start of the first
waveform in the waveform buffer.

Packet Packet type: Start, Stop, Address, Data or Unknown.
Data bytes Contents of data packets.

Start Time Time according to PicoScope timebase at start of frame.
End Time Time according to PicoScope timebase at end of frame.
Packet Time* The duration of the packet (End Time - Start Time).
Min Voltage* Minimum voltage.

Max Voltage* Maximum voltage.

Voltage Delta* Voltage range of the signal (Max Voltage - Min Voltage).

* Display of these items is toggled on and off by the Statistics button.
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9.6.3  12C protocol
You can decode I?2C Bus data using the serial decoding feature built into PicoScope.
About I’C Bus
I?C (Inter-Integrated Circuit) Bus is a serial protocol used mainly in consumer
electronics for communications between devices on the same circuit board, and
between computers and displays. The standard was originally developed in the 1980s
by Philips. It uses two signals: clock (SCL) and data (SDA).
The in-table view of the data looks like this:
| Export  Accumulate | View Link: Mone |E||E| Start from...  Filter  Statistics | Search | Refresh  Clear | |
2 lpgoress o Jwwre [ e[ e [N
3 Diats - - oL Yez 1798 ms 19ms | =l|
4 D=tz - oz ez 18l me 20l ms 0
T Address T WRITE - Yes 21083 ms 2183 ms
B Diats IF Yez 3081 ms 3151 ms=
] D=tz o] ez 3202 me 3302 ms
10 Dats o Yes 3313ms 3413 ms
11 Diats - AT Yez 3424 mz 3E2d msz
14 Address 70 WRITE - Yes 1587 ms IERE ms |z|
W A -I2C Data
The columns in the data table are as follows:
Column Description
No. Serial number of the packet (decimal). If Accumulate mode is off,
this counts from the start of the selected waveform. If
Accumulate mode is on, this counts from the start of the first
waveform in the waveform buffer.
Packet Packet type: Start, Stop, Address, Data or Unknown.
Address Shown for address packets.
Read/Write Polarity of the Read/Write flag.
Data bytes Contents of data packets.
Acknowledge Whether the destination acknowledged the packet.
Baud Rate* The signaling rate detected for this packet.
Start Time Time according to PicoScope timebase at start of frame.
End Time Time according to PicoScope timebase at end of frame.
Packet Time* The duration of the packet (End Time - Start Time).
Min Voltage* Minimum voltage.
Max Voltage* Maximum voltage.
Voltage Delta* Voltage range of the signal (Max Voltage - Min Voltage).
* Display of these items is toggled on and off by the Statistics button.
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9.6.4 125 protocol

You can decode IS Bus data using the serial decoding feature built into PicoScope.

About I2S Bus

I’S (Inter-IC Sound) Bus is a serial protocol used in digital audio devices for
communications between circuits such as CD transports and audio DACs. The standard
was originally developed in by Philips Semiconductors. It uses three signals: clock
(SCK), word select (WS) and data (SD).

The in-table view of the data looks like this:

| Export  Accumulate | View Link: Mone |E||£| Start from...  Filter  Statistics Search Refresh  Clear

[~]
2 Datz 75 s I78.7rs =
3 L=tz 1.175ps 1178 s
4 D=t 4. E25ps 4 BZE s
3 L=tz 7775 s 7778 s
8 Data B.5Tops B.5TB s
7 D=tz 8025 ps 8.028 us
g L=tz 1033 pus 10.33 s .
] Data bl 1088 s 1088 us [v]

W A-125 DatalBETA

The columns in the data table are as follows:

Column

No.

Packet

Data bytes
Baud Rate*
Start Time
End Time
Packet Time*
Min Voltage*
Max Voltage*

Voltage Delta*

Description
Serial number of the packet (decimal). If Accumulate mode is off,
this counts from the start of the selected waveform. If

Accumulate mode is on, this counts from the start of the first
waveform in the waveform buffer.

Packet type: all I?S packets are of type Data.

Contents of data packets.

The signaling rate detected for this packet.

Time according to PicoScope timebase at start of frame.
Time according to PicoScope timebase at end of frame.
The duration of the packet (End Time - Start Time).
Minimum voltage.

Maximum voltage.

Voltage range of the signal (Max Voltage - Min Voltage).

* Display of these items is toggled on and off by the Statistics button.
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9.6.5  CAN protocol

You can decode CAN Bus data using the serial decoding feature built into PicoScope.

About CAN Bus

CAN (Controller Area Network) Bus is a serial protocol used in automotive and industrial
machinery to allow microcontrollers to communicate with each other. The standard
was originally developed in 1983 by Robert Bosch GmbH. It typically uses differential
signalling (with signals named CAN H and CAN L) to increase noise immunity.

The in-table view of the data looks like this:

| Export  Accumulate | View Link: | <Nonex= [~|[+] Startfrom.. Filter Statistics Search | |
1~
. . . El
3 Data Yes 3.222 ms 3.323 ms
4 Dats o2 ez 5334 ms 5424 ms
7 Address L WRITE - Yes 3.507 ms 3.807 m
L Dat= 1F e= 8514 ms B.615m |v|
W A - CAN High

The columns in the data table are as follows:

Column
No.

ID

Frame

RTR

SRR

IDE

RO

R1

DLC

Description

Serial number of the frame (decimal). If Accumulate mode is off,
this counts from the start of the selected waveform. If Accumulate
mode is on, this counts from the start of the first waveformin the
waveform buffer.

Identifier (hexadecimal). Should be unique for a specified data
type. Base frames have an 11-bit identifier, and extended frames
have a 29-bit identifier.

CAN Bus data is divided into frames, each consisting of a humber
of bits. A frame can be any of the following types:

Data: contains data destined for a node
Remote: a request for the transmission of a specific identifier
Error: transmitted by a node that detects an error
Overload: inserted to add a delay between frames
Interframe: time interval preceding data frames and remote
frames

Any frame can also be a base frame or an extended frame.

Remote transmission request

Used only in extended frames

Identifier extension bit

Reserved bit

Reserved bit, extended frames only

Data length code. Indicates the number of bytes of data.
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Data bytes
CRC Sequence
CRC Delimiter
Ack Slot

Ack Delimiter
Error

Stuffed Bits*

Baud Rate*
Start Time
End Time
Frame Time*
Min Voltage*
Max Voltage*

Voltage Delta*

The data content of the message, DLC bytes long (hexadecimal)
A cyclic redundancy check of the data (hexadecimal)

A fixed bit following the CRC Sequence field

Node asserts this bit to acknowledge receipt

A fixed bit following the Ack Slot field

Set if PicoScope detects an error

The number of extra bits inserted in the frame to assist
synchronization

Number of bits per second.

Value of PicoScope timebase at start of frame.
Value of PicoScope timebase at end of frame.
Duration of frame (End Time - Start Time).
Minimum voltage.

Maximum voltage.

Voltage range of the signal (Max Voltage - Min Voltage).

* Display of these items is toggled on and off by the Statistics button.
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9.6.6

LIN protocol
You can decode LIN data using the serial decoding feature built into PicoScope.

About LIN

LIN (Local Interconnect Network) is a serial protocol used in automotive electronics to
allow microcontrollers to communicate with low-speed peripherals. The standard was
defined by the LIN Consortium, a group of five vehicle manufacturers. It uses a single

wire pair with a master-slave topology.

The in-table view of the data looks like this:

| Export Accumulate | View Link:  None |Z”E| Start from... Filter Statistics | Search | Refresh  Clear | |

i Jurcongivoral iz s i seees [0742280A004B4086 o | lissmeliisims |

W A-LIN (BETA)

The columns in the data table are as follows:

Column Description

No. Serial number of the frame (decimal). If Accumulate mode is off,
this counts from the start of the selected waveform. If
Accumulate mode is on, this counts from the start of the first
waveform in the waveform buffer.

Frame LIN Bus data is divided into frames, each consisting of a number of
bits. A frame can be any of the following types:

Unconditional: all subscribers must receive this frame.

Event-triggered: multiple slaves may respond to this, but only if
they have new data.

Sporadic: transmitted by the master when it knows that the slave
contains updated data.

Diagnostic: contains diagnostic or configuration data.
User-Defined: depends on your application.

Reserved: should not be used.

Break The start-of-frame notifier.

Sync A fixed value (0x55) used for automatic baud rate detection.
Frame ID A six-bit value to identify the type of data carried by the frame.
Parity A two-bit value calculated on the data.

Data count Number of bytes of data in the frame.

Data bytes The data content of the message.

Checksum A cyclic redundancy check of the data (hexadecimal).
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Calculated
Checksum*

Error

Start Time
End Time
Packet Time*
Min Voltage*
Max Voltage*

Voltage Delta*

The checksum expected by PicoScope.

Set if PicoScope detects an error.

Value of PicoScope timebase at start of frame.
Value of PicoScope timebase at end of frame.

The duration of the packet (End Time - Start Time).
Minimum voltage.

Maximum voltage.

Voltage range of the signal (Max Voltage - Min Voltage).

* Display of these items is toggled on and off by the Statistics button.
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9.6.7

FlexRay protocol

You can decode FlexRay data using the serial decoding feature built into PicoScope.

About FlexRay

designed to be fault-tolerant.

FlexRay is an automotive network communications protocol for high-speed data. It is

The in-table view of the data looks like this:

| Eport Accumulate | View Link: None [v|[+] Stertfrom.. Filter Statistics

Refresh  Clear

R N VA A VA

EE) Smmn 000
W A-FLEXRAY (BETA)

The columns in the data table are

Column
No.

Packet

TSS

FSS

BSS
Reserved Bit

Payload Preamble Indicator

Null Frame Indicator

Sync Frame Indicator

Frame ID
Payload Length

Header CRC

Cycle Count
Payload

Payload CRC

WG]

GREBEBEEBBRERER
0

as follows:

Description

Serial number of the packet (decimal). If
Accumulate mode is off, this counts from the start
of the selected waveform. If Accumulate mode is
on, this counts from the start of the first waveform
in the waveform buffer.

The type of packet.

Transmission Start Signal. Bit 0 of the frame.
Frame Start Signal. Bit 1 of the frame.

Byte Start Signal. A fixed 2-bit code.

Not used.

Indicates the presence of a network management
vector or message ID.

Indicates that the payload contains no useful
payload data.

Indicates whether the frame is a synchronization
frame.

Defines the slot in which the frame is transmitted.
The number of payload bytes divided by 2.

Cyclic redundancy check of data from the sync
frame indicator to the payload length.

The value of the cycle counter.
0 to 254 bytes of data.

CRC for the frame.

psw.en r39
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FES
DTS
Error

Start Time

End Time

Packet Time*
Min Voltage*
Max Voltage*

Voltage Delta*

Frame End Signal.
Dynamic Trailing Sequence.
Indicates whether an error was detected.

Time according to PicoScope timebase at start of
frame.

Time according to PicoScope timebase at end of
frame.

The duration of the packet (End Time - Start Time).
Minimum voltage.
Maximum voltage.

Voltage range of the signal (Max Voltage - Min
Voltage).

* Display of these items is toggled on and off by the Statistics button.
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9.7 Device feature table

Some PicoScope 6 features require specialized hardware and are therefore not available
on all devices. Feature availability is indicated in the table below. (Detailed
specifications for each feature may vary). Please see the relevant device data sheet
for more details.

Series / Model 50 | AT |AW|AX | BL|/DC| DI |EX|FC|FR | LP |RA|RU|SG|SM|ST | SW
USB DrDAQ v v v
PicoLog 1000 v
PicoScope 2104-2105

PicoScope 2202 v
PicoScope 2203 v v | v v
PicoScope 2204-2205 v | v v | v v
PicoScope 2206-2208 v | v v v v v v | v | v
PicoScope 2204A vl vl v
PicoScope 2205A

PicoScope 2206A

PicoScope 2207A v | v v v viv|v|v
PicoScope 2208A

PicoScope 2205 MSO v | v v viviv | iv|v]|v
PicoScope 3204 v v v

PicoScope 3205-3206 v v v v
PicoScope 3223/3423 v y
PicoScope 3224 /3424

PicoScope 3425 v v
PicoScope 3200A v v v vivi v iv|v|v]|v
PicoScope 3400A v v | v v viv v iv|]iv iv]|v
PicoScope 3200B v | v v v viv v |v|v v
PicoScope 3400B v | v v | v v viv v iv|v v
PicoScope 3000D v | v v | v v vivi v iv|v|v]|v
PicoScope 3000 MSO v | v v | v viv v iv|]iv iv]|v
PicoScope 3000D MSO v | v v v v viv v |v|v v
PicoScope 4223-4224 v v vlovly y
PicoScope 4423-4424

PicoScope 4225/4425 v v v v v v v
PicoScope 4226-4227 v | v v viv v |v|v v
PicoScope 4262 v | v v v viv v |v|v | iv]|v
PicoScope 4824 v | v v viv v v|v iv]|v
PicoScope 5203-5204 v | v |wv v v | v v iv | v |wv
PicoScope 5000A v v | v v viv v iv|iv|v]|v]|lv
PicoScope 5000B v | v v | v v viv v iv|iv|v]|v]|v
PicoScope 6000 viviv|iv|v] v viv v v|v iv]|v
PicoScope 6000A/C v | v v v v viv v iv|iv iv]|v
PicoScope 6000B/D vivivi|iv|v] v viv v |v|v v
PicoScope 6407 viv | v | v viv v |v|v | iv]|v
50 50 ohm inputs FR Flexible resolution

AT Advanced triggers LP Lowpass filtering

AW Arbitrary waveform generator RA Rapid triggering

AX Auxiliary input/output RU Runt pulse trigger

BL Switchable bandwidth limiter SG Signal generator

DC DC offset adjustment SM Streaming mode

DI Digital inputs ST Signal generator triggers

EX External trigger input SwW Signal generator sweep modes

FC Frequency counter
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9.8

Command-line syntax

PicoScope can be run from the Windows command line, allowing you to run tasks
manually or under the control of a batch file or other program.

To display the GUI
PicoScope <filename>
<filename> Specifies a single .psdata or .pssettings file.
Example: PicoScope C:\Temp\source.psdata
To display help
PicoScope /?
Shows help on all command-line options.
To convert a psdata file
PicoScope /C,/c

Converts a psdata file from one format to another. Cannot be used with /p[rint].

Syntax:

PicoScope /clonvert] <names> [/d <names>] /f <format> [/q]

[/b [<n>[:<m>]] | [all]] [/v <viewportname>]

<names> Specifies a list of one or more directories or psdata files.

Wildcards may be used to specify multiple files. If a
directory is specified, all psdata files within that directory
will be specified. This is a mandatory argument.
/d <names> Destination. Default is input filename with new extension.
/f <format> Destination format: csv, txt, png, bmp, gif, agif
[animated GIF], psdata, pssettings, mat [MATLAB]. This
is @ mandatory argument.

/q Quiet mode. Do not ask before overwriting files. The
default is to prompt.

/b [<n>[:<m>]]lall Waveform number n, waveform range n to m or all
waveforms. The default is the current waveform.

/v <viewportname> View to convert. Default is current view.

Example:

PicoScope /c C:\Temp\source.psdata /f png /b 5:9 /v Scope2
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To print a view
PicoScope /P, /p

Prints a view in the psdata file. Cannot be used with /c[onvert].

Syntax:
PicoScope /plrint] <names> [/b [<n>[:<m>]] all] [/v <viewportname>]
<names> Specifies a list of one or more directories or .psdata files.

Wildcards may be used to specify multiple files. If a
directory is specified, all .psdata files within that
directory will be specified. This is a mandatory argument.

/b [<n>[:<m>]] |all Waveform number n, waveform range n to m or all
buffers. Default is current waveform.

/v <viewportname> View to convert. Default is current view.
Example:
PicoScope /p C:\Temp\source.psdata /b 5:9 /v Scope?2
To import notes
PicoScope /N, /n
Copies text from a specified file to the Notes area.
Syntax:

PicoScope /n[otes] <notes filename> <filename>

<notes filename> Specifies a single text file.
<filename> Specifies a single psdata or pssettings file.
Example:

PicoScope /n C:\Temp\source.txt C:\Temp\source.psdata
To run an automation command
PicoScope /A, /a

Run automation command or macro on an existing instance of PicoScope 6.

Syntax:
PicoScope /a[utomation] <command> | <macro>
<command> Automation command
<macro> Path to .psmacro file containing a macro

psw.en r39 Copyright © 2007-2015 Pco Technology Ltd. All rights reserved.



PicoScope 6 User's Guide 203

Examples:

PicoScope /a Run.Pressed=True

PicoScope /a MyMacro.psmacro

PicoScope /a 2 (prints a list of automation commands to the console)

PicoScope /a Measurements? (prints information on the Measurements command)

An instance of PicoScope must be running before any automation command is
issued.
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9.9  Application Error dialog

If there is a problem with PicoScope and the program needs to close, the Application
Error dialog appears:

e -

4 PicoScope 6 Beta @
PicoScope 6 Beta has encountered a problem and needs i
to close. We are sorry for the inconvenience. “E'.,'.}

We have created an error report that you can send to help us improve PicoScope 6
Beta. To see what this report contains, click here,

Reports are sent automatically over the internet. If you dont have access to the
internet, you can save thefile to disk and email it to support@picotech.com.

Email Address (optional)
This will only be used to contact you about this problem

|user @domain.com

Describe what you were doing when the error occurred (optional)

| .

[+ Restart PicoScope 6 Beta

Save To File Send Report

It would be very helpful to us if you could send us a report of the problem. All you need
to do is click the Send Report button, then save the .zip file in a place where you
can easily find it again, such as on your desktop. Then, email the .zip file to us at
support@picotech.com and we will do the rest. Don't worry if you can't think of a
comment to enter in the text box: just leave it empty and send the report to us
anyway.
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9.10  Flexible power

The flexible power system for PicoScope devices provides a choice of power sources. In
most cases a straightforward USB connection will be enough to power the scope. If
PicoScope needs you to switch to a different powering method, it will display a dialog

similar to this:

More information on Power Options

Power Options
Please ensure that your scope is powered from one of the following sources:

55-%. One USB 3.0 port, using the Pico USE 3.0 cable.
.—%ﬁ# One USB charging port, often marked with a symbal similar to the ane shown.

.-%— Two standard USE ports using the double-headed U5SB cable.
Your scope will only operate at USE 2.0 speed.

The AC adapter supplied. Use this if you do not have suitable USB ports available or if your PicoScope is
= = ™ connected to a USE hub.

Operate your PicoScope from USE power?
|:| Don't show this message again.

|‘ Yes | | Mo ]

The power icons explained

SS4<- USB 3.0 port. If this symbol appears, you may power the scope from any
USB 3.0 port using the USB 3.0 cable provided with your scope.

..%.; USB charging port. If this symbol appears, you may power the scope from
any USB port capable of supplying 1200 mA of current.

- Dual USB port power. If this symbol appears, you may power the scope
*<= fromany two powered USB ports using the dual-headed USB 2.0 cable
supplied with your scope.
AC adapter. Use the adapter supplied and plug it into the DC IN socket on
T T T yourscope. If you power the scope in this way, the Power Options dialog
will automatically close and the scope will start working immediately.
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Insufficient USB power

If insufficient USB power is available, PicoScope displays this dialog:

Maore information on Power Dptions

Insufficient Power
Insufficient USE power is available to run your scope. Please reconnect to one of the following sources:

SS-%. Cne USB 3.0 port, using the Pico USE 3.0 cable.

.-%P’ One USE charging port, often marked with a symbal similar to the ane shown,

Two standard USBE ports using the double-headed USB cable.
Your scope will only operate at USE 2.0 speed.

The AC adapter supplied. Use this if you do not have suitable USB ports available or if your PicoScope is
connected to a USE hub.

|

USE power will be disconnected in: 27 seconds

| Disconnect now

Connect one of the power sources listed and try again. If you plug in the AC adapter,
the dialog will automatically close and you can continue working.
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9.1

Glossary

AC coupling. In this mode, the scope device rejects very low signal frequencies below
about 1 hertz. This allows you to use the full resolution of the scope to measure a.c.
signals accurately, ignoring any DC offset. You cannot measure the signal level with
respect to ground in this mode.

AWG. An arbitrary waveform generator (AWG) is a circuit that can generate a
waveform of almost any shape. It is programmed with a data file, supplied by the user,
which defines the output voltage at a number of equally spaced points in time. The
circuit uses this data to reconstruct the waveform with a specified amplitude and
frequency.

Axis. A line marked with measurements. PicoScope shows one vertical axis for each
channel that is enabled in a view, giving measurements in volts or other units. Each
view also has a single horizontal axis, which is marked in units of time for a scope view,
or units of frequency for a spectrum view.

Channel. A scope device has one or more channels, each of which can sample one
signal. High-speed scope devices typically have one BNC connector per channel.

CSV. Comma-separated values. A text file containing tabulated data, with columns
separated by commas and rows by line-breaks. CSV format is used for importing and
exporting PicoScope arbitrary waveform files. You can also export PicoScope waveforms
in CSV format. CSV files can be imported into spreadsheets and other programs.

DC coupling. In this mode, the scope device measures the signal level relative to signal
ground. This shows both DC and AC components.

Dead time. The time between the end of one capture and the start of the next. To
obtain the minimum possible dead time, use Rapid trigger mode.

Demo mode. If PicoScope is started when no scope device is plugged in, it allows you
to select a "demo device", a virtual scope unit that you can use to test the software.
The program is then in demo (short for demonstration) mode. This mode provides a
simulated, configurable signal source for each input channel of the demo device.

ETS. Equivalent Time Sampling. A method of increasing the effective sampling rate of
the scope. In a scope view, the program captures several cycles of a repetitive signal,
then combines the results to produce a single waveform with higher time-resolution
than a single capture. For accurate results, the signal must be perfectly repetitive and
the trigger must be stable.

Floating inputs. A feature of the PicoScope 4225 and 4425 oscilloscopes. These are
inputs that do not share a common measurement ground. The channels are separated
by high impedances and their measurement grounds can be connected to any voltage
within the specification range. It is important however that every input in use has both
a signal and a ground connection.

Graticule. The horizontal and vertical dashed lines in every view. These help you
estimate the amplitude and time or frequency of features on the waveform.

Grid. The arrangement of viewports. The number of grid rows and the number of grid
columns can each be either 1, 2, 3 or 4.

IEPE. Integrated circuit piezoelectric. A type of sensor, usually built to detect
acceleration, vibration or sound, and with a built-in amplifier. IEPE sensors can only be
used with special PicoScope oscilloscopes that have IEPE-compatible inputs.
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In focus. PicoScope can display several views, but only one view is in focus at any
time. When you click a toolbar button, it will usually affect only the view that is in
focus. To bring a view into focus, click on it.

MSO. Mixed-signal oscilloscope. An instrument that captures and displays analog and
digital signals on the same timebase.

PC Data Logger. A measuring instrument consisting of a hardware interface and the
PicoLog software running on a PC. You can also use the device with the PicoScope
software to create a multi-channel voltage input oscilloscope.

PC Oscilloscope. A measuring instrument consisting of a scope device and the
PicoScope software running on a PC. A PC Oscilloscope has the same functions as a
traditional bench-top oscilloscope but is more flexible and cost-effective. You can
improve its performance by upgrading the PC using standard parts from any computer
shop, or by purchasing a new scope device, and you can upgrade the software by
downloading an update from Pico Technology.

Probe. An accessory that attaches to your oscilloscope and picks up a signal to be
measured. Probes are available to pick up any form of signal, but they always deliver a
voltage signal to the oscilloscope. PicoScope has built-in definitions of standard probes,
but also allows you to define custom probes.

Progressive mode. Normally, PicoScope redraws the waveform in a scope view many
times every second. At timebases slower than 200 ms/div, however, it switches to
progressive mode. In this mode, PicoScope updates the scope view continuously as
each capture progresses, rather than waiting for a complete capture before updating
the view.

Resolution enhancement. Collecting samples at a faster rate than requested, then
combining the excess samples by averaging. This technique can increase the effective
resolution of a scope device when there is a small amount of noise on the signal. (More

details).

Ruler. A vertical or horizontal dashed line that can be dragged into place on a
waveform in a view. PicoScope displays the signal level, time value or frequency value
of all rulers in the Ruler Legend box.

Scope device. The box from Pico Technology that you plug into the USB or parallel
port of your computer. With the help of the PicoScope software, the scope device
turns your computer into a PC Oscilloscope.

Standard deviation. A statistical measure of the spread of a set of samples. The
standard deviation of the set ¥.-V.:is defined as:

1 n-1 .
SD = [=> (y,-9)’
n o ,

where ¥ is the arithmetic mean of all the samples. The units of the standard deviation
value are the same as those of the original samples.

Tool tip. A label that appears when you move the mouse pointer over some parts of
the PicoScope screen, such as buttons, controls and rulers.

Trigger. The part of an oscilloscope that monitors an incoming signal and decides when
to begin a capture. Depending on the trigger condition that you set, the scope may
trigger when the signal crosses a threshold, or may wait until a more complex condition
is satisfied.
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Vertical resolution. The number of bits that the scope device uses to represent the
signal level. This number depends on the design of the device, but can be boosted in
some cases by using resolution enhancement.

View. A presentation of data from a scope device. A view may be a scope view, an XY
view or a spectrum view.

Viewport. The views in the PicoScope window are arranged in a grid, and each
rectangular area in the grid is called a viewport.
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Index B

Bandwidth limiter 115, 200

% Battery power 98

Beep 90

%buffer% variable 90 Binary files, exporting 42

o4 file O 7

Yofile% variable 90 Bit stream 144

o) i o) 1

/otime % variable 90 bmp files 38

Bring channel to front 119

5 Buffer Navigation toolbar 137

50 Q DC inputs 115, 200 Buffer Overview 35

AC adapter 205 CAN bus

AC coupling 207 protocol 194

AC power 98 Capture count 20

Accelerometer inputs 115 Capture modes 8,9

Access 3 Capture rate preference 98

Add Measurement dialog 52 Capture Setup toolbar 130

Adding a measurement 52 Capture size preference 97

Advance function 74 Changing device 162

Advanced measurement settings 53 Channel ' 297 '

Advanced Options toolbar selecting in a view 49
Channel Labels button 114 Channel '—ab?'S 47,114
Notes button 114 Channel Options
Rulers button 114 button 115

Advanced triggering 151, 153 menu 115
types 154, 200 Channel ordering 119

Alarms 34, 90 Channel settings
save on ,trigger 176 in Properties sheet 28

Analog intensity 135 Channel warning symbol 30

Analog offset 115 Channels toolbar

AND logical operator 158 PicoLog 1000 Series 125

Animated GIF 38 standard 115

Arbitrary waveform generator 139, 200 _ USB DrDAQ 127
editing window 144 Clipboard 46
files 143 Close file 37
importing from channel 147 Collection time units 97

Automotive menu 110 Color preferences 104

Auxiliary (AUX) I/O 151, 200 Column aut.o-width 51

Average (statistics) 20 Command line syntax 201

AWG 207 Connect Device dialog 37,111

Axis 11,16,18, 207 ConnectDetect 122
auto-arrange 49 Converting data files 112, 201
horizontal 11, 16, 18 Copy _
offset 166 as image 46
scaling 119, 166 as.text 46
vertical 11,16, 18 Copyright 3

Axis scaling 116 Coupling control 115

Create New Custom Probe dialog 57
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Index

csv files 38

CSV files, exporting 41

Cursors (see Rulers) 22,23, 27

Custom grid layout dialog 50

Custom Probe Manager 55

Custom Probe wizard 57
Create New Custom Probe dialog 57
Edit Existing Custom Probe dialog 58
Edit Range dialog 64
Edit Range dialog (Advanced tab) 66
Finished dialog 69
Lookup-table Scaling dialog 61
Manual Ranges Setup dialog 63
Probe ID dialog 68
Probe Output Units dialog 59
Range Management dialog 62
Scaling Method dialog 60

Custom probes 29

dialog 56
saving 37
Data files

converting 112
DC coupling 207
DC IN power 205
DC offset 115, 200
Dead time 207
Decoding tab 32
Default Print Settings 103
Delay function 74
Demo device 148
Demo mode 148, 149, 207
Demo Signals

dialog 149
menu 148
Details dialog

channel labels 48

customer details 48

vehicle details 48
Device feature table 200
Device, how to change 162
Digital color 135
Digital inputs 123, 200
Digital Inputs button 115, 123
Digital outputs 126

UsSB DrDAQ 129
Digital Setup dialog 123
Digital trigger dialog 157
Digital view 14

context menu 15

DrDAQ 127
Dropout trigger 154

E

Edge trigger 154
Edit Existing Custom Probe dialog 58
Edit menu 46
Edit Range dialog 64
Advanced tab 66
Edit Reference Waveform dialog 82
Effective resolution 117
Equation dialog 74
Equivalent-time sampling 151
ETS 151, 207
and Advanced Triggering 153
Exit 37
Exporting data 41
binary format 42
text format 41
External (EXT) trigger 151, 200

F

Fall time
threshold 53
Falling edge button 151
Feedback 109
File conversion 112
File menu 37
Filter Method dialog 67
Filtering 115
channels 120
measurements 20
statistics 53
Fitness for purpose 3
Flexible power 205
Flexible Resolution 200
FlexRay
protocol 198
Focus 207
Frequency counter 115, 200
Frequency difference, measuring 164
Frequency legend 23, 27
Frequency rulers 23
Functions, mathematical 74

G

General preferences 97
Generate mask 92
Generate Mask dialog 94
gif files 38
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Glitches, finding 154
Glossary 207

Graticule 11, 16, 18, 207
Grid 207
layout 49, 50

Groups, digital input 123

H

Hand tool 160

Harmonic control for measurements 53
Help menu 109

Horizontal axis 11, 16, 18

House current 98

Hysteresis 156

I2C

protocol 192
125

protocol 193
IEPE inputs 115
Image, saving as 38
Import from a Channel dialog 147
Input impedance 115
Interpolation

linear 99

sin(x)/x 99
Interval trigger 153, 154
Invert button 30

K

Keyboard maps 101
Keyboard shortcuts

L

Language preferences 102
LED

on USB DrDAQ 128
Legal statement 3
Liability 3
LIN bus

protocol 196
Line thicknesses 104
Link file 88

creating 180
Lissajous figures 16
Logic trigger 154

dialog 158
Lookup-Table Scaling dialog 61

100, 160

Lowpass filtering 67, 116, 120, 200

M

Macro

Recorder 95

running from command line 201
Mains power 98

Manual Ranges Setup dialog 63
Marquee Zoom tool 160

mask files 92

Mask Limit Testing 33, 55
How To 173
Masks
colors 33,104
displaying 49
editing 93
export 92
generate 92
import 92

in Buffer Overview 35
library dialog 92
menu 92

polygons 93
selection dialog 33

Math Channel Wizard

Equation dialog 74
Finished dialog 80
Introduction dialog 73
Name and Color dialog 78
overview 72

Units and Range dialog 79

Math channels 55,70
Built In 70
button 115
dialog 70
Library 70
Loaded 70
overview 30
saving 37

MATLAB files

exporting 42,81
saving 38

Max (statistics) 20
Maximum Waveforms preference
Measurement system

selecting 102

Measurements

adding 20,51,52
advanced settings 53
capture size 97
deleting 20,51

97
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Index

Measurements

editing 20, 51

filtering 20

font size 51

list of types 182

menu 51

scope 182

spectrum 183

statistics 20

table 20

toolbar 106, 138
Menus 36
Metric measurements 102
Min (statistics) 20
Missing events, finding 154
Mission-critical applications 3
MSO 207

setup 123

view 13

N

NAND logical operator 158
New features 2
NOR logical operator 158
Normal Selection tool 160
Notes 46, 114
importing from command line 201
Notes area 46

O

Offset 166

analog 115
Open file 37
OR logical operator 158
Oscilloscope 6
Overrange indicator 11,115
Overvoltage

BNC Shell to chassis 12

Normal measurement range 12

P

Page Down key 37
Page Up key 37
Panning 161

Pattern trigger 157
PC Oscilloscope 7
Persistence mode 19

Phase rulers 24

partition 26
units 26
wrap 26

PicoLog 1000 Series 125, 126
PicoScope 6 1,2,7

how touse 3,5,6

main window 10

png files 38

Pointer tooltip 21

Polygon 93

Post-trigger delay 187
arrow 17

control 151, 187
Power Management preferences
Power supply 205
Preferences 55

capture rate 98

colours 104

Default Print Settings 103

device selection 106

dialog 96

general 97

keyboard 100

language 102

persistence modes 106

power management 98

sampling 99

spectrum modes 106

updates 108
Pre-trigger delay 187

control 151, 187
Printing 37

from command line 201

from menu 37

preferences 103

preview 37

Probe 207
custom 29
ID dialog 68

Output Units dialog 59
Progress bar 132
Progressive mode 207
Properties sheet 28

displaying 49
psdata files

converting 112, 201

saving 38
pskeys files 100

98

button 130 psmaths files 70, 74, 78
enabling and disabling 106 psreference files 81
options 135 pssettings files 38
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Pulse width trigger

PWM output
PicoLog 1000 Series 126
USB DrDAQ 129

R

Range control 115
Range Management dialog 62
Rapid triggering 151, 200
Reference waveforms 55

adding 49

delay 119

dialog 81

Library 81

Loaded 81

overview 31

using in equations 74
Reset 'Don't show this again' dialogs 97
Resolution control 130
Resolution enhancement 116, 117, 207
Revolutions per minute 27
RGB LED on USB DrDAQ 128
Rise time

threshold 53
Rising edge button 151
Rotation rulers 24

partition 26

units 26

wrap 26
RPM 27,106
RS232/UART

protocol 190

153, 154

Rulers 11,16, 18,114
definition 207
deleting 22, 23
handles 11, 16, 18
legend 27
lock button 27
phase 24
rotation 24
settings 26
time 11,18
voltage 11,16,18

Runt pulse trigger

S

Sampling preferences 99
Sampling rate 130
Save As 37

dialog 38

154, 200

Save file 37
Save on trigger
Scaling 7,166

button 119
Scaling Method dialog 60
Scope device 207
Scope measurements

AC volts 182

Cycle time 182

DC volts 182

Duty cycle 182

Fall time 182

Falling rate 182

Frequency 182

High pulse width 182

Low pulse width 182

Maximum 182

Minimum 182

Peak to peak 182

Rise time 182

Rising rate 182
Scope mode 8

90, 176

button 130
Scope view 9,11
Scrolling 166

Selection tool, normal 160
Send channel to back 119
Serial decoding 32,55
data window 88
dialog 83
link file 88
protocols 189
Serial number
of oscilloscope 109
Settings
saving 37
Signal difference, how to measure
Signal generator
button 139
dialog 139
sweep mode 139, 200
triggering 200
USB DrDAQ 142
Waveform types 185
Signal rulers 11, 16, 18, 22
Sinx(x)/x preferences 99
Slow sampling transition 99
Smoothing 99
Software version 1
Sound file 90
Space bar 150
Spectrum measurements

163
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Spectrum measurements
Amplitude at peak 183
Frequency at peak 183

Intermodulation Distortion (IMD) 183

Signal to Noise Ratio (SNR) 183

Spurious-free Dynamic Range (SFDR)
Total Harmonic Distortion (THD) 183
Total Harmonic Distortion plus Noise (THD+N)

183
Total power 183

Spectrum mode 8

button 130

enabling and disabling 106
Spectrum options

bins 132

dialog 132

display mode 132

scale 132
Spectrumview 9, 18

how to setup 168
SPI

protocol 191
Spreadsheet, exporting to 38
Spurious edges, finding 154
Standard deviation 20, 207
Start/Stop toolbar 106, 150
Startup Settings menu 44
State trigger 157
Statistics 20

filtering 53
Support 3
Sweep mode 139, 200
Symbols

red warning 11

yellow warning 30
System requirements 4

T

Text files, exporting 38, 41
Threshold for measurements 53
Thresholds, digital input 123
Time difference, how to measure 164
Time gate 28

Time rulers 11, 18, 23
Timebase controls 130

Tool tip 207

Toolbars 114

Tools menu 55

Trace 6

Tracking rulers 27

Trade marks 3,4

Trigger 151,187,207
advanced 151,153
digital 157
dropout 154
dual-edge 153
edge 154
glitches 154
interval 153, 154
logic 154
marker 17
missing events 154
mode control 151
pulse width 153, 154
reference point 187
runt pulse 154

timing 187

toolbar 151

window 154
Triggering

toolbar 106
txt files 38

U

U.S. measurements 102
UART

protocol 190
Undo zoom 160
Updates 109
Upgrades 3
Usage 3
Usage statistics 108
USB DrDAQ 127
USB power 205
'Used' check box 158
User's Guide 109

\

Valid edges, finding 154
Version number
hardware 109
software 1,109
Vertical axis 11, 16,18
Vertical resolution 207
View 207
enabling sub-views 49
how to move 165
menu 49
scope 11
selecting channels 49
spectrum 18
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View 207

XYy 16
Viewport 207
Viruses 3

W

Warning symbol 115
red 11
yellow 30
Waveform 6,11
saving 37
Waveform buffers
number of 97
What's new 2
Window functions 132, 186
Window trigger 154

X

X axis, configuring 49
X-Axis command 16

XNOR logical operator 158
XOR logical operator 158
XY view 16

Z

Zero offset 116
Zooming 166
undo 160
Zoom overview 161
Zooming and Scrolling toolbar
Z-ordering 119

160
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